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TECHNOLOGY—IN PARTICULAR the Web 2.0 phe-
nomenon—played an interesting role last month in
the upcoming 2008 American presidential elections.
CNN teamed up with YouTube for a telecast of its pop-
ular debate amongst the Democratic presidential
candidates. Voters invited via YouTube posed ques-
tions directly to candidates and raised issues of con-
cern to them—not policy matters of interest to the
journalists or the so-called expert panel that so often
graces such events.

Viewers of the debate, aired on CNN, saw videos of
people asking their own questions—and the Democ-
ratic presidential hopefuls were to answer them all.
The inclusion of these videos in this year’s debate
ensured politicians did not skip or gloss over ques-
tions. It might be possible to ignore a question (or
refuse to answer one) when confronted by a jour-
nalist, but you dare not do that with your voter. The
CNN-YouTube debate saw the highest viewership for
a debate among adults aged 18 to 34 in the cable news
history of America.

Though CNN got to choose the video-queries that
were aired, this ultra-democratic orientation, as tech
would have it, to the American presidential elections
has possibly altered the way political debates—at least
American ones—will be conducted in the future. It
has brought in more accountability to the process of
electioneering.

Now let’s please not speak about Indian elections
being radically revamped by YouTube. Imagine our
politicians confronted with a thousand YouTube
videos talking about “mundane” issues as taxation
and inflation…

But leave aside the politicians—the Web 2.0 phe-
nomenon has certainly reached Indian shores. The
effects of YouTube-aided citizen activism were wit-
nessed in India last month: an unhappy resident of
the prominent Unitech Builders’ residential project—
Uniworld City—in Delhi uploaded a video on YouTube
detailing his all-too-common builder-related prob-
lems. The video graphically portrayed the builder’s
lackadaisical approach towards its maintenance, the
unfulfilled promises of a functional swimming pool
and a children’s swing. This video was uploaded as a
last resort by the residents: their complaints to the
builders had fallen on deaf ears, they knew.

YouTube did come to their rescue. Within a few
days, there was a sudden turnaround by Unitech—
they did what was required. The promised pool is now

ready to use, and the swings have been fixed.
Months’ worth of complaints and letters to

Unitech and a community Web site could not achieve
what a video aired on YouTube did.

Indian consumer-product companies are warned.
They’d better realise the potential of Web 2.0, in
particular, the power of the tools it brings to the
consumer. If corporate America is crazy about
lawsuits, we as consumers in this country are crazy
about complaints—and rightly so, looking at the way
we are treated. Accountability takes a nosedive when
there is confrontation; moral responsibility is absent
in this vendor-is-king situation; we in this country
sometimes just do not have enough decency, and
we’ve gotten used to it.

Tech can change this; in the social sense, it is the
magic leveller. Sure, those with the upper hand won’t
like it, but nothing will prevent me and you from
logging on. Do it.

editor@thinkdigit.com

Editorial

Deepak Ajwani Executive Editor

Vendor1,
Consumer2.0

“Months' worth of complaints and
letters to a company and a community

Web site could not achieve what
a video aired on YouTube did”
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Enter

14
Anand Virani
spoke to us
about Mundu
Radio

14
Rumour didn’t
have it: Intel
joins hands with
the OLPC project

18
ISPs should not
be responsible
for users’
behaviour...?

20
FileRights: the
all-new P2P
copyright
defender

Digital Passion

Contents Magazine

Do It Yourself
26 Share Firefox Between
Windows and Linux
Dual-booting, are we? Feels powerful, doesn’t
it, an OS for a task... but some things can be a
pain. Like Firefox profiles. Get over it.

Main Story
41 On The Lot
First find out what an open source movie is, and
if that sounds cool, go about making one. We
can’t go into too much detail, to be frank, but
here are the basics

28 Pimped Out
Penguin
A problem of plenty is
the case with Linux
distros, we think. So
why not enjoy it?
Reviewed: off-beat
distross for specific
purposes, from
networking to gaming

Cover Story

46 A Cell, A Bell, And A Whistle
Presenting phones you know you want, and which
will do your ego proud, and which are 
useful at the same time—and they 
don’t all cost an arm and a leg!

38 Droolmaal
It is indeed about how much good stuff costs,
but we like the good, not the cost. We liked a
certain set of cans from AKG, an Alienware
machine that isn’t all about gaming, a
Klipsch speaker set with an exquisite name...

40 Take A Crack At
Yes, yes, you’re the budding system admin
spouting filth at worms contemptuously
called “users.” So can you disable access to the
Control Panel? And the printers as well? Win!

30 Days With
36 The Serpent And The Arachnid!
A mouse and a keyboard, that’s what our
reviewer spent 30 days with. And he actually
bothered to write all about it. But they’re
Razer, and they aren’t 200-rupee devices...

Know More About
90 Linux Desktop Environments  
Desktop Environments are the platforms that decide
the rules of dragging and dropping, look and feel of
the OS, etc. It goes beyond KDE and Gnome

3 Incredibly Useful Sites
92 New-age Wonders
Web 2.0 is usually light on the eyes, but some of
these newfangled sites are very utilitarian. Build a
WAP site, find a Web 2.0 application, use a cool new
news aggregator... at these sites we’ve reviewed

Agent001
88 Onboard’s Awful!
In this day and age and era
and century, are you still stuck
with an onboard graphics
solution? Your trusty Agent
eases you along the way to
graphics card glory

Digital Tools

Insight
21 Riders On The Stream
The G80 and the R600—from NVIDIA and
ATI—are hot names in the graphics card
empire. So what’s the difference? Plenty! All

demystified here!
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Trend
108 Companies Going Green
You’ve seen it in processors and other hardware.
Now we’re seeing it in technology companies,
this drive towards eco-friendliness—they’re trying
to save on paper and electricity. They’re
concerned for the environment. They’re taking
the baby steps.

Tech Careers
97 Master Of Penguins
It takes more than a geeky (or
aspirational) interest in Linux to make
a career of your knowledge of it. But
you can. Constant learning is key, as
are several other factors... We’ve
clarified a lot of the things you need
to know if you think you want a career
in Linux. The upside? The downside?
The good, the bad?

Smart Business
102 Lockdown
Laptop and PDA and Bluetooth and cell phone and
Wi-Fi and lots and lots of data all over, in tangible
and intangible state, begging to be locked down
before they’re stolen and misused?
Here’s a good dose of paranoia

Smart Soho
104 The Devil Has
Your Data
Put an old computer
to good use: make a
NAS (Network
Attached Storage)
server of it. This is
essentially a cheaper
alternative to a
dedicated file server 

Digital Business

Opinion Poll......................................15
Security Watch ................................15
The Digital World ............................16
Beat That..........................................17
Stat Attack ......................................18

Buzzword Of The Month ..................18
The A-list..........................................72
Tips & Tricks ....................................75
Q&A ................................................84
Whatever Happened To ..................120

Bluff Your Way Through..................122
Digit Diary ......................................123
Blogwatch ......................................123
Inbox..............................................130
Tech Quiz ........................................132R
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114 Game On
CellFactor: Revolution
disappoints. Colin
McRae: Dirt does not.
Tomb Raider
Anniversary is our
highlight... and Alex
Ward, creative
director at Criterion,
spoke to us about
Burnout: Paradise

Escape

121
James Fergason
gave us liquid
crystals in a form
such that they
could be put to
good use

120
Someone got so
immersed in a
game, they for-
got to give their
kids food to eat!

Digital Leisure Touched by Tech
111 Generosity 2.0
Do we upgrade too often?
Yes... Do those old boxes
need to be trashed? No!
Do more with them than
recycle the parts. Here’s
what, and how

Tech Quiz
132 Of Lasers And Security
If you get them all correct, we won’t give
you anything! But you can tell your friends
you did... and quiz them while you’re at it

Tabloid Tech
133 Accessories Anonymous
Our monthly dose of all the celebrity stuff
that does the rounds on the Net, and what
Big People are doing with and about tech



MULTIMEDIA
Bryce 5.5

Create breathtaking realistic 3D
landscapes and animations with DAZ 3D
Bryce. The easy user interface simplifies
the design process for a novice or the
seasoned professional. Start out building
or importing a landscape as impressive
as the Grand Canyon. You’ll have to
register your copy of Bryce at
www.daz3d.com/bryce55 to gain access
to your free Bryce serial number.

Softimage XSI Foundation Trial

Spend some quality time with the most
advanced 3D animation and character
creation software. Experience XSI’s
Gigapolygon core, elegant artist-friendly
interface, and non-destructive workflow
for modeling, character set-up, animation
and rendering. You will need an active
internet connection for this to work. 

trueSpace 7.5
trueSpace7.5 modeling capabilities are
unmatched. You have at your fingertips
literally hundreds of modeling tools for

polygonal modeling, Subdivision
surfaces, NURBS, metaballs, implicit
surfaces, you name it, all accessible via
intuitive direct manipulation interface.
You need to register at
http://cart1.caligari.com/ts5demo/form_
downloadts7.asp?adsource=&v=TS75 for
your trial serial key
■ AnimatorDV Simple+ for home use
■ aBasic Editor 10.4
■ Sony Sound Forge 9
■ Ulead Cool 3D Production Studio

SYSTEM
Autopatcher XP May 2007
Core Release
This release is based on the all-new
AutoPatcher 5.6 for Windows XP SP2 (x86)

Vembu StoreGrid Backup
Software-Free Edn 2.2.1

‘Vembu StoreGrid’ is a very well
designed backup and restore utility.
Ideal for small networks, StoreGrid can
facilitate intranet, client-server, and
remote backups.
■ Quick Heal Total Security 2007 
■ FreeNAS
■ Microsoft XNA Framework
■ Parted Magic 1.7
■ FlashBack 1.21
■ Hard Drive Inspector Standard Edition

INTERNET
Apple Safari for Windows 3.0.2
(522.13.1) Beta
Experience the web, Apple style, with
Safari: the fastest, easiest-to-use web

browser in the world. With its simple,
elegant interface, Safari gets out of your
way and lets you enjoy the web—up to 2
times faster than Internet Explorer.

Caligari iSpace

For web designers and developers who
want to design the different look of their
website, iSpace provides a web graphics
design tool that enables the creation of
stunning 3D web graphics. Working in
concert with traditional web design tools
iSpace delivers the full range of 3D
capabilities in a familiar drag & drop
environment. Unlike other 3D web design
tools, iSpace works seamlessly with your
main HTML editor such as Front Page,
Dreamweaver or Adobe GoLive and uses a
standard HTML format for input and output
of the entire fully formatted page. iSpace is
also an ideal companion tool for a
trueSpace artist who wants to create an
HTML page or  3D libraries for iSpace itself.

■ Collanos Workplace
■ IVBot 2.0
■ oSync 0.8.1 Beta 2
■ Qnext (Video Conferencing) 3.0
■ Windows Live Mail Desktop 8.0.1226

Beta
■ Caligari iSpace
■ Mundu Radio
■ Radmin Remote Control 3.01

FREE
CellFactor: Revolutions

CellFactor is an FPS with an epic storyline,
set in a warfare industrial atmosphere. It
features 3 playable main characters, each
with distinctive play styles. It was created
to promote the Aegia PhysX card, though
you don’t need one to play the first two
levels of the game.

Hidden & Dangerous 2: Sabre
Squadron
Reprise your role as commander of the
elite Special Air Services (SAS) in World
War II as you take on the Axis Powers in
nine new missions set in France, Africa

and Sicily. Fight through these
campaigns alone or play co-operatively
with friends. Sneak past enemy lines,
infiltrate heavily guarded bases and
outposts, and utilize superior tactics to
eliminate the opposition.

What Makes you Tick
Young Nathan has been sent by his
university to deliver an important message
to a retired professor. We are not initially
told how or why the university knows this
information, but the professor’s life is
apparently in danger, and Nathan must
find him. He is sent to the professor’s last

known residence somewhere in the
countryside, and he soon learns that he is
not the only one seeking the professor.
■ In Cubation
■ UFO: Alien Invasion

DEMOS
Ratatouille
Fast-paced game packed full of missions,
mini-games, daring heists, frenzied
pursuits, and wild chases!! Relive the
movie’s most intense action scenes
through the eyes of Remy. 

■ G.H.O.S.T. Hunters: The Haunting of
Majesty Manor

PERSONAL
Celestia-1.4.1-ED for
Windows

Celestia is a free space simulation
that lets you explore our universe in
three dimensions. Unlike most
planetarium software, Celestia
doesn’t confine you to the surface
of the Earth. This is a customised
version of Celestia, made for use
with the educational addons
provided in this DVD. Be sure to
check them out!

■ Celestia Educational Activities 1 &
2 – The Universe

■ Celestia Educational Activity 3 –
The Inner Solar System

■ Celestia Educational Activity 4E –
The Outer Solar System-Extended

■ Pagico (Basic) 2.1.0626
pdf-Office 6.0.2

■ Platinum Word 2007 Gold Edition
■ XMIND 2007

DEVELOPERS
C Code Library 1.7.6.21

C Code Library is a powerful multi-
language source code Library with
the following benefits: 1. Built-in
library with 50,000++ lines of code
2. Quick and powerful search engine
3. Powerful printing capability 4.
Password protection & strong 448
bits encryption (optional) 5. User
notes & attachments handling 6.
Favorites & rating support 7. Full
integration with *all* major
programming IDEs And much more!

■ Microsoft Expression Blend 2 May
Preview

■ myApps

■ VcSmith 2.2.2
■ Advanced Installer for Java 5.0
■ C Code Library 1.7.6.21

Editor.NET 1.47

Productivity

Tools

GamingF
8,700 MB Of Quality Content!

DUAL LAYER
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INTERACTIVE

VIDEOS
23rd Chaos Communication Congress:
How to Design a Decent User Interface
Take a look at software from a user’s point of view and
improve your applications. Prepare to be brainwashed!
This talk wants you to switch from the developer’s

perspective to that of an average user to design better UIs. Open the video in VLC
Media Player or Media Player Classic—you can find them both on this month’s CD

23rd Chaos Communication Congress: Body hacking
What happens when we leave behind cosmetics and start to modify our bodies and
minds to enhance who we are and what we can do? In this talk, journalist Quinn
Norton explores how technology and flesh are coming together. (from the 23rd
Chaos Communication Congress) Open the video in VLC Media Player or Media
Player Classic—you can find them both on this month’s CD

Microsoft Live Labs Photosynth Demo
Photosynth takes a large collection of photos of a place or
object, analyzes them for similarities, and displays them in
a reconstructed 3-dimensional space. Watch this demo to
see what it's capable of.

MOVIES
Dr. Jekyll and Mr. Hyde
John Barrymore stars in this 1920 renowned silent adaptation
of the Robert Louis Stevenson classic about a Victorian
scientist who turns himself into a murderous abomination.
This is one of several versions of the silent film production.

Entertainment

LG3D Live CD
LG3D is based on Sun’s Looking Glass Project. Imagine
this stunning 3D environment on your desktop—in less
than two minutes. Just burn the CD and get going!

LinspireLive!
Test drive Linspire Five-0 and the innovative CNR
Service, your ticket to thousands of popular
programs. There’s no need to install anything on your
hard drive. LinspireLive! boots and runs directly from
your CD drive, and it won’t affect your current system
or settings.

NimbleX 2007v2
NimbleX is a small but versatile operating system which
is able to boot from a small 8 cm CD, from flash memory
like USB pens or Mp3 players and even from the network.
Because it runs entirely from a CD, USB or network it
doesn’t require installation or even much hardware.
NimbleX is based on Slackware with the use of linux-live
scripts and it has a lot of this distribution advantages.

Damn Small Linux
It’s the smallest fully functional Linux distribution you
can get your hands on! Boot into it from a mini-CD,
USB Flash drive or even from within Windows!

LINUX SPECIAL

ArtistX is a live DVD which turns a computer into a full multimedia production
studio. It is based on Debian GNU/Linux and contains nearly all the available
free audio, 2D and 3D graphics, and video software for the GNU/Linux
computing platform.

FREE
Apprentice
In Apprentice, you play the unlikely
hero Mortimer “Pib” Pibsworth. This
game is right up there with the best of
them. Compared to Pleurgburgh on
occasion this game has the perfect
blend of humour, puzzles, gameplay
and graphics.

The Yetisports Collection

Join the Yeti as he makes his way
through eight games—Pingu Throw,
Orca Slap, Seal Bounce, Albatross
Overload, Flamingo Drive, Bigwave,
Free-Ride and Jungle Swing.

■ Fiat Panda Fun Racer
■ Fiend
■ Ragdoll Matrix Reloaded
■ SimSheep 2
■ Speedway
■ Zelda Classic

DEMOS
The Apprentice: Los Angeles

Compete for a dream job with Donald
Trump in this innovative twist on time
management games! Test your skills in
four iconic LA settings, each with its
own gameplay style. It`s like having
four games in one! You`ll prepare
food, manage your assistants and
control your inventory!

■ Dirk Dashing: Secret Agent!
■ Nanny Mania

FUN SOFTWARE
Rekkaturvat: Truck Dismount
The aim of this game is to injure
someone, as badly as you can, in a
truck accident that you have control
over. Control the speed of the truck,
the position of the poor helpless
victim, even place ramps to try and
score as much damage as possible.

■ Cartoonist 1.3
■ Water Rocket Fun
■ AV Voice Changer Software Gold

Edition 6.0.10

MUSIC
Creative Commons Music
Enjoy this collection of Creative
Commons Licensed Music in the Digit
Media Player

Digital Spaceland 4 by
Project System 12

According to the band: “Number 4 in
the series—dreaming in Space—
Adventures at strange places—
Fantasy”. Just that. 

MULTIMEDIA
PhotoMosaique 1.6

PhotoMosaique facilitates very easy
and fast creation of picture mosaics.
The final image comprises about a
thousand tiny images (thumbnails).

■ RealPlayer 11 Beta
■ iTunes 7.3
■ JetPhoto Studio 3.8
■ Reaper 1.873
■ Teen Spirit 0.91c
■ TV 2.0

SYSTEM
Returnil Virtual System
Personal Edition
Returnil Virtual System is a powerful
technology that clones a copy of your
System Partition in memory and can
create a file based Virtual Partition
where you can save documents, data,
and files while using the System
Protection feature.

■ ClamWin Free Antivirus 0.90.3-3c
■ Driver Magician Lite 3.26
■ Keyboard Extensions 1.0 build 53
■ Mz Cpu Accelerator 1.4
■ PowerPro 4.7
■ Returnil Virtual System Personal

Edition 1.62 Build: 4107
■ RightMark Audio Analyzer 6.0.5
■ SmartGesture Lite 1.0.1
■ ClickyMouse Advanced Scripting

Edition 6.31

TOOLS

ENTERTAINMENT

GAMING

L
The Phantom Inventory
The storyline: a bailiff visits an

old man in a wheelchair who
collects old mementos

(“souvenirs that no one wants”,
says the old man). He discovers a

vast attic full of curious objects
and sets out to take inventory of

all the treasures that are there.

SHORT MOVIE

Contents_Interactive_August_CD&DVD_ 07.qxd  11/6/2007  3:33 PM  Page 9



By Demand
You get to choose what goes
on Digit Interactive. This
month, you chose:

Sony Sound Forge 9
Size: 68 MB  

Latest Autopatcher XP
Size: 340 MB

Celestia + Add-ons
Size: 607 MB

taste technology at www.thinkdigit.com

This Month’s Question

To vote Log on to www.thinkdigit.com

What security software do you have installed on your computer?

Digit Reader Poll

Everything, from anti-virus to anti-phishing software.
A firewall, an anti-virus, and anti-spyware and anti-malware.
Only an anti-virus.
Security software… what’s that?

Subscribe
No more snail-mail!
No need to visit post
offices! All you have
to do is log on to
www.thinkdigit.
com/subscribe and
use your Credit Card
to make sure you
never miss another
issue of your favourite
magazine!

Which Operating System would you like to
use?

41%11%

28%

18%

2%

Last Month’s Question

Total: 3560

FROM THE DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
This month, we feature the seond-hand goodies being sold on our Forum by its members.

SSeeccoonndd--hhaanndd  ggooooddiieess  bbeeiinngg  ppeeddddlleedd  iinn  BBaazzaaaarr

What: Transcend 2x 1 GB DDR Memory
Who: codeguru
How Much: Rs 2,500 each
Link:
http://www.thinkdigit.com/forum/sho
wthread.php?t=58974

What: Gameboy advance SP with 8
bundled games
Who: ankush
Where: Delhi
How Much: Negotiable
Link:
http://www.thinkdigit.com/forum/sho
wthread.php?t=61939

What: Asus 8800GTS (320 MB) +
Corsair 620 W Power Supply
Who: Scudmis
Where: Mumbai only
How Much: Rs 23,000
Link:
http://www.thinkdigit.com/forum/s
howthread.php?t=63402

What: BIG 7600GS
Who: ROCKING7575
How Much: Rs 4200
Where: Gandhidham, Gujarat
Link:
http://www.thinkdigit.com/forum/s
howthread.php?t=63351

What: XFX 8600GT
Who: regenade
How Much: Rs 7,000
Where: Bangalore
Link:
http://www.thinkdigit.com/forum/sho
wthread.php?t=63224

What: Athlon 3000+,K8V-MX ,
Geforce FX 5200, 512 MB ZION RAM
Who: jack_sparrow
How Much: Negotiable
Link:
http://www.thinkdigit.com/forum
/showthread.php?t=62679
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Mundu Radio is a mobile-based
application that allows you to
connect to any Internet-based
radio station you’d want to. We
caught up with Anand Virani,
associate vice president of
Geodesic, the developers behind
Mundu Radio, for a quick salvo of
questions… 

What sets Mundu Radio apart
from other players like the
Nokia Internet Radio Client? 
Virani: Most internet players have
a fixed playlist, or cannot search
for third-party Internet radio
stations. Mundu Radio is one of
the only applications that allow
users to add their own stations to
the list. In future editions of the
application, a search feature
labelled “discover” will be added;
this will allow members to search
for stations based on genre, time
period, and more. Mundu Radio is
also the only cross-platform
player—it works on Series 60
Symbian as well as Java-based
phones.

How much will Mundu Radio
cost once out of beta?
Virani: We are in the process of
rolling out a commercial version
of Mundu Radio. Since the cost of
bandwidth in India is high and
unlimited data plans are
expensive, we are looking at
providing the service at a very
attractive rate. The pricing model
could be based on a “one time
downloading fee,” though that
will be decided later.

Will you bring in your own local
content as well?
Virani: India is a key market for
us and local content is very
popular. There are about 50
Internet radio stations we have
found that air local content. If you
access the “India” genre in the
playlist, you will find most of the
popular stations there. We are
constantly being approached by
Internet radio stations, and are
looking to partner with as many
of them as possible.

The iPhone Is Hackable!
Researchers at Independant Security Evaluators, a company
involved in testing clients’ computer security, informed of
an Apple iPhone vulnerability which was detected by
hacking the Wi-Fi connection and also by browsing to a Web
site containing malicious code.

Xbox Warranty Woes
19 July, Microsoft said it expects to spend more than $1
billion (Rs 4,000 crore) to repair widespread hardware
problems in its Xbox 360 video game console. A large
number of them have broken down of late after firmware
upgrades by consumers.

Abrief recap: under the
OLPC (one laptop per
child) project, a laptop

loaded with XO software,
costing $100, would be given
to every child in
participating developing
countries to aid learning.
This was the brainchild of
Nicholas Negroponte,
founder of the well-known
MIT Media Lab.

It didn’t remain a
Negroponte affair. It
became a low-cost-PC-for-
the-third-world thing, even
if no-one actually used the
word “third world.” Intel
hopped on the proverbial
bandwagon of low-cost PCs,
unveiling their Classmate
PC, a laptop for children—
but more expensive, and
with more features.

The scene became almost
ugly: Intel chairman Craig
Barrett referred to
Negroponte’s XO Laptop as
“a $100 gadget.” A miffed
Negroponte ranted: “Intel
should be ashamed of itself.
It’s just—it’s just shameless,”
in an interview with the BBC
News Web site. Mr Gates
himself later pointed to the
lacking design of the XO
laptop, its lack of a hard
drive, and its small screen.

Negroponte went on to
say Intel’s problem was that
an AMD-designed processor
was being used in his XO
laptop. The competition and
differences were increasing.

Brace yourselves: Intel,
out of the blue, joined hands
with the OLPC project.
Everyone was taken by
surprise, taken aback, even.

A delighted
Negroponte said,
“Intel joins the
OLPC board as a
world leader in
technology, helping
reach the world’s
children.
Collaboration with
Intel means that the
maximum number of
laptops will reach
children.” 

Software for the
Classmate PC would
run on the XO
laptop. Future XO
models could have
Intel chips,
speculation went.
The question that now arises
is about the role of AMD,
who have been silent about
the entire issue. Whose
processor would the XO
laptop carry?

That hardware decision
will be taken by the OLPC
Foundation. “Eventually,
different PCs with different
hardware and software
would be offered by OLPC,”
Walter Bender, head of
software development at
OLPC, informed the BBC
News Web site.  

Then again, the OLPC
project needs to tackle
several issues that surfaced
in the course of their pilot
test. The most recent is
that of setting up filters in
regards access to explicit
content; Nigerian students
have used the laptop to
surf porn.

This project has been
ongoing for the past five
years. Pilot studies are still

on. Issues such as explicit-
content filters, the cost of a
proprietary OS, eco-friendly
hardware, longer battery
life, and storage in terms of
a hard drive need to be
addressed by the OLPC
project. However,
Negroponte’s bottom-line is:
“This is an education
project, not a laptop
project.”

The icing on the now-
musty cake is that the
project still faces criticism;
some say children in
developing countries need
food, clothing, and shelter—
not laptops. The latest
updates say the XO Laptop is
now in production and
might be released late
December 2007.

Still, it’s not now a one-
man show, a one-project
drama. Intel’s stepping in
will make a difference: the
chip giant isn’t in it for
charity. There will be

Enter
OLPC NEWS AGAIN

Intel Steps In, Unexpectedly

Illustrations Harsho Mohan Chattoraj

■ US Citizens grilled presidential candidates through video questions on YouTube ■ Intel quad-core processors get cheaper ■ China to curb time spent gaming online

Anand Virani,
Associate Vice President, Geodesic



competition (AMD is still in
the picture). There will be
collaboration. And we can
hope for something
concrete to result.

ERASE YOUR TRACES

Anonymous
Surfing Goes
Mainstream

As you know, search
giant Google keeps a
history of your

searches after you log into
Google accounts. The
following might seem
insignificant for those with
the technical savvy and
inclination to cover their
online tracks if and when
they need to—whether by
way of cookies or by way of
using the feature Google
provides to manage search
history—but the fact is, not
everyone is savvy, and not
everyone is inclined that
way enough to bother—and
really, not everyone has the
time to bother.

In view of this, Web-
search portal Ask.com
thought of going against
the norm set by Google. Ask
recently introduced a tool

called AskEraser to its
portal: AskEraser will allow
users search anonymously
and set a privacy level. If
the user doesn’t want any
search history maintained,
he or she can select the
option of not retaining any
such data whatsoever.

If AskEraser is not
turned on, the machine IP
address will be stored along
with cookie information
and the URL the visitor
goes to. Ask will stop
linking searches to IP
addresses after a period of
18 months. However, a halt
on data deletion will be
ordered if the US
government has to retain
data for investigation. 

Microsoft will join
Ask.com on the same front,
allowing their users to search
anonymously on Windows
Live Web sites. They, too, will
scrub all search query data
after 18 months, data that
could identify the searcher.
Google, too, recently
announced it would make
the data it stores about its
users anonymous after 18 to
24 months. All this comes at
a time when what terrorists
and would-be terrorists are
searching for has come
under the scanner.

As a matter of fact,

search engines retain user
data for site improvement,
which brings in the risk of
data being hacked or
misused. Pressure from the
European Union on the
time limit for retaining
users’ search query history
has led to this situation.
Microsoft and Ask.com are
looking forward to invite
Web portals like Google,
AOL, and Yahoo!, as well as
privacy advocates, for talks

Yahoo! Mail
Beta
IM integrated
with Web mail is almost the
norm now. Google added the
chat feature to Gmail in June
2006; users could have chat
sessions and mail in the same
window. In February 2007,
Yahoo followed suit…

Hotmail
…But despite
being the
pioneers of
Web mail, MSN
Hotmail (now
Windows Live Hotmail) still
doesn't seem to get it. There
might still be a lot of users
of the once-Hot mail, but the
others have a definitive
edge now.

DIGIT AUGUST 2007

Security Watch

Sour Cup Of Java
The Problem
Sun has reported a serious
vulnerability in the Java
Runtime Environment (JRE). 

In the JRE, it’s a buffer
overflow vulnerability. This
might allow a non-trusted
applet or application to change
system privileges. For example,
an applet may grant itself
permissions to read and write
local files or execute local
applications. A second
vulnerability here may allow a
non-trusted applet or
application to cause the Java
Virtual Machine to hang.

The Solution
Visit http://tinyurl.com/2mnjae
for information on what you
need to do for your OS.

QuickTime Woes
The Problem
Multiple critical vulnerabilities
have been reported in Apple’s
QuickTime, wherein malicious
people can compromise a
user's system. 

The Solution
Update your copy of Apple
QuickTime—http://tinyurl
.com/2vwdxc for Windows,
and http://tinyurl.com/
35zvwy for the Mac

15

What security software do you have installed on your computer?
Everything, from anti-virus to anti-phishing software. A firewall, an anti-virus, and anti-spyware and anti-malware.
Only an anti-virus. Security software… what’s that?43

21

“I like to try out new
software, so I have
almost everything
installed. The anti-phish-
ing software I don’t use
because I do not do
Internet banking or

other such transactions on the computer.”
Pommy Bal

Mumbai

“Today, a leak in your
security could mean
anything—losing your
bank balance, theft of
sensitive personal
information—the con-
sequences are unthink-

able. Being careless with your security
these days is like being ready to be loot-
ed in any way you can be.”

Rohit Patel
Rajkot

“No anti-virus or anti-spyware
product is perfect—for exam-
ple, if Avast! detects a file as a
virus or Trojan, Kaspersky
finds the same file safe.
That’s why I keep two types of
anti-virus, anti-spyware, and

firewall installed on my computer. I also like to
check their working and performance—and how
secure and safe they are on the PC.”

Anurag Pandey

Delhi
“I don’t have the Internet
on my PC at home, so I
don’t need anything apart
from an anti-virus. I use
Avast!, which I keep up-to-
date using the updates
you provide on your CD.”

Priyobatra Sharma
Bangalore

“I use Linux full-time!”

Prakash J Kokkattu
Hyderabad

“Definitely. I want to
keep my computer clean
and safe. I don’t want it
to stop working.”

Santhosh S
Bangalore

■ Doctors at USA’s Baltimore’s Sinai Hospital visit patients via video-conferencing robots  ■ “All ‘big news’ from this year’s E3, is coming from Nintendo”—Gartner, on the Wii’s success ■

(One Silly Question makes way for Opinion Poll. You, too, can participate at www.thinkdigit.com)Opinion Poll
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to better handle the
privacy of users’ search
query history. 

Whether these privacy-
maintaining steps will be
successful or not, users will
certainly feel better about
it. Users need no longer feel
“under surveillance,” and
also, the chances of
misusing data would be
reduced. Search portals
seem to be looking to
protect you: still, they need
industry consensus and
collaboration to make the
move a success.

AGAIN…

Chips Off
The Clock  

Age old rival warlords
Intel and AMD seem
to be ever creating

some buzz or the other to
remain in the news. Their
rivalry in the silicon chip
market continues to keep
the media orchestra
playing. Both recently
announced the roadmaps
of their next-generation
processors, creating yet

another buzz in the chip
market and getting
consumers all excited.

Intel gave out
additional details of their
45nm processors—Penryn—
due out later this year.
Also, Intel shared a few
details of their next-
generation architecture
called Nehalem for its
Penryn processors. On their
mobile platform Santa
Rosa, fresh new mobile
Penryn Core 2 Duos will be
available before the next
generation Montevina
mobile processors.

On other hand, to catch
up with the quad-cores from
Intel, AMD’s quad-core
Barcelona’s performance
reports are yet to come. AMD
spoke about GPGPU
flexibility and their Fusion
processors. Also, AMD
announced plans for their
second-generation Stars
(quad-core and dual-core),
and the single-core Sparta
processors. AMD also
announced their 65nm
Athlon 64 refreshed single-
core Lima processor would
be replaced by Sparta, set for
launch in September 2007.

Call it leapfrogging or a

bullfight, but the two chip
giants seem to enjoy
sharing their plans and
leaving consumers
confused with processor
code-names! The processor
wars took a twist when
Intel announced Core 2
Duo stepping and price-
cuts of as much as 50 per
cent for the Core 2 Duo
series. Also, fresh quad-core
processors will soon join
the Quad family. Following
in Intel’s steps, AND, too,
announced a price cut for
their single-core and dual-
core processors.

What’s been done is
nothing new except for the
sharing of their processor
roadmaps. However, the
timing creates a situation
where the possibility of
loss due to price cuts
haunts AMD. If Barcelona
outperforms and meets
expectations, Intel stands
to suffer from the price
cut. But if, on the other
hand, Barcelona fails to cut
it, AMD would have to cut
prices, which could even
compel them to change
their roadmap. AMD has
already suffered a $600
million (Rs 2,400 crore)

loss in 2nd quarter of 2007. 
Both will be affected by

their price cut strategies,
and as usual, the consumer
will have more options.
But the upcoming
processors will only make
consumers drool if there
are revolutionary features
added to the cores rather
than evolutionary
functions. All this is yet
another case of the rivalry
heating up, and we cannot
help but report it! 

THE CLASSMATE PC

Will These
Dinkies
Deliver? 

The much-awaited
learning companion
for students, Intel’s

Classmate PC is finally
here. Intel and HCL
Infosystems launched it
last month. The launch of
the Classmate PC is part of
Intel’s World Ahead
Program (WAP) for
promoting technology as
learning and teaching tool.

A Round-up Of Technology News From Across The GlobeThe Digital World

ITALY 
After France, the Italian parliament
has approved a bill to migrate all
the computers in the assembly
from Windows to Linux in a bid to
cut costs. The parliament has
chosen the SLED distribution.

The government is offering $968
million (Rs 3,872 crore) to state
and local agencies for technology
for communications during
disasters—broadband video
applications, mobile public safety
networks, satellite communication
systems, and more.

UNITED STATES Nokia’s DVB-H technology
standard for mobile TV
broadcasts has been approved
by the EU; it has said that Europe
needs one common standard for
mobile TV.

EUROPEAN UNION

UNITED KINGDOM
A museum is being set up to
celebrate the country’s role in
building modern computers. The
National Museum of Computing will
be based at Bletchley Park, where
WWII code-breakers built the first
recognisably modern computers.

SOUTH KOREA
A new law has been enforced
to curb cyber-bullying: false
IDs may no longer be used.
Web portals now have to
record real IDs and addresses
of users before they are
allowed to put up posts. 

■ Vista Service Pack 1 not in the offing—Microsoft prefers the patch-a-month system; customers frown ■ iPhone Nano rumours rife; corresponding stock rise makes Apple happy ■
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Photograph Amandeep Singh

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 

Beginning XML
4th Edition
by David Hunter, 
Jeff Rafter, Joe Fawcett

Published by
Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption

“Windows Siesta””

The first shipments of HCL-
branded Classmate PCs are
expected in August /
September 2007.

Pilot tests for the
Classmate PC have been
conducted by Intel in
certain schools in India
since December 2006. Intel
had initiated pilot
programs by deploying
Classmate PCs in three
schools at Ghaziabad,
Faridabad, and Bangalore.

Intel director for
marketing (South Asia)
John McClure has said that
the Intel Development
Center in Bangalore had
extensively designed both
the hardware and software
for the Classmate PC,
which is rugged and could
withstand the using
pattern of small children
starting from class three. 

The specifications of the
Classmate PC seem good on
paper and possibly
otherwise: a 900 MHz Intel
Mobile Processor, 256 MB
DDR II RAM / 512 MB SO-
DIMM, 1 GB / 2 GB NAND
Flash memory, a 7-inch LCD
screen, and sporting either
Windows or a Linux OS. It

weighs 1.45 kg and has a
six-cell Li-on battery, which
is expected to last four
hours. For connecting to the
Internet, it uses Ethernet
(10/100M) and Wi-Fi (802.11
b/g) connectivity. Pretty
good for use by kids up to
age 12; they don’t need
quad-cores!

The laptop carries a
special educational feature
set integrated for teacher-
student and teacher-parent
collaboration. This feature
can be used as an
innovative teaching aid.
For instance, teachers can
demonstrate diagrams and
graphs from their laptops
onto a projector / LCD TV
screen, and using the Wi-Fi
/ Ethernet, the diagram or
graph will simultaneously
appear on the students’
Classmate PCs.

HCL announced tie-ups
with content providers and
Education Service
Providers (ESPs) to bundle
their content with their
HCL Classmate PCs. HCL
will provide more
educational content and
learning solutions. The
Original Equipment

Manufacturer Partners
Wipro Infotech and Zenith
Computers will also offer
Classmate PCs shortly
under their brand name.

With an estimated price
of Rs 18,000 for the
standalone model, the
Classmate PC would be
bundled with teaching aids,
educational programs, and
even training content for
teachers to make the best of
it. The entire system could
be offered to schools on a
monthly subscription basis,
said Rajendra Kumar,
executive vice president,
HCL Infosystems. Also,
parents can access feedback
from the teachers.

An anti-theft security
feature is included, which
upon being enabled
through the network
works through digital
certification. Also, audio /
video and educational
applications can function
on it. McClure has said,
“The initial target
audience would be private
schools, and then it will
move to government-run
programmes”.

It would be interesting

to watch how Indian schools
will make the best of this
educational tool. The
bottleneck of limited storage
capacity (no hard disk, just 1
or 2 GB of Flash) can be
augmented using network-
based storage. But this
depends upon the school’s
policy and the nature of
usage for education.

SILLY NAME, BUT…

Low-cost,
Green PC:
All Good

An energy-efficient and
environmentally-
friendly computer has

always been the ideal. Here’s
something along those lines:
the Zonbu Computer, a $99,
eco-friendly little box-like
PC, a subscription-based
solution devised by Grégoire
Gentil and Alain Rossmann.
Gentil is the CEO of Zonbu;
his last successful start-up,
Twingo, was acquired by
Cisco in 2004. Rossmann is
an ex-Apple employee and

Last Month’s Winner!
Ashwin Gupta, 
Ashwin Gupta, Kanchili-532290
Srikakulam dt. A.P.
“SANI-AMIR-ZA”

DIGIT AUGUST 2007

■ Palm to launch Linux-based smartphone next year—will replace PalmOS 5 ■ Cross-browser exploit uses IE-Firefox interaction to compromise systems—finger-pointing ensues ■
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well-known technology
entrepreneur.

Gentil came up with the
idea of Zonbu after having
witnessed his father’s
Windows PC constantly
crashing. Then he, along
with Rossmann, worked on
Zonbu. It will be sold from
the Zonbu.com Web site. It
comes with Gentoo Linux
loaded, and has ready-to-use
apps like Firefox, Skype,
OpenOffice, a media player,
graphics editing tools, and

more. What it doesn’t come
with is monitor, keyboard,
and mouse.

The Zonbu is sold in
two versions—Locked and
Community. The Locked
version costs $99 with
restricted access to the
root of the Linux OS. In the
Community version which
costs $249 (Rs 10,000), the
root is accessible, so more
applications can be added
using Gentoo Package
Manager. The company,

however, doesn’t commit
support for the
Community version. 

The Locked version
demands a monthly
subscription fee of $12.95
(Rs 520), and includes 25 GB
of free online storage.
Storage capacity can be
increased.

The computer is based
on a 1.2 GHz Via C7 ULV
chipset and has 512 MB of
RAM, integrated graphics,
and a 4 GB Compact Flash
card. It’s a fanless, silent PC
drawing much less power
than a regular PC: a Zonbu
spokesperson has claimed,
“Zonbu uses around a tenth
of the power of a
traditional PC.” 

The founders have also
claimed receipt of the
highest possible
certification from the Green
Electronics Council (GEC), a
non-profit group that has
created a product
classification standard
known as Electronic
Product Environmental
Assessment Tool (EPEAT).

Such a solution has
never been available for
home users: Zonbu is a
decent enough standalone
PC for users not so
comfortable with computers.
MSN TV is a similar solution
meant for audio-visual
entertainment, but it
doesn’t sport the features
Zonbu offers.  

It is developing
countries like India that are
the potential market for
such products. The only
drawback is the storage
model: think of broadband
penetration here.

Even so, on a positive
note, we must appreciate
the efforts of those who
are out to prove that PCs

need not be energy hogs;
that they need not have
advanced configurations to
be functional; that
alternative storage models
might very well work. On
the other hand, we must
ask: is this merely the
brainchild of two people
out just to see if their idea
will make it big? Will a
subscription-based model
work for a PC? Will there
be switchers-over to
“simple and small” in the
current scenario?

Questions abound, but
we’re reporting this
primarily because Zonbu
seems to be cheap. Is that
the next wave?

WE’RE JUST THE CONDUITS

Washing
Their Hands
Off It

Music piracy as you
very well know is
rampant on the

Web. No sooner does an
album get released than it
gets uploaded on P2P
networks. A historic
decision was ruled by a
Belgium court earlier this
month. The court decided
that one of the largest ISPs
in the country would be
given six months to install
a technology that would
block or filter copyrighted-
infringing content shared
via P2P networks.

A Brussels court-
appointed expert
mentioned seven ways to
install filters or block P2P
traffic. These filter
technologies are automatic
in nature, so they won’t

Apart from improving its existing services like e-mail
and IM, Microsoft is working on a concept to unify all
the services it offers onto one platform called the
“Cloud OS,” a.k.a. Windows Live Core.

Cloud OS will run Web-based applications like
Microsoft’s Live service, using it to unify platforms from
Windows on the PC to the Xbox platform to Windows
Mobile. Customers will then be able to access their data
from any platform—it will be stored online. If you took a

photograph using your Windows Mobile based phone,
you’ll be able to access it seamlessly on a PC. Or, save
game-related notes from your Xbox  and access them
on your mobile phone. Microsoft is solidifying its stance
with the launch of two new Live services: one for
storing and sharing photos online, and another for
storage of any kind of file.

There’s quite a bit of speculation and unconfirmed
reports regarding the exact nature of the end product—
but it’s in the general direction of MS getting up there
on the Web the way it stands on the Desktop.

Cloud OS

It’s all in the numbers

Stat Attack

CPU types worldwide as of July 2007

India
produced
nearly 3.1

crore mobile
phones in

2006—worth
about

$5billion
(Rs 20,209

crore)

The average
download speed

on Internet
connections in the

US is 1.97 Mbps.

Japan: 61 Mbps

Google served
3.8 billion searches in

April 2007

Indian cellular services revenues
amounted to $9 billion (Rs 36,000 crore)
in 2006, and are projected to grow at a

compound annual growth rate (CAGR) of
18.4 per cent  to reach $25 billion (Rs

1,00,000 crore) in 2011

India’s video game 
console market

is expected to grow to
Rs 506 crore

by 2010

Opteron 
(4.52%)

Athlon XP 
(7.67%)

Athlon 64 (29.1%)

Pentium 4 (18.4%)

Turion (0.56%)
Pentium D (3.68%)

Pentium M (2.81%)

■ Nokia launches Global Positioning Service, will make it available initially for Nokia N95 users ■ Spielberg to direct two Electronic Arts games—one for Wii, one for PS 3, XBOX 360 and PC ■
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FileRights
What is FileRights?
FileRights is a collaborative
programme devised to
prevent copyright content
from being distributed on the
BitTorrent network.

How does it work?
A Web site for original content
developers and BitTorrent Web
site owners will host a
database to which the original
content developers can upload
details of their movies, TV
shows, and songs. FileRights
then distributes these details to
participating BitTorrent sites so
that copyrighted content can
be removed from their search
results. FileRights will use the
file’s digital signature, or MD5
checksum—also known as
“hash values”—to detect this
content over their network.

Why is it a good thing?
Currently, the only way for
original content developers to
remove their content from a
BitTorrent site is to issue Digital
Millennium Copyright Act
(DMCA) affidavits for each and
every torrent file on the site.
FileRights will take much less
time to implement.

Where lies the problem?
Since FileRights uses hash
values to detect content, even
the smallest alteration to a file,
like the adding of a frame to a
video, will make the file unique
and untraceable by the
database, thereby debunking
the entire system. Moreover,
Digital Millennium Copyright
Act take-down affidavits are
worrisome only to BitTorrent
sites hosted outside the US.

When did it start?
The FileRights network
programme was launched in
July 2007. 

Who is developing it?
Ironically, the team behind the
popular torrent site TorrentSpy,
a site that hosts torrent files of
pirated content, has developed
the system. They hope to rope
in more original content
developers and BitTorrent sites.

breach the customer’s
privacy.  John Kennedy,
chief executive of the
International Federation of
the Phonographic Industry
(IFPI), praised the
judgement and
commented, “The
Internet’s gatekeepers, the
ISPs, have a responsibility
to help control copyright-
infringing traffic on their
networks.” The IFPI
represents recording
industry worldwide.

However, after this,
British ISPs expressed firm
discontent against the
ruling. The UK’s Internet
Service Providers
Association (ISPA) re-
asserted that ISPs should
not be held responsible for
the music sharing that
takes place via P2P
networks. According to the
eCommerce Directive (of
2002), ISPs are mere
conduits of information,
noted an ISPA
representative.

But certain ISPs have
realised their liabilities,
and are moving away from
being labelled “pure
conduits.” Danny Prieskel, a
telecommunications
lawyer, believes that UK
ISPs would strongly oppose
it if such a liability is
imposed upon them. David
Cameron, UK Conservative
Party leader, said in a
speech that if child
pornography could be
removed by ISPs, then they
would block the sharing of
copyright-infringing
content. In regards this, the
ISPA justified themselves
saying two different things

were being talked about:
child pornography is a
criminal case, and
copyright infringement
would be a civil case.
Cameron added that
Internet censorship
should take place at the
government level and not
a corporate level. People
are responsible for
uploading and sharing
of illegal content, not
ISPs, he reiterated. 

The ISPs seem to be
pretty much sick of it,
and just want to wash
their hands off the

issue. If the ISPs were to
start examining every data
packet transmitted, one
can imagine the increase
in the workload on
systems. It could even
cause data congestion and
slower speeds.

In India, certain ISPs
believe in their own
liabilities just to the point
where transmission of
copyright-infringing
content becomes a major
issue. However, customers
are smart enough to install
key-loggers on their systems
and put them to
surreptitious use, installing
several packet masking
software, and even
employing router hacks.
Should ISPs be responsible
for what’s transmitted
across the wires? It’s a
debate almost as large as
that of P2P and DRM itself.

COSYING UP

What Price
Privacy?

Here’s another case of
kiss and make up:
earlier this year,

Google sued Microsoft in
regards Vista because it left
no scope for competition—
Vista had locked down the
Desktop search program.
Google wanted to develop
search-based products for
Vista, and complained
against incompatibility
issues with the OS.

Microsoft initially called
Google’s complaints

baseless. But the software
giant is currently enjoying a
boost in their profits—of
about 11 per cent—for Vista
and other products. And
recently, they announced
they would change the
Desktop search features in
the engine. This would
allow users and OEMs to
choose Desktop search
programs in Vista other
than Windows Instant
Search. This change will be
activated from Vista Service
Pack 1, due in the last
quarter of this year.

Microsoft will provide
technical details of the
Desktop search to other
Desktop search providers so
they can design their
product for optimisation of
computer resources. It will
make independent software
vendors’ search products
interoperable with Vista. The
royalty-free programme for
software vendors will be
extended to 18-months. 

In July, Microsoft filed a
patent for ad-supported
desktop search versions. The
patent focuses on using
software that will display ads
after the gathering of
information lying on the
user’s hard drive. Data
security would be of the
utmost concern, keeping
users in mind.

Well done, Microsoft, for
patching up with Google.
But they are planning to
put the security of user at
the highest form of risk.
The ad version of their
desktop search could well
create compatibility issues,
and raise the risk of
malware attacks as well.
The adware might even
gather information based
on the user’s files and
documents. It’s a case of
keeping potential lawsuits
at bay by giving the users
something to worry about.
Of course, users will have
the option of not installing
either a Google or a
Microsoft tool, but when
they’re there, we a believe a
large number—if not the
majority—will go ahead and
do it anyway.

May the mini-drama
unfurl! 

■ Apple takes 4th place in notebook sales—behind HP, Toshiba and Gateway ■ Indiana University students phish people to understand the phenomenon and stress importance of security ■



Michael Browne

It’s been an impressive sight to anyone even
loosely following developments in the graph-
ics industry. NVIDIA’s G71 and ATI’s R580

nearly doubled performance in all the games
that were new back then, and visuals were
improved dramatically. There was, however, a
limit to what either vendor could do with
DirectX 9.0’s Shader Model 3.

Then Windows Vista was announced, along
with the new, backwards-compatible DirectX 10.
Speculation ran wild as everyone tried their hand
at calculated guesses as to what the new standard
would amount to in gaming terms. More impor-
tantly, who would emerge top dog from among
NVIDIA and ATI—two companies that have been
slugging it out since DX 8.1 days. With both
companies now offering DX 10 capable GPUs, all
speculation has been laid to rest. There is still
uncertainty, because we still don’t know how the
latest cards perform under DX 10. Here, we hope
to clarify things, however, by peeking under the
bonnets of ATI’s R600 and NVIDIA’s G80.

A Demystification Of The Basics
Shaders: Colouring at the speed of light!
As we all know, while rendering any 3D scene,
texture (pixel) and geometry (vertex) information
is sent to the graphics card for processing. Earlier,
cards used to have a set of fixed algorithms hard-
wired into them; this was used to process the
data. It was known as the FFP (Fixed Function
Pipeline). Game programmers could only select
from the limited functions hard-wired onto those
cards. Restrictions on the programmer and limi-
tations in the flexibility of the code itself meant
games couldn’t look as realistic as developers
wanted. 

Shaders were developed in 2001, and their sole
purpose was to give programmers more liberty
with the code. There were primarily two types of
shaders—Pixel and Vertex. On a software level, a
shader is in essence a small algorithm that
describes mathematically how a particular mate-
rial or texture is rendered onto an object. This
shader algorithm also specifies how light affects
the appearance of the object. So a shader actually
defines an object’s physical properties in a 3D
scene. This (shader) code is loaded into the graph-
ics card’s memory, and from there fed directly
into the graphics pipeline, where it is executed.

Riders On The Stream
We take more
than a peek at
the innards of
the latest high-
horsepower,
pixel-grinding
top guns as
NVIDIA’s G80
squares off
against ATI’s
R600
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On a hardware level, a shader unit is essen-
tially a little engine of its own that can process a
particular type of 3D information. Shader units
are designed to execute shader code based on a
particular API, or compatible with a certain set of
APIs—such as OpenGL and Microsoft’s DX. A
graphics card will contain multiple shader units,
enabling it to process, in parallel, large volumes of
data. DX 10 makes programmers’ lives even easier,
as there is no distinction between pixel and vertex
shaders on the hardware level. Some of the soft-
ware restrictions have also been removed. This
gives coders the liberty to implement new and
improved techniques to give improved visual qual-
ity… the Holy Grail for developers and gamers.

Graphics Pipeline: But Where Are The Pipes?
This isn’t like a real physical pipe per se. The word
pipeline refers to individual stages required to
perform a much larger task. The key to remem-
ber is that a graphics card (much like a CPU) is
rapidly fed with a lot of data to be processed. In
order to achieve this repetitive task, some
streamlining is needed. Each pipeline represents
a single task to be performed in order to give you
that gorgeous display on-screen. Multiple
pipelines get fed with data and instructions;
they work on their specialised tasks, complete
them, and pass the results forward. In a nutshell,
the graphics pipeline is tasked with accepting
some form of a 3D scene and processing it to
deliver a 2D scene to your monitor. Keep in mind
that this is not a simple process, since every
object in a rendered 3D scene is basically a
completely discrete 3D model—referred to as an
entity—and involves the following:

The Transformers: Transforming objects in
part or whole from their original space to the
desired space in the 3D scene. This part of the
process involves scaling. Size scaling of 3D
objects is not easy, as every entity has its own
coordinate system (remember Coordinate
Geometry in high school maths?), and the
entire object has to be accurately rendered
from each and every angle while maintaining
this scale. This stage of the pipeline is also
tasked with rotation of the objects in the
scene, also called transformation. This rotation
could be along either the X- or Y-axis, or both.
The Wide Angle: The next step involves the
viewer and his perspective view and orienting
everything in the scene to that view. This is
called the camera angle. This also involves scal-
ing, rotation, and even translation (movement
along a defined axis). All this is done to
appease the field of view of the user; nearer
objects will be larger than objects far away.
Exterminatus Triangulus: The third stage
involves efficiency management. It’s time to
remove all the hidden triangles that are
uselessly composing invisible objects. There’s
no use rendering the back surface of an object,
or the detail behind a wall facing the perspec-
tive view of the viewer, is there? This stage
reduces the work the graphics card has to do,
and is called Occlusion Culling. In modern
games where there are transparent objects
that themselves may have other objects visible
through them, this part of the pipeline is very

important. For example, fish swimming in a
pond cannot be treated as invisible. 
Light My Fire: Next, the scene has to be lit (illu-
minated). This is done keeping in mind the
locations of light sources in the scene and its
effects on the Objects. The properties of each
object such as change in colour, reflectance,
and refraction, among other surface properties
of each object, in response to the light from a
particular source, has to be taken into account.
Take into consideration six different light
sources of varying intensities and you’ll see
how difficult this stage can become! Once
again, the triangle-cutting scalpel is applied to
speed things up by reducing GPU load. All that
needs to be lit in a scene is what appears to the
viewer from his point of view.
Lose that Z axis: This involves the final
conversion from 3D to 2D, that is, your moni-
tor. All the data that is held in textures and
vertices must now be converted to pixels
displayable by your monitor. Then there are
the final touches to be added including
Anisotropic Filtering, Anti-Aliasing, Shadows,
Fog, Alpha Blending, Shading, Filtering, sten-
cils, and depth, among others. This entire
stage is called Rasterization.

With the basics clear, we can move on.

Parameters

No. Of Transistors (million)

Core Speed (MHz)

Number Of Shader Units

Shader Unit Speeds (MHz)

Memory Bandwidth

No. of TMUs

No. of ROP/clock

Number Of Z Compare Units

8800GTS

681

500

96

1200

64

24

20

160/40

X1950XTX

384

650

48+8

*

51.2

16

16

16

8800 Ultra

681

612

128

1500

103.2

32

24

192/48

HD2900XT

700

740

320

*

106

16

16

16/32

7900GTX

278

650

24+8

*

64

24

16

32

TMU: A texture mapping unit is responsible for adding detail to a bitmap that is
part of a 3D image.
Primitive: In 3D animation, this means the most elemental level of detail, the very
basic of building blocks. A point, a line, a polygon, a bitmap, all represent
Primitives.
MADD: Stands for “Multiply Add”. This is a floating-point operation consisting of a
multiplication and an addition instruction fused together, mainly because it is more
efficient to execute for any processing unit than a separate multiply and add
function. It is called a multiply accumulate, and in terms of algebra, is denoted by
(a * b) + c, where “c” is added to the product of a and b.
Transcendental Operations: The term literally means higher-order operations, or
very simply operations requiring complex computation to arrive at a result. For
example, sin(), cosine(), logarithm(), exponent() etc., as opposed to simple
arithmetic operations like power(), multiply(), divide(), and add().
SIMD: The acronym for Single Instruction Multiple Data. This is a technique where a
single instruction is performing the same function simultaneously on multiple
streams of data. It’s used in image and video streaming, where data streams are
usually identical (in this case, pixels).
MRT: The acronym for Multiple Render Targets. This is a technique in programming
implemented in shader hardware to conserve resources. The shader unit renders a
single texture, which is then used to simultaneously paint multiple pixels that share
this texture in a 3D scene.

Making Shade(r) Light(er)

Matters of the Core

* Identical to Core Speed
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Unlikely Twins
Let’s take a look at the salient core specifications
of the G80 and R600, with the R580+, (X1950XTX)
and G71 (7900GTX) thrown in for reference.

Some (rare!) common ground and a very
significant addition over all previous-generation
hardware is the Geometry Shader Unit, which is
present on both cards. Geometry shaders are an
extension of vertex shaders; they can work on
many vertices (in 3D terms, called a mesh), unlike
vertex shaders, which work on a single vertex. The
unified shaders on the R600 and G80 and all their
derivatives can now perform pixel, vertex, or
geometry operations. This translates to efficient
use of shader units—the load is balanced between
pixel, vertex, and geometry, and none of the
shader units are left idle. Traditionally, in the case
of heavy, pixel-processing frames, the vertex
shader units would idle, though in an always-on
state (consuming power). 

The R600 a.k.a. HD2900XT’s 80nm fabrication
process propels it to higher clock speeds within
acceptable thermal limits as opposed to the
8800GTX/Ultra a.k.a. G80’s 90nm process. 

With more than double the shader units and
a higher clock, not to mention the 512-bit
memory interface, the HD2900XT might seem to
bury the 8800GTX, but this isn’t an apple-to-apple
comparison; the two companies’ approach design-
ing and implementing DX10 parts is quite differ-
ent. The 320 vs. 128 shader-unit argument is
equally pointless. And as you will see, there is
much more at play then simple on-paper specs.

Is 320 Equal To 128?
The more shaders the merrier, is a general thumb
rule. This  because  a single stream processor can do
only so much work in a single clock. Pixel opera-
tions in particular are complex and multi-
threaded, often needing more than one SP working
on the same pixel data (called a dependency).

ATI’s 320 Stream Processors:
Is more necessarily better?
ATI has taken pains to explain that most of the
Stream Processors (hereon referred to as SPs) on
the R600 aren’t capable of special function oper-
ations, that is, they are simpler than the SPs on
the G80. Also, if you look at the diagram along-
side, you’ll see that five of these SPs are bunched
together in a cluster, and only one SP in the block
(the large one) can handle either a regular float-
ing point (FP) such as a MADD operation or a
special function operation such as SIN (sin), COS
(cosine), LOG (logarithm), or EXP (exponent). This
SP is called a special function SP by ATI. The other
four SPs can handle only simpler integer opera-
tions such as ADD (add) and MUL (multiply). There
is a sixth unit in the SP cluster, which is a branch
execution unit responsible for tackling flow
control operations like looping, comparisons, and
calling subroutines.

Another limiting factor is that each cluster of
five SPs can handle only a single thread, be it
vertex, pixel, or primitive, in a single cycle. This
means essentially that each bunch of five SPs are
handling only a single FP operation per cycle,
while a single SP in the bunch can do a transcen-
dental operation (read: special operation).

While ATI has gone through pains to ensure
that each cluster of 5 SPs is always busy, it is
extremely difficult to ensure that each SP in a
single cluster is always occupied. Therefore the
R600 essentially consists of 64 SPs with 5 ALUs
(Arithmetic Logic Units) each, though ATI prefers
to refer to the total number of SPs as 64 x 5 = 320.

NVIDIA’s 128 Stream Processors: 
Parallelism unparallel? 
At the very outset, NVIDIA designed the SPs on
the G80 to be independent. No clusters here—just
128 SPs (96 on the 8800GTS) that can perform a
single operation per cycle, unless one operation is
a simple one. This could be either an FP operation
(like a MADD), or a special function (SIN, COS, etc).
A single SP can complete a MADD and one integer
operation like a MUL in a single clock cycle. So we
can have 128 threads running in parallel in a
given clock cycle. However this doesn’t mean 128
discrete operations because vertex and pixel data
contains multiple threads. For example, eight SPs
may be working on a single thread in a single
clock! Keep in mind that the G80 has eight SIMD
blocks each containing a cluster of 16 SPs (see
diagram on page xxx).

Before getting fed to the SPs, each vertex oper-
ation is divided into 16 threads, while pixel and
geometry operations are divided into blocks of 32
(16 threads are executed over two clocks).

Which is better, 320 or 128?
Each SP on the G80 can perform two simultane-
ously-issued scalar operations per cycle, say a
MADD + MUL. This is in contrast to the R600,
where only one SP in a cluster of five can handle
such an operation. So the G80 can handle twice
the number of threads (128 vs. 64) in parallel.

However, due to the fact that each thread is
worked upon by 5x the SPs on the R600, more
work is potentially getting done on each of the
64 threads than on the 128 threads on the G80. In
the best case scenario, the R600 can execute five
parallel operations on each thread. This is, of
course, assuming no dependencies among any of

ATI’s R600: Note the clusters of 5 SPs bunched together

Complex SP SPs
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the five threads. The G80 can only handle a single
operation (albeit on double the number of
threads, that is, 128).

Notice we said “best case” because such a situ-
ation is rare in real code, and this peak perform-
ance (5x) is not sustainable, and possible only
rarely. The performance difference in such a case
is restricted to the difference in the number of
SPs: 320 / 128 = 2.5x. Do remember that these
scenarios are largely code-dependent. In a worst
case—where there are no dependent threads—
we’d see the G80 with a 2x advantage, that is, 128
threads vs. 64. All the above are hypothetical situ-
ations, and we’ll see developers optimising code
for one or the other GPU. 

There’s another variable to consider, in that
the G80’s shaders are clocked at much higher
speeds (see table Matters Of The Core). In fact, at
double the speed of the R600 (1500 MHz vs. 740
MHz), the overall throughput should remain the
same. This is more or less confirmed when both
companies reveal their GPUs’ performance
figures—475 GigaFLOPS on the R600, and 520
GigaFLOPS on the G80. 

In our opinion, in practice, therefore, the G80
should in most cases be significantly faster than
the R600, unless code has been heavily optimised
for the R600, wherein its heavy-duty computing
engine comes into use.

Texturing: How Much Is Enough?
There are two methods in vogue for displaying
spectacular visual effects in games. The older
method employs complex textures specifically,
consisting of complex code written for each
texture, while newer games—in general; there are

exceptions—use shaders. All GPUs now
feature programmable hardware shaders,
for which code can easily be developed.

Look at the table Matters Of The Core and
you’ll see the Texture Mapping Units
(TMUs) on the R600 remain unchanged
from the earlier Radeons at 16 (texture
filter units). The TMU on R600 is brand-
new, with many improvements over pred-
ecessors, namely improved Anisotropic
Filtering, filtering of FP 32-bit textures, in
addition to support for larger texture
samples in compliance with DX 10. 

The TMUs on the R600 are additionally
able to work on both unfiltered and filtered
textures. While filtered textures mostly
represent image-based data like pixel
textures, unfiltered textures represent
vertex data and other blocks of data (which
are not related to images). In true compli-
ance with DX 10, the R600 can display FP
formats from 11:11:10, (R:G:B), up to 128-bit. 

NVIDIA’s G80 is at a direct advantage
with double the number of TMUs (32). Although
NVIDIA has double the number of texture filter-
ing units (64), the number of texture address units
is only 32. The G80 only works on filtered texture
samples, somewhat limiting its capabilities (keep-
ing in mind true unified architecture), but texture
filtering should be faster on the G80 because of
sheer numbers.

Pixel Mascara: Shading Up To Kill
Pixel operations bring up the last few steps in the
rendering pipeline before the output is diverted to
the screen. ATI’s nomenclature for this part of the
core is Render Back Ends, while NVIDIA uses the
handle ROP Units (Raster Operation Units). The ROP
unit is basically a complex processor responsible
for compression and decompression of textures,
Alpha Blending, frame buffer, and Anti-Aliasing,
to name a few functions.

The R600 has the same number of ROPs as its
predecessor, that is, four; one for each SIMD unit.
The maximum throughput these four ROPs main-
tain is 16 pixels per clock (four pixels per ROP).
Although ATI has mentioned improvements in
efficiency over the previous-generation R580+, the
huge number of shader units (320 or 64,
whichever way you look at it) will be seriously
bottlenecked in the ROP portion of the R600’s
hardware pipeline.

The G80 has six ROP units, each capable of
four operations per clock. That’s 24 Raster Opera-
tions per clock on the whole. So while theoreti-
cally the G80 has more processing power,
remember here that the ROPs are clocked at core
speeds, so the R600 should be able to hold its own
here (740 MHz vs. 648 MHz), with maybe a slight
edge going to NVIDIA’s hardware. We don’t expect
the difference to effectively more than 10 per cent
either way.

Memory Bandwidth: Multi-Lane 
Traffic Control!
ATI’s Ring Bus was talked about on the R500 series.
This was basically dual, 256-bit unidirectional
buses used to carry blocks of vertex, pixel, and
data around the various subsystems of the core

NVIDIA G80’s internals:
Note the clusters of
Stream Processors and
Texture Mapping Units
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and eventually to the memory. The R600 adds two
more parallel buses for a total of data path width
of 1024 (256 x 4) bits. This Ring Bus is fully duplex.
ATI has referred to this design as fully distributed,
meaning there is no central hub or controller.
Defying conventional topologies, the controller
itself is distributed over the entire ring.  

The kind of bandwidth the R600 provides may
seem a gross overkill for today’s games—but when
one takes into consideration DX 10 and the addi-
tional memory load, this kind of headroom makes
sense. ATI has not gone GDDR4 this time, although
it is supported by the memory controller.

The G80 uses a controller similar to the earlier
GeForce 7 series. There are now six paths of 64 bits
each (instead of four sections), so in essence, the
8800GTX and Ultra versions sport a 384-bit
memory controller. Incidentally the lower-end
8800GTS features a 320-bit bus, presumably with
one less path than the GTX and Ultra versions,
that is. five instead of six. There are 12 chips of
GDDR3 memory aboard the 8800GTX/Ultra, 64 MB
each, and each gets a discrete data path spanning
32 bits. The 8800GTS has 10 such memory chips.
GDDR4 is supported on the G80’s controller, but
we’re yet to see it implemented.

Different Stream, Same Horizon?
These two are undoubtedly the fastest graphics
hardware on the planet, and easily outperform
all previous-generation cards by at least 200 per
cent in all DX9 titles. DX10 is the proverbial dark
horse here, and just how well both these new
architectures do is yet to be seen. Of course, this

was something both these cards were bred for!
Sure, DX 9 proves overkill for them, but we know
how developers love to bring hardware to its
knees. We fully expect this trend to continue, but
fervently hope this is achieved through better
visual content and not just horribly optimised
code as we’ve seen in the past. In fact, there are
a few DX10 titles on the market that exemplify
this point. There have been flashes of brilliance,
games like Far Cry, F.E.A.R., Oblivion, and Company
Of Heroes being shining examples.

Which of the two architectures is faster is still
debatable. We’re trying hard to get our hands on
both cards to end the suspense once and for all
with a full-fledged test. ATI has already launched
a 1 GB version of its HD2900XT, with which they
hope to combat the 8800 GTX/Ultra. NVIDIA is
expected to launch something to the tune of an
8900GTS/GTX, but details are sketchy, and the
company itself tight-lipped as of now. We can also
expect to see an 8950GX2 (remember the two-GPU,
two-PCB 7950GX2?). 

One thing’s for sure—which architecture does
better will also largely depend on which side of
the fence game developers choose to sit on, opti-
mising their code for one or the other GPU archi-
tecture. NVIDIA with their “The Way it’s meant to
be played,” and ATI with their “Get into the
Game,” are beckoning developers with promises
of title promotion and support. It’s just a matter
of developers going red or green... As for us, our
verdict is reserved until both contestants grace
our PCI-Express slots! 

michael_browne@thinkdigit.com

Which of the two
architectures is
faster is still
debatable
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Abey John

If you dual-boot Linux and Windows, you will
know the pain of not being able to access the
same settings and data for Firefox and Thun-

derbird under both OSes. If all your e-mail in
Thunderbird is configured for the Windows
login, for example, and you need to quickly
access an important e-mail when logged into
Linux, you would, in a conventional configura-
tion, reboot into Windows, open Thunderbird,
read the mail, shut down, and boot back into
Linux. And you’ll do some further gymnastics if
you want to copy some text—say a command line
string—from the e-mail to the application you
are working with under Linux. 

There is, of course, a better way to go about
things. The procedure is fairly straightforward:

1. Move all Firefox and Thunderbird data to a
partition that will be recognised by both
Windows and Linux.

2. Configure Firefox and Thunderbird under
each OS to use the same data set.

With hard disks today being as large as they
are, it is common to partition one physical disk
into many logical drives. Under Windows (2000,
XP, and above), partitions are most often format-
ted using the NTFS filesystem. Many Linux
distros do not support NTFS, but some—like
Ubuntu—do. If your Linux distro supports NTFS,
configuring a separate partition may not be
necessary: you can configure the Linux versions
of Firefox and Thunderbird to use the data from
the Windows partition. This is assuming, of
course, that the e-mail and browser settings /
data that you want to use reside under your
Windows login. If your data and settings reside
on the Linux partition, which is a non-FAT32 or

non-NTFS partition, then you will need to create
a separate FAT32 partition, which can be read by
both OSes.

It is easier to create the partition under
Windows. Right-click on My Computer, select
Manage, and click “Disk Management”. You will
be presented with a graphical view of all the
partitions and hard disks your computer has.
Select an unpartitioned area, or reformat an
existing partition, using the FAT32 filesystem. Be
careful not to accidentally delete or erase any
Linux partitions; these might show up as unpar-
titioned space.

Once you’ve created the partition, the next
step is to move all the data to it. Here, you will
need to choose between the data under your
Windows or Linux login—you cannot merge the
data. The data and settings are stored in what is
known as Profiles. These can be usually found
under: C:\Documents and Settings\user-
name\Application Data\Mozilla\ABC\
Profiles in Windows, where “ABC” would be
either “Firefox” or “Thunderbird”. In Linux, the
usual locations are ~/.mozilla/firefox/ and
~/.mozilla-thunderbird/Profiles.

In the new partition, create a folder called
MozillaCommon, and create two sub-folders
called Firefox and Thunderbird. Then copy
the Firefox and Thunderbird profiles you want to
use to the respective folders under the Mozilla-
Common folder.

The last step is to configure Firefox and Thun-
derbird to use these folders, using the Profile
Manager. In Windows, run firefox -profileman-
ager or thunderbird -profilemanager to open the
respective Profile Manager. 

Make sure both Firefox and Thunderbird are
closed, and also that they aren’t running in the
background. To find out if they are running in
the background, of course, look in the Processes

Dual-booters
rejoice! Now
you don’t have
to worry about
losing your
settings
between
operating
systems

Use Windows Disk Managment to create a FAT32 partition

Share Firefox Between
Windows and Linux

Change your Profile Location using the Profile Manager
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tab of the Task Manger, and kill the processes if
they’re running. 

In Linux, open a terminal window, and at the
command prompt, execute cd firefox or cd thun-
derbird. If the directory names are different,
make the appropriate changes. To start the
Profile Manager, execute ./firefox -profile-
manager or ./thunderbird -profilemanager.
You also need to ensure the programs are not

running in the background. If you get an
“already running…” type of error, use the ps or
kill commands to shut down the applications
running in the background. To learn more about
these commands, look up the man pages
(execute man ps or man kill).

Once you’ve opened the Profile Manager,
click Create Profile… and then Next in the
Create Profile Wizard. In the Completing the
Create Profile Wizard screen, select
Choose Folder, and select the profile on the
new partition.

And that’s that. Now, whenever you browse
using Firefox or open an e-mail in Thunderbird,
all data and browsing history will be seamlessly
available irrespective of OS.

readersletters@jasubhai.com

Make sure both
Firefox and
Thunderbird are
closed, and also
that they aren’t
running in the
background

Check if Firefox or Thunderbird is running in the back-
ground

Point Firefox or Thunderbird to the new profile location
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Rossi Fernandes

It’s extremely rare to have Windows prein-
stalled with all the software you need for, say,
multimedia authoring. Then again, for a half-

hour’s work, you don’t want to scour the Net
hunting for software, so we turn our attention to
Linux. The large number of open source tools
available for it makes Linux a very good base to
build a purpose-built operating system on. There
are a lot if you look for them.

We’ve decided to take a look at distributions
that have been created specifically for certain
purposes and filling gaps left by most of the
Desktop distros. They’ve been creating waves on
the Internet for their functionality, though they
aren’t recommended for regular Desktop use. We
have divided them into categories that should
cover the majority of your computing needs out-
side of basic Desktop computing. 

Most of these distributions are Live CDs, so
you don’t need to bother with installation—just
boot off the CD or DVD to try them out. In the
odd case that a distribution needs to be installed,
you can first test it in a virtualised environment
like VMWare or the free VirtualBox. Refer to the

While they’re not trying to replace your current Desktop, these Linux
distributions come in really handy when you need a bunch of
purpose-built software in one place

30 Minute Expert to VirtualBox in our July issue for
more. Once you’re comfortable with the instal-
lation process and have decided on a distribution,
go ahead and install it.

Illustration Chaitanya Surpur
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Let us put it this way—Damn Small Linux is
pretty damn small as its name suggests, and it
packs in loads of features despite its
constraints. It is the geek’s Swiss Knife, and can
be carried about on portable USB drives. Its
compact size is what makes it stand out,
and also what cripples it by
not letting it be a complete Desktop. The
lack of a video player or even a proper word
processor is proof of this. Still, you can do
almost everything you would on a
Desktop with DSL. It’s an adequately func-
tional Desktop replacement for those
who travel a lot. 

SLAX Standard 
Edition 5.1.8.1
Site: www.slax.org
Size: 192 MB

At 192 MB, SLAX doesn’t come close to
Damn Small Linux in terms of portabil-
ity, but with 2 GB USB Drives available

for under Rs 1,000, portable disk space isn’t an
issue any longer. Also, at 192 MB, it has many
more software packages than DSL does. 

The Live CD boots into the console, after
which you are required to enter the root user-
name and password. You then need to type
startx to load the X Window System—this
could all have been automated, but that tiny
bit of disappointment ends here. SLAX looks a
lot better than DSL—much more like a proper
Desktop operating system. 

The first thing you notice when you go
through the menus is they seem to have every-
thing made for KDE in it. That means no
Firefox, no Abiword, no xmms, nothing. Those
who love KDE shouldn’t have any problem, 
but GNOME fans might find it a little hard 
to digest.

That aside, the distribution has compo-
nents out of KOffice for word processing,
spreadsheets and pres-
entation. Konqueror
automatically becomes
your browser. Unlike
with DSL, you can play
video—they’ve included
a media player called
Kplayer (it comes pre-
installed).

SLAX doesn’t allow
you to install programs,
but there are ways to
configure the ISO to add
modules. The command-
line RPM (Red Hat
Package Manager,
though the term is
rarely used) module is

Damn Small Linux 3.4 
Site: www.damnsmalllinux.org
Size: 49 MB

Damn Small Linux (DSL) is what first
comes to mind when you think of
portable, compact Linux distributions.

The Live CD loads up without any issues into a
Fluxbox-powered interface. You can switch to
the jwm window manager if you don’t like
Fluxbox, but it isn’t as nice looking. The inter-
face is minimal and clean. A transparent panel
on the right of the Desktop shows you statistics
for system resources, network speeds, and so
on. This adds to the geek factor that most
people generally associate with Linux. 

Functionality-wise, there’s a lot stuffed into
DSL, considering it’s just short of 50 MB.
There’s almost everything from browsers like
Firefox to PDF readers to the remote access
programs Rdesktop and VNCViewer. There’s
even a command-line-based CD/DVD burning
software, cdw. Instant messengers are limited—
there are text-based AIM, IRC, and Jabber
clients, but nothing for the more commonly
used MSN or Yahoo!. A utility called DSL
Control Panel allows you to change settings and
turn services on and off quickly using buttons
on the interface. 

As for entertainment, audio playback
shouldn’t be a problem with xmms around. A
video player could have been included, though,
without sacrificing much on space. Moving on
to games, you’ll only find card games in DSL—
other than a Tetris game here and there.
Fortunately, extensions can be added to Damn
Small Linux through the Internet using a
program called MyDSL Extension Browser. You
can also install extensions downloaded to the
local drive using the same application.

Portable Linux Distributions are compact operating systems meant for users who would like to
carry their operating systems along to work or wherever they need to go. They need to be as
feature-packed as possible without going overboard on the resources and storage space front. 

Linux On A Stick

A very compact distribution with the bare necessities

A complete Desktop in a compact package
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installed, so you can also add programs using
RPM packages.

Games don’t seem to figure anywhere in
the list of priorities for the creators of
SLAX—the same old set of card games on most
distributions can be found on SLAX as well. Since
it’s based on KDE, customising and setting up the

OS is really simple using the KDE Control Center.
When you think of DSL and SLAX as portable

operating systems, SLAX doesn’t feel like one—it
feels more like a full-fledged OS. Anyone wanting
the smallest OS with the bare necessities should
blindly opt for Damn Small Linux, but if you
want anything more, SLAX is your best bet.

dyne:bolic 2.4.2 
Site: www.dynebolic.org 
Size: 654MB

Multimedia authoring distributions
often conjure up the idea of a software
suite that extends into the gigabytes,

but dyne:bolic fits on a single CD. The distribu-
tion starts up to a pretty-looking interface—

clean with colourful icons. You
can customise it by changing to
one of the many themes to suit
your taste. The interface comes
configured with six virtual
Desktops—useful when you have plenty going
on: drawing, 3D, animations, compositing,
communicating with other members in your
team, etc. Programs are well-categorised accord-

encoded in H.264 or QuickTime. It even played
WMV files and Flash video clips—all this
through the Live CD, without having to install
any third-party codecs or players. 

You don’t always have to use the Live CD—
you also have the option to install GeeXboX on
a hard drive, which speeds up its already quick
startup time. This distribution is perfect for
those who have fairly old machines with some
life still in them. Plug in a card with a TV-out
function, and you have yourself a media play-
back centre for free! Check out our October
2006 issue to find out how.

This is a tiny Linux-based, dedicated media centre

Content designing and digital media creation has become a common hobby the
world over, not to mention a growing business area. Taking advantage of this trend
are distributions aimed at all sorts of media creation and editing—perfect if you
have multimedia leanings but don’t know where to start.

Media Authoring

GeeXboX 1.1 
Site: www.geexbox.org 
Size: 8.8 MB

The distribution we had to try was
GeeXboX. The size of the distribution is
shocking—with a download size of close

to 9 MB, we were wondering if this was even a
real distribution! The interface is colourful
with a simple menu, and fonts like the ones you
would find in cartoonish games like Worms 3D. 

GeeXboX can play movies and music, and
display images and slideshows if you wish.
Once completely loaded into memory, the Live
CD is ejected, so you can put in your CDs or
DVDs. There is no mouse control whatsoever, so
you have to depend on the keyboard’s direction
keys or a remote control.

We had some issues with slideshows switch-
ing to next and previous image—we couldn’t
navigate to them, and had to jump back and
forth to the index for this. But movies and
music playback worked perfectly—GeeXboX
plays back everything from AVIs to MP4s

These are distributions meant to take the place of your entertain-
ment centre—playing music and movies and providing some image
viewing features, to be specific. The distributions will allow you sit
back on your couch and use a remote control or a wireless keyboard
to control all your entertainment content.

The Media Centre
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ing to the tasks you want to perform—whether
it’s viewing video or creating music. There is
also software for streaming media over a
network or the Internet to create your own live
performances. It features tools for print media,
such as Scribus for Desktop publishing, and
vector imaging tools like InkScape. The good
thing with a distribution like this is that you
get to choose from a variety of software for
each task depending on which one you like. 

The distribution also has the now-stan-
dard set of software like Firefox, Thunderbird,
XChat, and a few P2P applications. There’s
even VoIP software like Kiax and Iaxcomm,
and VNC for remote access.

All this functionality stuffed onto a 655
MB Live CD distribution is just amazing, and
very good for anyone interested in computer
graphics. When you’re done with your work,
you can save your data on either a USB drive
or a hard drive using a tool called Nest. 

We’re rather pleased with Dyne:bolic over-
all. It seems like they’ve thought of almost
everything by putting useful tools not for just
for the multimedia authoring, but also for
general Desktop use. Like we said earlier,
Dyne:bolic is a great way to go for anyone
wanting to get their hands dirty with CG-
related tools.

Ubuntu Studio 7.0.4
Site: www.ubuntustudio.org 
Size: 867 MB

Ubuntu Studio is another highly-spoken-
of Linux distribution. This isn’t a Live
CD like Dyne:bolic, so you’re going to

install it on your drive or use VirtualBox. The
installation is rather sad with no GUI—much
like distributions from the ’90s—though it
still is easy and straightforward; it’s just poor
presentation.

The interface doesn’t look anything
special, and is very similar to that of another

Now here’s a well-customised distribution with media
creation in mind!

multimedia authoring distribution called
ArtistX (which you’ll find on this month’s
DVD). There are no virtual Desktops in sight,
and unlike Dyne:bolic, applications aren’t
sorted and categorised into menus; this can be
very confusing. The only distinctions made
are between still graphics editing and
audio/video tools. A lot of emphasis seems to
have gone into the audio recording and edit-
ing components.

The software in Ubuntu Studio is more or
less similar to that in Dyne:bolic. There are
quite a few interesting applications, like
terminatorX, which acts like a virtual
turntable and allows you to record tracks as
well. Another interesting application is Synfig
Studio, which is animation software for vector
images; it can be used to create 2D cartoon
animations.

Ubuntu Studio does not give any emphasis
to streaming media over the network—every-
thing is for the local machine. Quite a few
other desktop applications are missing as
well—of the OpenOffice suite, you’ll only find
the word processor, and Firefox and GAIM
bring up the rear. There aren’t any mail
clients or games either, but you can install all
the missing software using the Add/Remove
Applications tool.

At 867 MB, Ubuntu Studio forces you to use
a DVD, but the size disappoints—they could

have put many more applications into the
distribution, or made it a CD-size distribution
like dyne:bolic.

We expect Linux distributions to select
only the best software, instead of simply pack-
ing all the available applications and calling
it a distribution—which is what Ubuntu
Studio tries to do. Any Ubuntu fan inclined
towards digital media creation and computer
graphics would be interested in trying
Ubuntu Studio. It must be said this is the first
release and it’s doing pretty well already—
things can only get better, and it won’t be
long before it matches the might of other
distributions in its class.

A content-creation distro based on the well-known Ubuntu

Dyne:bolic is a
great way to go
for anyone want-
ing to get their
hands dirty with
CG-related tools
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eBox 0.9.1
Site: www.ebox-platform.com
Size: 205 MB

eBox is a really unique distribution with a
lot of potential, not just for home users,
but even small offices, and can scale to

much larger networks. It acts like a router with
a dozen additional features like proxy, firewall,
routing, VPN, and many others thrown in—
things a router normally can’t do. It’s a full-
fledged, remotely controllable network server.
eBox is a 200 MB distribution that boots off the
CD without any trouble. 

There is no user interface—no taskbars, no
menus, nothing! It directly loads an elegant
page on Firefox which is, in fact, the Web inter-
face from where you control all the features of
this operating system. This means you can
remotely access the server over the network too.

There is a lot this distribution can do: you
can  add multiple network interfaces and gate-
ways. You can then set it to load-balance
requests to the gateways. Traffic shaping allows
you set bandwidth limitations. The HTTP proxy
can be configured to block files of certain exten-
sions, MIME types, or entire sites altogether.
Easy switching of strictness for the proxy can be
done by changing a single setting called
Content Filter Threshold.

The firewall in eBox can be set up to block
ports and also for port forwarding. eBox can
also route data from one network to another.

The VPN capabilities here are very interest-
ing indeed. OpenVPN is a free, open source
application that comes with eBox; it allows
multiple users from all over the network or the
Internet to connect and form a virtual network.
There is no limit to the number of connections.

There is an option to back up settings to a
drive, but we found no option to install the OS.
The eBox site has a separate installer image for
download for that purpose.

You should be able to run eBox on pretty
much any machine. The highlight here is that
it’s easy for non-technical people to use, thanks
to the Web interface.

AsteriskNOW Beta 6
Site: www.asterisknow.org
Size: 447 MB

AsteriskNOW is a Linux distribution that
turns your computer into a mini PBX
(Private Branch Exchange)—a mini phone

exchange—for both telephone and VoIP calls. It is
not a Live CD, so you’ll need to install it to disk.
Upon boot-up, you’ll see just a text-based inter-
face, and there’s nothing that can be done here.

To get to the most functional part of the OS,
you need to connect to the AsteriskNOW
machine through a browser from anywhere on
the network. The setup Wizard helps you set up
the system the first time you log in, and the
Web interface is well-laid-out.

You can set up multiple phone providers
and then assign them to different users—not
only can you use your regular analogue phone
line, you can add online VoIP providers as well. 

Connections can be set up in a manner such
that numbers starting with certain codes can
be routed through different providers, and calls
coming from a particular provider can be auto-
matically sent to particular extensions. It also
supports conferencing in addition to the stan-
dard three-way phone calls. In addition,
there are voice menus to interact with callers,
and you can assign functions to a number
of keystrokes.

Your all-in-one network server!

This can be your personal telephone exchange

Communications
And Networking
What do you do with an old PC that you can’t sell? Linux is a perfect
operating system for network servers. Here are some distributions
that take your scrap-worthy machine and turn it into a network
server or a telephony box.
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It’s pretty hard to put “Linux” and “education” in a single sentence. This category is for school-
going children who can use Linux in their daily academic life and also as a regular operating
system in their free time.

Education

AsteriskNOW gives you reports of system
information such as CPU loads, network inter-
face information, system logs, and even a text
console for executing direct commands to
Asterisk. It’s claimed that a machine with a
3 GHz processor and 1 GB of RAM will be able
to sustain up to 15 simultaneous connections.
You can monitor all active connections using
the Web interface, and back up and restore all
your settings and data as needed.

You obviously will need some hardware to
act as an interface for the telephone lines for

Asterisk to function. Digium is a company that
uses and works closely with Asterisk as soft-
ware to run their hardware. Digium hardware
can be found through a couple of distributors
in India, too. Visit http://asterisk.pbx.in for more.
The software works fine with other manufac-
turers as well, though. They make PCI cards
that allow many phone lines to be connected to
a computer.

It is clear that AsteriskNOW isn’t meant for
home users, but for a SoHo setup, it’s a very
cheap solution.

Edubuntu 7.0.4
Site: www.edubuntu.org 
Size: 695 MB

Edubuntu, like Ubuntu Studio, is based on
Ubuntu and is targeted at the young ones.
Unlike Ubuntu Studio, this distribution

comea as a Live CD, and has a GUI for its installer
as well.

Edubuntu isn’t just for schoolkids—there are
quite a few applications meant for very young
children as well. Tux Paint, for example, is a
drawing application for children, much like MS
Paint. The interface is stacked with large, colour-
ful icons. Another educational game that should
be fun for kids is called GCompris, a collection of
many simple math games and puzzles. There are
also some simple games and quizzes that ask the
user to find colours, as well as some reading
games. They’re all meant to teach kids real stuff
while keeping it fun.

For the slightly grown-up, there’s an applica-
tion called KTurtle, a KDE clone of the old
programming language called Logo, where you
use text commands to draw. There are some
maths programs as well.

KEduca by itself is a program that allows
students to take tests, and marks are given
accordingly. KEducaBuilder is a program that

accompanies it, and lets you design tests
that can be run on KEduca—really useful for
teachers and parents alike. Kalzium is a
program that shows the periodic table of
elements and a lot more information like
chemical data, history details, and more. It
even shows photos for quite a few of the
elements, which makes it more interactive
and interesting. 

Edubuntu doesn’t throw out the stan-
dard software package, though—you get
the OpenOffice suite, some media players,
instant messengers, Firefox, and Evolution for
your mail. You can also add and remove
programs with simplicity similar to that of
Ubuntu. 

This operating system meant
for kids could have been
designed to be a lot more colour-
ful and interactive to make it
even more appealing—something
like the software in it, like
GCompris. They also could have
given the user a choice of choos-
ing between a couple of different
layouts and schemes, each suited
for a different age group. All in
all, it’s an operating system with
lots of fun things to do, with bits
of educational value added.

A few enterprising Indian groups have decided to make Linux easily accessible to non-
English speaking public by creating distributions for them. 

The Indian Flavour

IndLinux—Rangoli 1.0b
Site: http://www.indlinux.org/
Size: 688MB

IndLinux is one of the more prominent Linux
distributions we came across, and we had to
look at it. It’s a Live CD based on Morphix,

which in turn is a derivative of Debian.

When you first boot from the CD, you
can choose from seven languages. You can
also choose to use KDE or GNOME if you
select Hindi. The other languages boot up into
the GNOME desktop environment.

Not all menus and programs are translated
into the regional languages, though, and
this differs from language to language.
You can switch between languages for

Learning and fun together on a Linux 
distribution. But make sure they learn
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typing using a menu in the KDE taskbar, though
you can’t do so in GNOME.

This is no scaled-down operating system—a
large number of programs are included. There’s

live.linuX-
gamers.net 0.9.2

Site: http://live.linux-
gamers.net/

Size: 2.36 GB

The Linux Live Game Project is a compila-
tion of games for Linux, and requires no
previous knowledge on how to set up Linux

and all its applications. It’s a Live DVD that’s
based on Arch Linux, so there is no need to
create space and partition drives, either.

Depending on your hardware, you’d be well
warned that some of your drivers may not be
open source. We ran our tests on an NVIDIA-
based motherboard. This can be a little irritating
to see every time you boot up: you need to agree
to continue, and once you do, the drivers are
loaded and the GUI boots up. There’s not much
to see here other than a thick bar with a list of

games there.
Now the games on this

distribution aren’t your typical
low-end-card games you find on
your Windows and Linux
Desktops. These are full-fledged
3D games, including FPSes like
Warsow, Tremulous, and World of
Padman.  Sauerbraten is another
pretty good-looking game that
makes use of some fancy-look-
ing shaders.

It’s not all FPS mayhem
either—games like Foobilliards

A Linux distribution with support for Indian languages—marking a step ahead

everything from browsers and text editors to
games and even videoconferencing tools. A
couple of very important programs are missing,
though—there’s no Firefox, but you will find the
Mozilla Web browser. The KDE documentation,
for those who need it, has topic names in Hindi,
but the text is all in English. Translating it all
would be a mammoth task, we’d imagine. 

People who are used to English versions of
Linux as their Desktops might find using the
regional languages a little confusing, but
newcomers to computers and to Linux might
find this a lot easier.

IndLinux sets out in the right direction—
it’s really good for people who want to use
computers but don’t have good command over
the English language. It doesn’t have support
for all the regional languages in our country,
but the IndLinux site links to teams develop-
ing and translating programs to other
languages. Perhaps future releases will imple-
ment more languages. 

A lot of people hesitate from using Linux because of the lack of games,
not to mention the trouble of hunting down the few games that do
exist, and then set them up. A lot of distributions, however, do all the
dirty work for you, so all you have to do is play!

Gaming

(a pool game) and Blobby 2 (a 2D ball game) will
appeal to casual gamers. Real-time Strategy (RTS)
and Role-playing Game (RPG) fans can always try
out Warzone 2100 and The Battle for Wesnoth. For
those with a need for speed there’s TORCS (The
Open Racing Car Simulator)—a fairly decent-look-
ing car racing game, and gl-117—a rather bad-look-
ing flight simulator.

The performance of the games on our test
machine—an AMD64 3800+ with 1 GB of RAM
and the onboard NVIDIA 6150 graphics—was
more or less satisfactory. What is irritating is
the amount of time games take to load off the
DVD. You can save your settings on a USB drive
if you wish. 

Unfortunately, other than playing games,
there’s nothing much you can do with this distri-
bution. If that’s all you want, then Linux Live
Game Project has a decent collection of games
where you can spend a lot of free time.

rossi_fernandes@thinkdigit.com

A distribution for less-than-casual gamers

3D games form most of the distribution



Day 1  
The Tarantula is much larger than conventionalkeyboards, and has numerous nifty shortcuts includingmultimedia buttons, though these are a touch too hard.The keys themselves have a nice feel to them—shorttravel and plenty of feedback, though I personally preferthe softer, less immediate travel of some Logitechkeyboards. The DeathAdder has soft keys. They’re largethough, which is good, but too soft for my liking(especially while gaming). Still, they’re very comfortablefor regular use.

Both the Tarantula and the DeathAdder have abacklit, glowing Razer logo that pulsates—very fetching.The palm rest on the Tarantula is decent. It’s treated witha sweat-resistant matte finish that feels comfortable. TheDeathAdder has a similar finish, but feels (and looks!) somuch better thanks to a velvety coating.

Day 3 
My impressions of the mouse after a couple of hours ofQuake 3 on a Razer Mantis Speed mat: precise, quick,but no more so than the 1600 dpi Logitech MX518.What is really significant is the frequency, whichdetermines the accuracy while tracking—and theDeathAdder feels every bit as good as the excellentMX518—even better. The DeathAdder is good for large-handed folks. The comfortable and well-sculpted bodyfeels excellent—especially over prolonged use.

Day 6
The Tarantula comes with a beautifully functional keyremover—ultra-utilitarian. The keyboard itself will hogtwo USB ports, but in turn provides two additionalUSB ports (1.1, not 2.0). Headphone and microphonecables are provided, meaning your headset can beplugged into the keyboard!

Day 10
Gamers hark: ten backlit macro keys!They are on either side of thekeyboard, and are

programmable, able to store a multiple-keystrokecombination for each profile. Imagine an action gamerequiring six different keystrokes—each at the propertime to complete a combo attack on an opponent—beingbound as a single key-press to one of these macro keys! 
Day 13
After wading through the Tarantula’s software menu,I’m a bit boggled. The Logitech G11/G15 duo has a moreintuitive menu structure on the whole. I feel the regularkeys on the Tarantula are also smaller than what I amused to, and while typing out e-mails, I end up withquite a few typos.

Day 19
I miss sideways scroll with the DeathAdder—a boonfor spreadsheets, although the vertical scroll onthe wheel is deadly accurate. Incidentally, theDeathAdder is priced at Rs 4,249: with the MX518at Rs 1,600, and the G5 at Rs 3,200, this one isa little overpriced.

Day 24
Time to bid goodbye to this deadly duo! By now I’vegotten used to the Tarantula’s smaller keys—a greatkeyboard for typing, too! I’ll even missthe ultra-comfortable DeathAdder.Bah… my colleagues won’t bequaking in their boots every timeI pick up a railgun any more.Still, for anyone but brand

freaks and die-hard Razer fans,I’d recommend passing up
getting stung and bitten,
especially at this price point.

michael_browne@thinkdigit.com

Michael Browne
Any gamer worth his frag will relate to Razer, one of the most hallowed names in that fraternity. True to their naming conven-

tions—”Copperhead,” “Diamondback,” and “Krait”—they’ve brought out the DeathAdder, an 1800 dpi optical mouse based on an

infrared sensor. Complementing the mouse is the Tarantula, a keyboard that when judiciously used should result in many deaths.

While gaming, of course…

The Serpent And The Arachnid!
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Droolmaal The good stuff.
Stuff to lust after.
Stuff for the well-moneyed.

eople love their music a lot, and some love it even
more. The AKG K701 is perfect for the latter. These
cans, meant to be used for reference, are some of the

most stylish ones we’ve seen. The frequency range goes from
10 Hz all the way beyond 39 kHz! Who’d even think you’d
need to go beyond 20 kHz? The leather headband has been
designed with bumps, so wearing comfort has been taken

care of. The jacks and contacts
are gold-coated, so quality

is not compromised.
And the

impedance
rating is 62
ohms! Don’t
say goodbye
to your el

cheapo Rs
2,000 phones

quite yet—unless
you’re willing

enough to part
with the $400
(Rs 16,500),

that is.

P

Wacom Cintiq 21UX

Digital Passion l Droolmaal

ow, most of us believe gaming isn’t
something you do on laptops.
They’re meant for general

office work—Word, Excel, e-mail, etc.
Falcon Northwest is out to prove us
wrong. The DRX has two 7950GTX cards
in SLI, and the processor driving them is
a Core 2 Duo X6800 @ 2.93 GHz.
Shocked yet? The rest of the
specs go thus: the 17-inch
screen does a resolution of
1920 x 1200, something you
normally find on 24-inch monitors.

Three hard drives are provided—a 100 GB
7200 rpm for performance, and two 160 GB

5400 rpm ones for mass storage. A TV-Tuner and four speakers
are built in as well. Surely all this must be really expensive—

well over the $3,000 mark? Actually, it’s close to more than
twice that: $7,687 (Rs 3,15,000).

Falcon Northwest DRX

N

HTC Advantage

The HTC Advantage X7500 might look like some sort of
tiny laptop, but it’s more than that. You get a practical,
usable keyboard and a 5-inch screen. It is powered by a

624 MHz processor with 128 MB of RAM and 8 GB of space—
quite a bit for a mobile device such as this. No fear of it getting
lost either—the HTC Advantage comes with an inbuilt GPS unit
that uses TomTom Navigator 6. Bluetooth, Wi-Fi, and 3G are all
implemented. There are two cameras—a 3MP still camera, and
a standard VGA camera for video. The latest version, the X7501,
comes with Windows Mobile 6 but without the second (video)
camera. The price for the HTC Advantage X7501 is rumoured to
be around $900 (~Rs 37,000).

T
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Alienware Hangar 18
Alienware never
disappoints, as a
general rule. The

Hangar 18 departs from the
super-gaming-machine scene.
It is, in short, a home theatre
system running some pretty
mighty hardware. It runs on
an AMD Athlon 64 X2
processor and can have up to
4 GB of RAM. Vista is the
primary operating system.
There are two digital TV-Tuners and two analogue ones, using which you can record videos of up to 1080p resolutions. The 2
TB of storage space should arguably be more than enough for your HD video, photos, and music, and the 1000 W amplifier
will inarguably satisfy those with a taste for really loud music. Starting price: $1,999 (Rs 81,000).

A

Digital Passion l Droolmaal

pieces of lighter greys gives it a rather cool look. All the
speakers are magnetically shielded. Klipsch recommends
adding their Sub-12 to the setup to add punch to the
sound; this is a 12-inch, 300 RMS woofer. It’s $950 (Rs
39,000) for the speakers, but if you want the Synergy Sub-
12 woofer, add a further $499 (Rs 20,500) to the bill.

Klipsch Quintet SL
Klipsch makes some really expensive, high-
performance, stylish audio products. The Quintet
SL is a flat speaker set based on one of their

older best-selling speaker sets. You get two vertical
speakers and a horizontal speaker panel. The two
smaller rear channel speakers along with the front
panels combine to give you the perfect surround sound
experience. The dark grey colour scheme with bits and

K
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Nimish Chandiramani

I
t’s no coincidence that this article shares
its title with one of TV’s most popular
(and you must admit, inspiring) reality
shows. Eventually, if it hasn’t already,
the thought of your own movie will pop

into your head... “What will it be about? Who
will I cast? How will I get it done?”

We can’t help you with the first two ques-
tions—you’re going to have to figure out that
for yourself—but we can give you a friendly nod
in the right direction for the third.

But First...
What, you might well ask, is an open source
movie? The concept has two interpretations:
the first is that an open source movie, like open
source software, is available not only in its
final, finished form, but also as a collection of
raw footage and soundtracks, so anyone can
make their own version of the movie using the
same material. The second interpretation
doesn’t need the movie’s source footage to be
available, but slaps on the requirement that
the movie be made only with open source soft-
ware. It should then be released under an
appropriate Creative Commons License (the
Attribution-NoDerivatives-NonCommercial
license seems to be the popular one). Of course,
you can still make the source files for your
movie available to the general public, and they
might thank you for it. 

How you release your movie is your deci-
sion; we’re here to tell you about the best open

Lead Feature

Digital Tools l Jumpstart
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tion. The next step would be to start building
your screenplay, and then the storyboard.
While you’re writing your screenplay, Celtx
makes things easier for you by letting you add
annotations and notes, and by giving you an
autocomplete menu when you start typing
character names. 

Once you’ve made a plan, you just need to
execute it.

Aside: The Lazy (?) Way
If you don’t want to shoot your own footage—
whether it’s laziness or a lack of equipment—
there are sources on the Internet where you
can get yourself a whole cornucopia of raw
footage, just waiting to be edited and mixed
into a new film. One such site is MOD Films
(www.modfilms.com), where you can get your
hands on over nine hours of raw footage, loads
of concept art and more. They’ve even made
their own re-mixable movie, called Sanctuary,
which you can modify to your own tastes. But
we digress...

Capture And Cut Up
If your camera uses a proprietary driver to con-
nect to your PC, chances are you have no choice
but to use its own bundled software to dump
video to your drive (Sony camcorders are quite
notorious in this respect). You could use Virtu-
alDub—a greatly undermined tool—to import

source software to help you get there. You’ll
find nearly all of them in ArtistX, which you
can boot into using this month’s DVD.

Before It All Begins
You can’t just inflict your camera-toting self on
the world and hope to create the next big thing
in film-making. Apart from a sense of reality,
you need a plan. Convenient though it might
be, great movies don’t just happen—they start
with scripts, storyboards and characters. For
that, you need Celtx.

Celtx (you’ll find it on our July CD) calls
itself a “media pre-production” tool for
prospective movie makers. It lets you take your
movie from a fleeting idea to a well-planned
project. It lets you outline your story, create a
screenplay and storyboard for your movie and
add characters’ profiles. If you’re a more
serious film-maker, you can use Celtx to set

filming schedules, manage actors, wardrobe
and props.

Celtx starts new projects with a screenplay
and a storyboard, and you can right-click in the
left pane to add items like a story outline to
descriptions of special effects you intend to
employ. A logical way to start would be to add
a story outline before anything else. Next, add
your characters: give them family back-
grounds, eccentricities, even a physical descrip-

You don’t really need to go out and shoot real people and real
things to make a movie—if you’ve got a webcam or a

respectable PC and lots of determination, you can create your own
stop-motion or 3D movie, à la Elephants Dream, which is easily the
most famous open source movie in recent times. What you need:

Blender
Its interface takes getting used to, and creating a good 3D
model takes plenty of skill—not to mention animating it—but
Blender lets you create some really amazing animations.
Setting up animations for human and animal models is made
easy with its Skeleton Creation Mode and walk cycles, and you
can use Python to write more complex animation scripts. 

Stopmotion
The good thing about stop-motion animation is that you only
need a webcam at home to do it, but that good is quickly
offset by the amount of work that’ll go into your actually
creating a stop-motion feature. 

Stopmotion is a simple tool. There’s not much
technology can do when your biggest effort involves 
moving the arms and legs of a doll while ensuring that 
your set or camera doesn’t change position by even an inch.
But it does offer you a few helpful features like Onion
Skinning, which lets you overlay previous shots over your
current camera view, so you can create a tighter, more
fluid-looking animation.

Off-track

If you’re serious about making your movie, you should start with Celtx

Kino is the need of the hour to turn lots of raw footage
into a decent movie

Celtx calls itself a
“media pre-
production” tool
for prospective
movie makers. It
lets you take
your movie from
a fleeting idea to
a well-planned
project
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video from your camera to your PC, if the camera supports the
Video for Windows capture driver—find out in its documenta-
tion. VirtualDub is a great tool to process and encode video
from your camera, but it comes up short if you need to edit
your movie in true film-editor fashion.

To cut up and edit movies, you need to use Kino, one of the
most popular non-linear editing (NLE) tools for Linux. It lets
you break up your movie into scenes, stitch movies together,
add special effects and a lot more. It can even capture video
from a FireWire-based camera. 

Like all video editing tools, it takes a bit of tinkering to
get used to Kino, but once that’s done, working with it is
quite pleasant.

A Little Make-up
Once you’ve finished editing your movie, you might want to
consider a bit of touching up: Kino won’t help you much if you
have to make changes to single frames, or if you want to try
your hand at rotoscoping, a technique where you draw on each
individual frame to convey the impression that you’ve ani-
mated something very well. Think of it as a primitive version
of motion capture. If you want to edit individual frames, you
need to turn to CinePaint.

CinePaint’s former name—Film GIMP—should serve as a hint
to what it does. The program supports all major video formats,
including high-definition formats like Kodak’s Cineon and ILM
and NVIDIA’s OpenEXR. The interface looks just like that of The
GIMP, so if you’ve used The GIMP before, you shouldn’t have
any problems. Use CinePaint to make corrections in frames that
didn’t come out too good, add titles to your movies if you’re not
satisfied with Kino’s capabilities in that department, or add
your own weird animations—but remember that working on
individual frames can be as exhausting as it is rewarding.

Tell The World!
When your movie is finally done, you’ll need a good video
encoder to be able to inflict it upon the masses. If you want to
make your own holiday DVD, complete with menus, use DVD-
Styler. For more advanced encoding features, there’s
AVIDemux, which also doubles up as a DVD authoring tool
when extended with software like dvdauthor.

If YouTube is your chosen route to fame, then you don’t
have to worry much—as long as you encode your movie to be
less than 100 MB and in a file format like AVI or MPEG, it’ll get
converted by YouTube once you upload it.

The last step is to e-mail your friends and tell them to
e-mail their friends about your new creation! (The open source
tools for that would be Firefox or Thunderbird, but you already
know that). 

nimish_chandiramani@thinkdigit.com

CinePaint—it’s The GIMP for movies!
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A Cell, A Bell,
And A Whistle

Now these aren’t
your run-of-the-
mill cell phones…
they’re miniature
computers aimed
at making your
existence just a
little more
upwardly mobile!

Michael Browne

F
rom being play-toys of the rich to
becoming tools of some necessity, to
trickling down to (most of) the urban
masses, the mobile phone has taken
almost too short a time to get to where

it is in this country! There was a time around
the mid-’90s when some people actually used to
rent cell phones—the bricks of that era—to flash
around at momentous occasions and social

gatherings. Costing as much as they weighed,
these devices were dysfunctional clods com-
pared to what we have today.  

The technological improvements in cell
phones have been colossal -comparable in scale
to perhaps the difference between a 133 MHz
Pentium 1 processor of yesteryear and a Core 2
Duo of today. Add to this the fact that underly-
ing allied technologies have become phenome-
nally cheaper and you have the explanation
behind the explosive growth of the cellular
industry, not only locally but worldwide.

Photograph Vinay Somaiya
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To the layman, what this translates to, of
course, is better phones at lower prices. In fact,
with respect to some of the devices we’ve tested
this month, calling them cell phones is tanta-
mount to an insult. They represent the new era
of smart and truly connected devices.

Although we’d initially meant to test
mostly PDAs and smartphones, we haven’t for-
gotten our promise in May of covering a few of
the mainstream models as well. You’ll find a
smattering of them in our entry-level catego-
ry. We did a lot of market research and dug
out some of the hottest handsets around for
this comprehensive shootout. We’ve also split
up the test into two very distinct categories—
business-oriented devices (including PDA
phones) and multimedia-oriented devices, to
enable quick buying decisions!

BUSINESS PHONES
Fondly called smart smartphones, PDA phones are
the Einsteins of the handset world. In general, a
PDA phone will have better hardware under its
hood, and will be capable of running a greater
variety of applications than will a regular smart-

phone. A faster processor and more memory
equate to greater productivity, and a PDA phone
will also offer additional connectivity and pro-
ductivity options. 

Earlier the cherished darlings of the rich,
PDA phones have now become sufficiently inex-
pensive to be sought after by lesser mortals like
executives and managers, who can utilise their
many functions in a productive way. In fact, a
PDA phone is also very much within reach of
your average urban college-going spoilt brat
(with a little money management).

Most PDA phones offer users the ability to
work seamlessly with documents and spread-
sheets, and will provide the flexibility of a full
QWERTY keypad while providing wireless con-
nectivity and e-mail client support, should you
need to mail your labours to your boss in office
while on a tour. A PDA phone is also a fraction of
the size and weight of a laptop.
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We called for 18 PDA phones, representing
between them perhaps the best replacements for
a laptop that your money can buy. 

Gorgeous Value
(Up To Rs 17,000)

Features
A few years ago, expressing the desire to buy a
smartphone (let alone a PDA) at this price point
would probably mean a trip to a psychiatrist.
These phones aren’t strictly PDAs, and do sacri-
fice on some functionality in order to keep
prices within bounds, but at half the price of a
traditional PDA, heck, who’s complaining…?

At under Rs 10,000, the Nokia E50 is truly
light-weight, inexpensive and very compact. In
fact, it is the slimmest phone in this category,
and catches the eye because of its compact form
factor. The colour itself (dull black) will not
inspire much. The screen, though small, is bril-
liantly crisp, mainly due to the high pixel densi-
ty (240 x 320). Although the camera is strictly so-
so, this is forgivable for a business-oriented
phone. The lack of Wi-Fi and a full keypad, and
the ability to work with office documents (only
document editing allowed, no creation) means
this is more a smartphone than a PDA. However
the price makes it a killer deal.

Nokia’s E61 and E62 duo have had their fair
share of attention. With a large, clear, and crisp
screen, and an even larger form factor that some
like and others hate, these phones are definitely
aimed at users looking at affordable PDAs. The
two look identical, and are extremely well-built—
very solid in-hand. A brilliant 2.8-inch TFT with
16 million colours is the right way to go, and the

48

only difference between the functionality of the
two is the inclusion of Wi-Fi and 3G capabilities
on the E61. The QWERTY keypad is awkward to
use at first, but after a couple of days, we really
got used to them. Nokia should have made this
duo slimmer—these phones just aren’t for jeans!
A single ear-bud is provided, meaning music was-
n’t given importance. Battery life is stellar thanks
to the huge 1500 mAh battery on both phones.
For some weird reason, both phones miss out on
HSCSD (High Speed Circuit Switched Data), a fea-
ture present on the more basic E50.

Sony Ericsson’s M600 is definitely a winner
as far as looks and form factor go. Compact
enough to fit denims, it also feels substantial in
larger hands. The gorgeous screen feels bigger
(though it’s not) than the E61/E62 mainly due to
its vertical alignment (both the Nokias’ screens
are wider than they are long). Although the
touchscreen works rather well and picks up even
finger hits, we have two complaints with the sty-
lus: it’s too short to write properly with, and
after a while, it gets loose and keeps falling out
of its holder—not acceptable! The keys on the
M600 work surprisingly well—we were initially
dubious about having two letters on a single key,
but it works well: tap the left side of the oblong
keys and you have a Q, tap to the right and you’ll
get a W. It just needs getting used to.

The only Windows Mobile (WM)-based device
in test, HP’s iPAQ 514 is their latest model; it
tries to be a compact PDA by losing the QWERTY
(typical on all other iPAQs). Based on WM6, this is
a powerful PDA in the guise of a smartphone. It’s
built well, but feels built to a budget unlike other
iPAQs, which, considering its price, seems fair.
The keypad does feel a little tacky, but is well-

The following is our division of the phones:

Testing procedures were
identical across the
categories, except that
the business phones
were rated on their
ability to work with

office documents and their wireless data transfer abilities.
Weightages changed too—for example, multimedia phones should
have better cameras than, say, business phones, so we did not
assign too many weightage points to a business phones’ camera.
Conversely, a business phone should have multiple connectivity
options and a good application bundle, but for a multimedia phone,
this isn’t as important.

We divided features into the following broad heads, while
awarding points for the presence or absence of a feature. Subjective
criteria were awarded points on a scale of 10.

Features
Physical specifications: Characteristics like dimensions, screen size,
weight, and form factor were considered here.
Memory: Inbuilt memory, expandable memory, and their
characteristics.
Other phone features: These include address and call book
capabilities, and features like voice recording and voice dial. We also
recorded talk time and standby time here (according to
manufacturer-quoted specs).

Connectivity: This includes all possible connectivity options like Wi-
Fi, Bluetooth, GPRS, EDGE, etc.
Accessories: What came bundled on each phone (applications) and
inside each box (accessories)
business functionality: We rated the ability to work with different
documents, the interface of the phone itself while accomplishing the
task, as well as the bundled applications that aid the purpose. 
And finally, camera and media player features were listed.

We rated the build quality of the phones, more importantly, we
rated ergonomics—from comfort to usability. 

Performance
Signal and Voice Clarity tests: This is the most important test for any
cell phone or business. Call quality and signal quality were looked at.
We used two test zones—one was close to a window thereby giving a
better signal (zone 2), and the other (zone 1) was right in the middle
of our office, where even the strongest of cell phone signals die a non-
mysterious death. We also tested hands-free clarity.
The Camera: We tested all possible aspects of the camera (if present)
on each phone.
Multimedia: This test included quality of audio and video playback—
basically a good test of the speakers, bundled headphones, and
screen of a cell phone, aside from its processing hardware.

We also tested processing speed by multitasking, and Wi-Fi speeds
were tested by transferring a 25 MB file from a laptop to the business
phones. The laptop was a Core 2 Duo based, 1 GB affair connected to a
Linksys WRT54G wireless router via RJ45 to ensure that the only
bottleneck would be the wireless connection on the handheld’s side.

How We Tested

Nokia E50
Business is sleek!

A U G U S T  2 0 0 7

Multimedia Phones

Up to 12,500
12,501 - 20,000
Above 20,000

Business Phones

Upto 17,000
17,001 - 25,000
above 25,000
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laid-out and comfortable to use. Voice
Commander comes installed on the iPAQ 514,
meaning you can go truly hands-free by using
voice commands for commonly-used applica-
tions. Besides name-based number dialling, you
can also voice-dial single numbers, that is, actu-
ally call out the number.

One attractive-looking phone, finished in
soft matte black, the Motorola A1200 has a very
cool, translucent plastic flip cover over the
screen. Like the ROKR E6, the Motoming a.k.a.
the A1200 is Linux-based. Missing out on a key-
pad is never good unless the touchscreen is bril-
liant, and this is the A1200’s first shortcoming—
the touchscreen. We saw a lot of mis-registering
stylus hits. There’s very little space to type out
characters, so composing SMSes is painful.
Character recognition is not as good as WM or
Symbian’s UIQ. This mobile version of Linux def-
initely has its work cut out as a cell phone / PDA
platform.

Performance
All the Nokia phones have good antennas, with
almost no dropping in calls and reasonable voice
clarity even in zone 1. The E50 in particular
excelled here, and is definitely the benchmark-
setter in this category as far as this parameter
goes. The Sony Ericsson M600 takes fourth posi-
tion overall, while the HP iPAQ 514 brings up
the rear (voice clarity in zone 1 became a prob-
lem).

Although none of the cameras on the phones
in this category are worth too many words, the
E50 comes closest to being near-acceptable. The
image quality on the iPAQ is poor.

If you plan on using your full-time business
phone as a part-time music player, you’d proba-
bly want to take a look at the Sony Ericsson
M600. The E61 / E62 duo do reasonably well—just
make sure to invest in a 3.5 mm converter and
get a decent set of earbuds. Video playback, too,
is great on the E61 / E62, courtesy their large,
high-colour displays.

The two brick-like Nokias were also the snap-
piest while multi-tasking, while the Sony
Ericsson was the proverbial tortoise. Thankfully, a
firmware flash seemed to get its gears in motion.

The Motoming gave us decent signal recep-
tion in zone 2, but very mediocre performance in
zone 1. It’s also not as good as its multimedia-
oriented sibling, the Moto ROKR E6, as far as
multimedia playback goes.

With only two of these phones supporting Wi-
Fi, it wasn’t much of a comparison, but for the
record, the E61 is a little faster than the iPAQ 514.
Wireless browsing on both phones is acceptable—
a sustained speed of 1.35 MBps should be enough
for everything expect heavy downloading.

Our Conclusion
The phones in this category deviate from the
classical idea of a PDA. In fact, as our test
revealed, these are simply business-oriented
smartphones. The biggest attraction is their
price—getting a full-fledged PDA phone for any-
thing under 20,000 rupees is sadly still impossi-
ble. This is the next-best thing.

Flashy and gimmicky generally means a
touchscreen. If you want a really nice form as
well as flash-bling factors, then look at the Sony
Ericsson M600. It doesn’t have a camera, though.

The Sony
Ericsson M600’s
keypad is
surprisingly
usable—looks
can be
deceptive. The
Nokia E61 and
E62 are even
better!
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Decent music quality and a gorgeous screen (its
highlight, really) will be yours for the taking. 

The Motoming loses out on functionality.
It’s definitely not for serious business users;
rather, it targets those in between a fully-func-
tional PDA and something flashy. The
Motoming is only for Motorola fans who want a
touchscreen real cheap…

Nokia’s E61 / E62 duo have very good build
quality, great screens, and functional QWERTY
keypads to their credit. The E61 bags the Digit
Best Buy Silver award, and shadows its cheaper
twin by a hairsbreadth with the inclusion of Wi-
Fi—which in our collective opinion is a must for
this type of device. If you need wireless connec-
tivity, this is the sub-17,000 smartphone to buy. If
you don’t, the E62 will suffice. Being a newer
model, the E62 has support for A2DP, something
the E61 misses out on.

For someone looking at the flexibility and
application support provided by Windows
Mobile, look no further than the HP iPAQ 514 at
this price point. It has all the basic tools to get
your job done, Wi-Fi support, MS Office support,
and a host of useful applications pre-installed. At
Rs 14,000, this is the cheapest way to go WM!

Finally, we have our Digit Best Buy Gold win-
ner—Nokia’s E50 was just too irresistible a pack-
age to deny it the award. A PDA it’s not, but it’s
got nearly all the goodies except for wireless
connectivity. The inclusion of a camera certain-
ly doesn’t hurt. Just right for the executive—
who wants something that looks classy, is com-
pact, and has all the necessary features for a
business-oriented device, with some multime-
dia capabilities thrown in.

Beyond The Basics
(From Rs 17,001 To Rs 25,000)
Features
This category is where the fun really starts, as
each manufacturer now has a sizeable budget to
work with to give even more functionality, and
more importantly, usability. That word was miss-
ing in the sub-17,000 phones. What’s the use of all
the features in the world when they aren’t
usable… for example, a PDA that allows you to
write MS Word documents, but doesn’t give you a
proper keypad to accomplish the task. As many

users will testify to, working with T9 predictive
text is a pain for anything longer than 30 words.

HTC’s Touch was something to look at.
Based around the iPhone-like TouchFLO naviga-
tion, this is one smart-looking phone. It’s well-
finished in velvet black, which gives it a soft feel.
The navigation button on the front bezel looks
amazingly attractive—large and white set in a
chrome bezel. TouchFLO tries to cash in on the
iPhone concept of using your finger to swipe
around the screen, and it works pretty well on
this phone. For example, swiping your finger on
the HTC logo grants access to multimedia
(music, photo, and video) content. The swipe also
works well for contacts—swipe left for previous
and right for next, and so on. The swipe motion
needs you to exert a little extra pressure, which
most users will have to adjust to.

HTC’s D600 is a budget attempt at a PDA—but
a good one. It’s got an excellent screen, in fact,
even better than that on the C800 (another cost-
lier HTC model); it looks clearer. The buttons are
also very well-placed on the front bezel—a good
thing, considering it lacks a keypad. 

The HTC C720W has a full QWERTY keypad,
a little too much chrome on the front bezel, and
a really nifty and functional set of touch keys on
the front bezel that control volume with a fin-
ger-flick. The keypad compromises on spacing
for compactness, and the keys are hard—but
once again, it’s quite usable.

The O2 Xda Stealth is the fourth WM
device in this category. Rounded corners and
black make for a good combination, and this
phone features one of the best sliders
around—smooth as butter, with just the right
feedback even after a couple of weeks of use.
The positioning of the stylus underneath the
phone and too close to the USB port is quite
an irritation.

One of the only devices with both num-
ber and QWERTY keypads, Sony Ericsson’s
P990i is a large phone, with a large and crisp
screen. The iffy materials used on its exteri-

or didn’t leave a good impression. While the
backlighting is excellent, the QWERTY is not
ergonomic—the buttons are too small, and it
takes some getting used to. The number keypad
looks uncomfortable but is surprisingly easy on
the fingers. This phone also has a good camera

Blackberry’s
Pearl features a
compact yet
functional
QWERTY keypad
and a roller-ball-
type joypad that
makes naviga-
tion a snap

Nokia N93—Look Ma, I’m A Camcorder!

Nokia’s N93 is a camcorder under the guise of a
fully-functional cell phone. It’s a clamshell phone

that, once open, allows you to twist the screen,
thereby orienting it for viewing while shooting.
Incidentally, the camera is mounted on the side of the
phone. This gives a handycam-type of feel while
shooting.

The keypad is very well-laid-out: great key spacing,
and good feedback and tactility. Even the joypad feels
good under your thumb.

It’s bulky at 180 grams, but not bulky for a camcorder,
we say. With Wireless, 3G, EDGE, and Bluetooth support, the
N93 is really connected. We were dissatisfied with the puny
128 MB memory card bundled, although the videos we shot
turned out to be surprisingly compact.

While it’s fairly middling at photo shooting (the N73ME beats it
hands down), video shooting is what Nokia has been harping about.
VGA resolution (640 x 480) at 30 fps is good, and capable of
producing some nice, clear videos. With 3x optical zoom (the only
cell phone with this feature!), the N93 makes no bones about where
its appeal lies. Good-quality MP3 playback, too, is a definite plus. 

At Rs 42,209, the Nokia N93 is definitely costly, but it’s a
phone that has no competition really when it comes to video
shooting. It’s as close as cell phones have come to digital
camcorders, but to be honest, to that section of consumer
electronics the gap is more a chasm at the moment. We hope to
see bigger and better sensors, higher video resolutions, and a
longer optical zoom on Nokia’s camcorder range in the future.
If you aren’t into video shooting, give the N93 a miss—other
cell phones will do all it does at half the price!

Sony Ericsson P990i
Features galore
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Digital Tools l Cellphone Test

and a good media player. For the price (Rs
19,897), the SE990i has an extensive feature list.

Blackberry’s Pearl features a compact yet
functional QWERTY keypad and a roller-ball-type
joypad that makes navigation a snap. One look at
the screen icons will tell you this is no multime-
dia phone—very business-like, with loads of
applications pre-installed. For example, Yahoo!
Messenger and Google Talk are set to run out of
the box. The Pearl is really well-built, and the
compact form factor was something Blackberry
sorely needed in their line-up. 

Performance
The Sony Ericsson P990i offered some swift Wi-Fi
transfers—to the tune of 1.75 MBps! This PDA
offers great music quality while suffering a bit in
on call quality. 

During the voice clarity tests, the HTC
phones revealed where their true genes lie—and
it’s definitely not as a handset. Functionality—
yes, call clarity—needs to improve.

The best phone in this category was the
Blackberry Pearl. In fact, it was much better than
anything else in the previous category as well.
Amazing… no voice distortion even while mov-
ing from zone 2 to zone 1! It does have its weak
points, though—like the mediocre camera.

Our Conclusion
It’s smart looking, and it’s functional, not to
mention nifty—and more, it’s our Best Buy Silver:
the HTC Touch—unbeatable value for money at
under Rs 20,000. Definitely for you if you want a
flashy PDA with almost all the features.

If you’re looking for a multimedia-rich PDA,
the Sony Ericsson P990i will fit the bill. Just
remember a belt case is a must, as this phone
won’t fit tight jeans—we suggest you avoid try-
ing! A good camera, a great media player, two
keypads, a good screen, and all the connectivity
you’ll need—Digit Best Buy Gold belongs here!

The RIM Blackberry Pearl is just as flashy as
the HTC Touch, but its talents are more subtle,
less in-your-face. It’s very functional, very
Internet friendly, and it has a stellar antenna to
keep your phone calls connected almost every-
where. If all this appeals, then by all means, take
the plunge. We feel the price is a little steep, espe-
cially considering some of the other phones in
this test. Do not forget that Blackberry phones
aren’t available off the market shelf. They are
sold with select service provider schemes.

Corporate Mates
PDA Phones (Above Rs 25,000)
Features
Being a corporate user, you’ll probably scoff at
many of the contestants in the previous two cate-
gories. You receive a hundred mails a day. A
QWERTY keypad and a fully-functional docu-
ment assistant aren’t something you flash
about—you actually use every feature to the
fullest. In such a case, money isn’t the sole con-
cern—functionality and feature-convergence is.

The GPS-ready ASUS P535 is a standout look-
er. It’s compact, has exceptional build quality,
and sports a dark grey body that suits boardroom

environments. It comes with the richest software
bundle we’ve seen in a while. Take a look at Voice
Commander 2.0, a remote control / presentation
utility, a GPS utility with detailed maps, an
encryption software that protects all your pry-
worthy data from prying eyes, and a business
card scan utility that works really well. A 2 MP
camera with auto-focus hasn’t been forgotten.

HTC’s C800 is another solidly-built device
with pleasing aesthetics, except for the all-
chrome buttons on the front. The full QWERTY
that slides out from the side is a big plus. It’s
large enough for the ham-handed, and it doesn’t
add to the dimensions of the phone.

O2’s Xda Zinc has a form factor identical to
that of the P535 and the C800, but like the for-
mer, it misses out on a full QWERTY keypad.
Button ergonomics are good, though some may
find that the light grey body catches stains a lit-
tle too easily.

The old man in this test was IMate’s Jasjar.
Despite the fact that the Jasjar is essentially a
2005 model, it has all the features needed to
make it here, including a huge 3.7-inch screen
that actually sports an unheard-of VGA (640 x
480) resolution. Then there’s the full QWERTY
keypad that is revealed when you open the lap-
top-like lid. The best-laid-out QWERTY in test,
period! It uses the now-ancient 802.11b Wi-Fi pro-
tocol, and at 285 gm is by far the heaviest PDA
now in our labs. 

Nokia’s Communicator series gets a new flag-
ship—the E90 exemplifies what the
Communicators are all about. The hinge quality
has been beefed up, the camera now captures 3.2
megapixels, and both screens now display 16 mil-
lion colours. Incidentally, the smaller outer
screen is very crisp and ultra-usable—something
earlier Communicators missed out on. The key-
pad is typically Communicator—good tactile feed-
back and well-laid-out.

RIM’s Blackberry 8800 is their flagship, and
it shows: a well-laid-out QWERTY, and all the
great features aboard the Pearl minus the cam-
era that RIM figures corporates could do without
anyway. But mysteriously, Wi-Fi is absent. When
you take into consideration that this phone will
be part of a service provider bundle, this seems
to make sense. Browse using GPRS if you must!

Performance
Despite our best efforts at
signal scrambling, the
Blackberry 8800 wasn’t
fazed one bit—signal quality
was even better than that of
the brilliant Pearl. This 8800
loses out on multimedia per-
formance—music quality
isn’t really acceptable—you
just have to live with the
fact. The screen is good, how-
ever, and that makes for a
good visual experience, as
we discovered in our video
playback tests.

Nokia’s E90, too, has good
signal quality, and is snappy to boot. Its camera
does surprisingly well,and at 2.1 MBps on our

51

A QWERTY key-
pad and a fully-
functional docu-
ment assistant
aren’t something
you flash about if
you’re a corpo-
rate user—you
actually use
every feature to
the fullest

Nokia Communicator E90
The new brick!
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BRAND 
MODEL

*for category Business Phones up to 25,000

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 55/52*)
Performance (Out of 30/36*)
Price Index (Out of 15/12*)
Features
Physical Specs
Form Factor
Network Bands
Screen Resolution (Pixels)/Size (Inches)
No of Colours
Touchscreen / Dual Screen (✔ /✖ )
Dimensions (LxWxH) (mm)
Weight
Memory
Phone Memory (MB)
Expandable Memory / Type
Hot Swappable (✔ /✖ )
Other Features
Charging via USB (✔ /✖ )
Keypad (Regular/QWERTY)
Talk/Standby Time *
Offline Opearability (✔ /✖ )
Operating System
Communication Options
Internet (GPRS/HSCSD/EDGE/3G) 
Connectivity (WiFi/Bluetooth/IR/USB)
Bluetooth Version/A2DP support
Accessories
Bundled Applications
Bundled Accessories

Build Quality (So10)
Body / Keys
Movables Parts / Accessories
Accessories
Ergonomics (So10)
Interface / Navigation / Joystick
Keypad Layout/Comfort
Keypad Backlight
Camera Specs
Camera (✔ /✖ ) / Mega Pixels
Video Capture Resolution
Dual Cameras
Camera Settings (So10)
PDA Functionality
Sync Software Interface (So10)
Productivity (Office Apps. (So10)
Pre-installed Applications (So10)
Performance
Signal Reception Zone 1/2 (So10)
Voice Clarity Zone 1/2 (So10)
Handsfree Clarity (So10)
Photo Quality Colour/Crispness (So10)
Playlist Features/Audio Quality (So10)
Video Playback Quality (So10)
Processing Speed (So10)
WiFi Transfer Speed (MBps)

Scoreboard                   Business Phones UP to 17,000
Nokia
E50

Rs 9,500
+ Sleek

– Limited functionality

61.17
30.56
17.11
13.50

Bar
Triband
240 x 320 / 2”
256K
✖ /✖

113 x 43.5 x 15.5 mm
104 gm

70 MB (shared)
✔ /microSD
✔

✖

✔ /✖

6.4 hr/240 hr
✔

Symbian 9.1 (S60)

✔ /✔ /✔ /✖

✖ /✔ /✔ /✔

2.0/✔

PC Suite
Charger, data cable,
handsfree kit

7 / 6.5
NA / 6.5

6.5
6.5 / 6.75 / 5
7 / 6.5
7

✔ /1.3 MP
352 x 288
✖

5
7.5
3.5
5.5

6.25 / 7
6.5 / 7
7
4.5 / 4.25
5 / 6
5.5
6
NA

Nokia
E61

Rs 16,000
+ Gorgeous Screen

– Wide footprint

56.09
32.15
15.93
8.02

Bar
Triband/UMTS
320 x 240 / 2.8”
16M
✖ /✖

117 x 69.7 x 14 mm
144 gm

75 MB
✔ /microSD
✔

✖

✖ /✔

7 / 260 hrs
✔

Symbian 9.1 (S60)

✔ /✖ /✔ /✔

✔ /✔ /✔ /✔

1.2/✖

PC Suite
Charger, data cable,
handsfree kit

7.5 / 7.25
NA / 7.25

7.25
6.75 / 7 / 5.75
6.75 / 6.5
6.75

✖ /NA
NA
NA

NA
7.5
6
5.75

5 / 5.75
5 / 5.5
6.5
NA / NA
6 / 6
6.25
6.5
1.35

Motorola
A1200 (Motoming)

Rs 13,399
+ Touchscreen

– No keypad

54.29
32.98
11.75
9.57

Bar with flap
Triband
240 x 320 / 2.6”
256K
✔ /✖

95.7 x 51.7 x 21.5 mm
122 gm

8 MB
✔ /microSD
✔

✔

✖ /✖

4 / 200 hrs
✖

Linux

✔ /✖ /✖ /✖

✖ /✔ /✖ /✔

2/✔

✖

Charger, data cable,
handsfree kit

6.5 / 5.5
6.5 / 6

6
5.5 / 6.25 / 6.25
NA / NA
NA

✔ /2.0MP
352 x 288
✖

5
5.75
6
6

4.75 / 6.25
5 / 6.25
6
5 / 5.5
5 / 5
5
6
NA

Nokia
E62

Rs 11,500
+ Value for money

– Wide footprint

55.87
31.49
13.23
11.15

Bar
Triband
320 x 240 / 2.8”
16M
✖ /✖

117 x 69.7 x 14 mm
144 gm

80 MB
✔ /miniSD
✔

✖

✖ /✔

6 /330 hrs
✔

Symbian 9.1 (S60)

✔ /✖ /✔ /✖

✖ /✔ /✔ /✔

2.0/✔

PC Suite
Charger, data cable,
handsfree kit

7.5 / 7.25
NA / 7.25

7.25
6.75 / 7 / 5.75
6.75 / 6.5
6.75

✖ /NA
NA
NA

NA
7.5
6
5.75

5 / 5.75
5 / 5.5
6.5
NA / NA
6 / 6
6.25
6.5
NA
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HP
iPAQ 514

Rs 14,000
+ Compact

– No QWERTY

55.06
30.80
15.10
9.16

Bar
Triband
176 x 220 /2”
65K
✖ /✖

107 x 48.6 x 16.3 mm
102 gm

128 MB (shared)
✔ /microSD
✔

✔

✔ /✖

6.3 / 188 hrs
✖

Windows Mobile 6

✔ /✖ /✔ /✖

✔ /✔ /✖ /✔

1.2/✖

✖

Charger, data cable,
handsfree kit

7.25 / 6.5
NA / 6.5

6.5
6.25 / 6.5 / 6.5
6.5 / 6.75
6.5

✔ /1.3 MP
176 x 144
✖

5.25
6.75
6.25
6.75

5 / 5.25
4 / 5
5
3.25 / 2.75
6.25 / 6
5
5.5
1.25

So10 = Scale of 10



Business Phones Up to 25,000
Sony Ericsson

M600

Rs 16,500
+ Great screen, footprint

– No camera

52.68
33.17
11.75
7.77

Bar
Triband/UMTS
240 x 320 / 2.6”
256K
✔ /✖

107 x 57 x 15 mm
112 gm

80 MB
✔ /M2
✔

✔

✖ /✔

7 / 340 hrs
✖

Symbian 9.1 (UIQ 3)

✔ /✔ /✖ /✔

✖ /✔ /✔ /✔

2.0/✔

✖

Charger, data cable,
handsfree kit

6.5 / 6.75
NA / 6.5

6.5
6 / 6.25 / NA
6 / 6.25
6.75

✖ /NA
NA
NA

NA
6.25
6
5.5

5.25 / 5.5
4.25 / 5
6.25
NA / NA
6.25 / 6.5
6
4
NA

HTC
Touch

Rs 19,900
+ Compact

– Lacks QWERTY

61.76
31.58
19.48
10.69

Bar
Triband
240 x 320/2.8”
65K
✔ /✖

99.9 x 58 x 13.9 mm
112 gm

128 MB (shared)
✔ /microSD
✔

✔

✖ /✖

5 / 200 hrs
✔

Windows Mobile 6

✔ /✖ /✔ /✖

✔ /✔ /✖ /✔

2.0/✖

✖

Charger, data cable,
handsfree kit

7.5 / NA
NA / 7

7
7.25 / 7 / 6.5
NA / 5
NA

✔ /2.0 MP
176 x 144
✖

5
6.75
7
6.5

4.5 / 6
5 / 6
6
4.75 / 4.75
6 / 6
6
5.5
1.16

HTC
D600

Rs 19,700
+ Well built

– Poor call quality

58.82
30.98
17.04
10.80

Bar
Triband
240 x 320 / 2.8”
65K
✔ /✖

109 x 58 x 18 mm
126 gm

✖

✔ /SD, MMC
✔

✔

✖ /✔

5 / 200 hrs
✔

Windows Mobile 5

✔ /✖ /✖ /✖

N/✔ /✔ /✔

2.0/✔

✖

Charger, data cable,
handsfree kit

7.25 / 6.5
NA / 6.5

6.5
6.75 / 7 / 6.75
NA / NA
NA

✔ /2.0 MP
176 x 144
✖

6.25
7.5
6
6

4.5 / 6
4.25 / 5.5
6
5.5 / 5.25
6 / 6.25
6
5.75
NA

HTC
C720W

Rs 23,900
+ Good build

– Poor call quality

59.88
31.72
19.26
8.90

Bar
Triband
240 x 320 / 2.5”
65K
✖ /✖

111.5 x 62.5 x 12.8 mm
130 gm

✖

NA
✔

✔

✖ /✔

5 / 220 hrs
✔

Windows Mobile 5

✔ /✖ /✔ /✖

✔ /✔ /✖ /✔

✔ /✔

✖

Charger, data cable,
handsfree kit

7.5 / 7.25
NA / 6.75

6.75
6 / 6 / 6.5
6.25 / 6
7.25

✔ /1.3 MP
176 x 144
✖

6
7.5
6.5
6.75

5 / 5.5
4 / 5
6
5 / 5
6 / 6.25
6
6
1.36

O2
Xda Stealth

Rs 21,500
+ Slick Slider

– Keypad

60.04
31.49
18.65
9.90

Slider
Triband
240 x 320 / 2.4”
65K
✔ /✖

110 x 53 x 22.5 mm
140 gm

192 shared
✔ /MiniSD
✔

✔

✔ /✖

4.3 /150 hrs
✔

Windows Mobile 5

✔ /✖ /✖ /✖

✔ /✔ /✔ /✔

1.2/✖

✖

Headset, Data Cable,
A/C adapter

7.25 / 6.25
8 / 7

7
7 / 7 / 6.75
7 / 7
2

✔ /2.0 MP
176 x 144
✖

4.75
6.75
6.75
6.75

4.75 / 5.75
3 / 4.75
5.75
5 / 4.5
6.25 / 5.5
5.5
5.5
1.65

Sony Ericsson
P990i

Rs 19,897
+ Great feature set

– Bulky, Plasticy

65.84
36.33
18.82
10.69

Bar
Triband/UMTS
240 x 320 / 2.75”
256
✔ /✖

114 x 57 x 26 mm
150 gm

60 shared
✔ /MS Pro Duo
✔

✔

✔ /✔

9 / 430 hrs
✔

Symbian 9.1 (UIQ 3)

✔ /✔ /✖ /✔

✔ /✔ /✔ /✔

2.0/✔

✖

Headset, Data Cable, A/C
adapter 

6 / 6
6 / 6.5

6.5
6 / 6.25 / 5.75
5 / 5
6.75

✔ /2.0 MP
176 x 144
✔  

5.25
6.25
6
6

4.75 / 6
3.5 / 5
6
5.75 / 6
6.25 / 6.5
6
3
1.75

RIM
BlackBerry Pearl

Rs 24,990
+ Sleek, functional

– Cramped QWERTY

59.54
30.55
20.48
8.51

Bar
Triband
240 x 260 / 2.2”
65K
✖ /✖

107 x 50 x 14.5 mm
89.5 gm

64 shared
✔ /microSD
✔

✔

✖ /✔

3.3 /360 hrs
✔

Proprietary

✔ /✖ /✔ /✖

✖ /✔ /✖ /✔

2.0/✖

✖

Charger, data cable,
handsfree kit

7 / 6.5
NA / 6.25

6.25
6.5 / 6 / 6.5
6.5 / 6.5
6

✔ / 1.3 MP
✖

✖

2.5
6.75
6.5
6.5

6.75 / 7
7.25 / 7.5
7
4 / 4
2.5 / 5.25
6
5.75
NA
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BRAND 
MODEL

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 52)
Performance (Out of 38)
Price Index (Out of 10)
Features
Physical Specs
Form Factor
Network Bands
Screen Resolution (Pixels)/Size (Inches)
No of Colours
Touchscreen / Dual Screen (✔ /✖ )
Dimensions (LxWxH) (mm)
Weight
Memory
Phone Memory (MB)
Expandable Memory / Type
Hot Swappable (✔ /✖ )
Other Features
Charging via USB (✔ /✖ )
Keypad (Regular/QWERTY)
Talk / Standby Time *
Offline Opearability (✔ /✖ )
Operating System
Communication Options
Internet (GPRS/HSCSD/EDGE/3G) 
Connectivity (WiFi/Bluetooth/IR/USB)
Bluetooth Version/A2DP support
Accessories
Bundled Applications
Bundled Accessories

Build Quality (So10)
Body / Keys
Movables Parts / Accessories
Accessories
Ergonomics (So10)
Interface/Navigation/Joystick
Keypad Layout/Comfort
Keypad Backlight
Camera Specs
Camera (✔ /✖ )/Mega Pixels
Video Capture Resolution
Dual Cameras
Camera Settings (So10)
PDA Functionality
Sync Software Interface (So10)
Productivity (Office Apps. (So10)
Pre-installed Applications (So10)
Performance
Signal Reception Zone 1/2 (So10)
Voice Clarity Zone 1/2 (So10)
Handsfree Clarity (So10)
Photo Quality Colour/Crispness (So10)
Playlist Features/Audio Quality (So10)
Video Playback Quality (So10)
Processing Speed (So10)
WiFi Transfer Speed (MBps)

Scoreboard                             Business Phones Above 25,000
ASUS
P535

Rs 37,800
+ Good build, looks, features

– Expensive

61.26
33.01
20.63
7.62

Bar
Triband
240 x 320 / 2.8”
65K
✔ /✖

109 x 59 x 19 mm
145 gm

256 MB (shared)
✔ /MiniSD
✔

✔

✖ /✔

5 / 200 hrs
✔

Windows Mobile 5

✔ /✖ /✖ /✖

✔ /✔ /✖ /✔

2.0/✖

✖

Headset, Data Cable, A/C &
Car chargers, desktop stand

7.75 / 6.5
NA / 8

8
7.25 / 7.25 / 6
6 / 6.5
5

✔ / 2.0 MP
176 x 144
✖

5.25
6.75
7.25
7.5

5.5 / 6.25
6 / 6
6
5.5 / 5.5
6.25 / 6.25
6
6
1.54

HTC
C800

Rs 34,900
+ Good build, features

– Expensive

59.78
32.74
18.79
8.25

Bar with side slider
Triband
240 x 320 / 2.8”
65K
✔ /✖

109 x 59 x 17 mm
168 gm

128 MB (shared)
✔ /microSD
✔

✔

✖ /✔

5 / 220 hrs
✔

Windows Mobile 5

✔ /✔ /✔ /✖

✔ /✔ /✖ /✔

2.0/✔

✖

Charger, data cable,
handsfree kit

7.25 / 6.75
6.75 / 6.5

6.5
7 / 7.25 / 6.25
6.5 / 6.75
5.75

✔ /2.0 MP
176 x 144
✖

6.25
7.5
6.5
7

5 / 6
4 / 5
6
5.75 / 5.25
6 / 6.25
6
6.25
1.54

I-mate
Jasjar

Rs 40,000
+ The ultimate QWERTY

– Phasing out

57.78
33.89
16.70
7.20

Swivel and Fold
Triband/UMTS
640 x 480 / 3.7”
65K
✔ /✖

127 x 81 x 25 mm
285 gm

64 MB (shared)
✔ /MMC, SDIO
✔

✔

✖ /✔

8 / 260 hrs
✔

Windows Mobile 5

✔ /✖ /✖ /✔

✔ /✔ /✔ /✔

1.2/✖

✖

Data cable, A/C charger,
extra stylus

7 / 7.25
7 / 7

7
7.25 / 7/6
7.5 / 7.25
7.75

✔ / 1.3 MP
176 x 144
✔

4.5
6.75
7.25
6.5

4 / 5
3.5 / 5.25
5.25
4.25 / 4
6.25 / 6.5
6
6.25
1.6
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Nokia
Communicator E90

Rs 40,499
+ Extremely powerful

– Heavy, bulky

64.99
36.19
21.69
7.11

Bar and folding
Triband
800x352/240x320/4”
16M (both)
✖ /✔

132 x 57 x 20 mm
210 gm

128 MB (shared)
✔ /micro SD
✔

✖

✔ /✔

5 / 330 hrs
✔

Symbian 9.2 (S60)

✔ /✔ /✔ /✔

✔ /✔ /✔ /✔

2.0/✖

PC Suite
Headset, Data Cable,
A/C adapter

7.25 / 7.5
7.25 / 7.25

7.25
6.75 / 7.25 / 6.5
7 / 7.25
6.75

✔ /3.2 MP
352 x 288
✖

6.5
7.5
7
6.5

5.75 / 6.5
5.5 / 6
6.5
6.5 / 6.5
4.75 / 5.5
6.25
6.25
2.1

RIM
BlackBerry  8800

Rs 31,990
+ Well built, features

– No WiFi support

59.17
29.11
21.06
9.00

Bar
Triband
320 x 240 / 2.8”
65K
✖ /✖

114 x 66 x 14 mm
134 gm

64 shared
✔ /MicroSD
✔

✔

✖ /✔

5 / 530 hrs
✔

Proprietary

✔ /✖ /✔ /✖

✖ /✔ /✖ /✔

2.0/✖

Blackberry user tools
Headset, Data Cable,
A/C adapter, holster

7/6
NA/6.25

6.25
6.5 / 6.25 / 6.5
6.25 / 6.5
6

✖ /NA
NA
NA

NA
6.75
6.5
6.5

7.25 / 7.25
7.5 / 7.5
7
NA / NA
2.5 / 5.5
6
6
NA

O2
Xda Zinc

Rs 34,990
+ Large keypad

– None in particular

60.52
32.98
19.30
8.23

Bar
Triband/UMTS
240 x 320 / 2.8”
65K
✔ /✖

109 x 58 x 22.6 mm
175 gm

128 shared
✔ /MiniSD
✔

✔

✖ /✔

5 / 220 hrs
✔

Windows Mobile 5

✔ /✖ /✖ /✔

✔ /✔ /✔ /✔

✖ /✖

✖

Headset, Data Cable,
A/C adapter

7 / 6.5
6.5 / 7.25

7.25
7.25 / 7.25 / 6.25
6.5 / 6.75
6

✔ /2.0 MP
176 x 144
✔

4.75
6.75
7.25
6.75

5 / 6
5 / 5.75
6
5 / 4.75
6.25 / 5.75
6
5.75
1.8
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WLAN, this PDA is truly for the wireless at heart.
ASUS’ P535 is very responsive and has decent

signal quality too. Some loss in voice clarity in
zone 1, but that was acceptable.

The Jasjar didn’t drop any calls, but quality
was low, especially in zone 1; do not opt for this
phone if cellular reception is an issue in your
area, and if that is an important factor affecting
your decision. That aside, music playback is very
good—a 3.5 mm jack is always appreciated. Wi-Fi
performance was surprisingly good considering
the older 802.11b protocol in use.

Both the HTC C800 and O2’s Xda Zinc per-
formed better than the Jasjar as signal strength
and quality go.

Our Conclusion
For an unbeatable mix of features, like a stellar
screen (two screens actually), a great keypad
(both keypads in fact), good signal quality, and
unbeatable connectivity options, the E90 is spe-
cial. Add to the party loads of applications bun-
dled, a great camera, and quality accessories… It
sums up to a Digit Best Buy Gold award—Nokia’s
E90 is highly recommended to corporate users
who need the features and don’t mind the size.

It’s hard to recommend the Imate Jasjar to
anyone looking for a PDA phone, despite its fea-
tures and performance. For one, the model is on
the verge of being phased out. It does have the
most easy-to-work-with screen of the bunch.

Our Best Buy Silver winner, the ASUS P535,
is a combination of great and usable features,
superb build, functionality, and a good bundle.
How we long for a QWERTY keypad on this one!
GPS means it’s the PDA for road warriors who
don’t want to invest in an add-on GPS unit. 

The Blackberry 8800 makes for a sensible
purchase if you’re looking for one-touch connec-
tivity to mail and popular chat services; remem-
ber that service providers have special schemes
for SIM cards bundled with this phone. 

MULTIMEDIA PHONES
The difference between a multimedia phone and
a business phone is more about about the way
manufacturers position devices than anything.
For example, Nokia has always had a business
series of phones. They now choose the prefix “E”
to denote “enterprise,” we presume, to denote
this category. Their multimedia series now has
the prefix “N” (Njoy? Ntertainment? You choose.)
Similarly, Sony Ericsson has a “P” series for busi-
ness class phones, and a “K” series for camera
phones. Their Walkman series of phones have
model numbers prefixed with “W”. 

The one thing to remember is that 99 per

cent of all phones are built to a price. While
thinking business phone, a manufacturer would
think office productivity, long e-mails (read
QWERTY), and Wireless LAN, among others.
Similarly, multimedia phones are used for enter-
tainment, and the tools for entertainment are
good PMP features and quality, funky looks, a
good camera, and such. With looks ranging from
sexy to cute to bizarre, there’s literally some-
thing for everyone. 

After sorting through this month’s lot of
phones, we selected 19 of them for a comparison
shootout that spanned three categories.

Grab ‘Em Hot!
(Up To Rs 12,500)
Features
The tiniest phone in this category has the soul of
an MP3 player—the BenQ-Siemens’ EF51 has a
flap that holds all PMP buttons (playback, next /
previous track, pause, etc). Open the flap and the
keypad appears. A tiny screen with blurry icons
isn’t really fun, though. 

Samsung had a trio of phones in this catego-
ry. The SGH-E840 is by far the best looking of the
lot. With an ultra-slick slider, this phone has
touch-type menu buttons. The keypad is a little
recessed, but feedback isn’t a problem. The other
two Samsung phones were the slimmest phones
we received.

LG’s KE820 is an unusual-looking phone. A
wide phone with a large keypad that much
resembles the keys on a calculator, this is
nonetheless really comfortable to type SMSes on.
The screen is a let-down: blurry. On to the
Motorola KRZR K1: Motorola really has their
ergonomics right, and while attending a call, the
KRZR K1 feels natural in the hand, and the posi-
tioning of the speaker and mouthpiece is such
that they coincide with your ear and mouth
respectively. Some of us liked the keypad, some
didn’t (too much colour), but it’s well-laid-
out overall, and feedback is good.

Nothing extraordinary about the
Nokia 6300 as looks go. A slim phone,
slightly long, with a solid steel back, the
6300 is built to last. A good screen, great on-
screen icons (typical Nokia), only
Samsung’s E840 gives it a bit of a run for its
money as far as the display goes. 

Performance
Nokia’s 6300 dominated both the call and
audio quality tests. In zone 1 the signal qual-
ity was pretty good, very little distortion;
zone 2 had no issues whatsoever. 

Despite having
dedicated PMP but-
tons, the tiny BenQ-
Siemens’ audio quali-
ty is mediocre at best.
The real culprit is the
lower-quality headset
that comes bundled.
The audio quality on
the Samsung phones is
also mediocre; once
again, poor-quality

The ASUS P535,
is a combination
of great and
usable features,
superb build,
functionality,
and a good
package

Nokia 6300
Sleek and functional
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Your Budget We RecommendYou Want

Decision Maker

Something solid, functional and simple
Funky looks on a budget
Great Camera with functionality
Good MP3 player, great screen, with
functionality
PDA-like features on a budget
Functional QWERTY/High end PDA
functions
PDA with flaunt value
Upwardly Mobile
Cheapest way to a touchscreen

8,000 to 13,000
8000 to 12000
Dependent on performance
Up to 25,000

Up to 15,000
Unlimited

NA
What is that?
14,000

Motorola KRZR K1, Nokia 6300, SGH E-840
Samsung SGH E-490, SGH E-840, LG KE820
Nokia N95, Sony Ericsson K790i, Nokia N73ME
Nokia N73ME, Sony Ericsson K790i

Nokia E62, HP iPAQ 514
Nokia E90, Imate Jasjar, O2 Xda Zinc

ASUS P535, Sony Ericsson P990i
Nokia 8800 Sirocco
Motoming (A1200)
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headphones are the culprits rather than the
device itself. The only redeemer for them is the
SGH-E840, which offers decent call reception and
acceptable music quality.

Coming to the camera quality, let’s face it—
none of these devices have cameras worth any-
thing more than a cursory shot. Samsung’s
SGH-X820 and SGH-E840 offer the best cam-
eras in the sub-12.5 grand block. Since none of
these phones have a lot of applications
installed, they’re all reasonably fast.

Our Conclusion
If you’re looking for a good phone in this cate-
gory, Nokia’s 6300 will satisfy at Rs 11,489. Its
overall dominance in our tests, and signal quali-
ty in particular aside from the solid build, make
it one of the candidates for our Digit Best Buy
Gold award. 

However, this was a close affair: the Samsung
SGH-E840 was neck and neck all the way, with
the 6300 just sneaking ahead by a hairsbreadth.
Samsung’s E840 shares the precious yellow with
Nokia—joint Best Buy Gold. These phones are
very different, however—the Samsung should be
your choice if you want a slick-looking phone
with a decent camera; just 10,700 rupees.

If you want a cool-looking clamshell
phone, the Motorola KRZR K1 is for you. At
under Rs 10,000, and with great build quality,
a flashy keypad, and a body that will get onlook-
ers all hot and envious, this is a good phone for
college-goers who want something compact and
curvaceous.

Dare To Flash
(Rs 12,501 To Rs 20,000)

Features
Motorola is the only brand to have featured a
touchscreen phone in this price category. The
ROKR E6 uses Tux mobile (Linux), similar to

the Motoming (the A1200). Neither phone had
any sort of a number keypad, a glaring omis-
sion in our opinion. Just try typing with an on-
screen keypad and a stylus and you’ll under-
stand why. The typing area on-screen is also
limited to a small patch where letters are
detected. Also, only characters can be detect-
ed, not entire words (Windows Mobile does
that). These gripes aside, it’s a brave effort
from Motorola—touchscreen phones rarely
cost under Rs 20,000.

Last year’s winner, the N70, quickly gets
overshadowed. The 5700 Xpress Music is a
quality offering from Nokia featuring a twist
keypad similar to the one on the Nokia 3250.
The other side of the keypad has dedicated
music keys.

The best-looking phone in this comparison
(this writer’s personal choice!) is the Sony
Ericsson K790i. An exquisite matte-finished
rear (some soft-feeling surface coating) con-
trasts well with the piano black finish on the
front. The bezel surrounding the screen is
brushed metal, again black. A good keypad
and a joystick smooth as butter makes 
working with this phone a delight. The ultra-
crisp screen and high-resolution icons are
other attractions. While on topic, how does a
3.2 MP camera with an ultra-bright Xenon
flash sound?

The SE W880i is the slimmest phone in this
category. Surprisingly usable, though—the but-
tons are tiny and good for similar fingers. The
joypad looks painful at first but works well. The
W610i has an even smaller keypad that is
uncomfortable if you’re using your fingertips:
the trick is to use your nails. The circular menu
buttons don’t offer feedback and you need to
press at a particular place to get the desired key
hit, else it might not register. The older W810i
is still around—decent keypad, and a crisp-look-
ing, small screen.

Nokia Sirocco 8800 Gold Edition: Of Luxuries And Sinful Indulgences!

So you’ve got the cash to burn, but being the self-made millionaire
that you are, spending upward of 5 lakhs on a Vertu seems

criminal. Enter the 8800 Sirocco and Nokia’s upmarket offering, for
those who delineate the term upwardly mobile. A beautiful box,
well designed accessories, and a phone whose body is glossy
steel that will shimmer when exposed to light will greet you.
You immediately get a feeling of cash well-spent (though we
can’t afford to test this parameter!). Remember to have
your valet carry around chamois leather with him—the
surface of this phone is a smudge magnet.

The display is scratch-resistant sapphire glass. You
won’t think much of the display itself once you see the
N95 (256K colours and 208 x 208 pixels doesn’t seem
much in comparison), but who gives a hoot about
the screen when you probably have PAs to do all
your dirty work, right? That said, the display is
crisp in its own right, owing to its smaller size. Two
batteries are provided, and so is a neat-looking
charging dock that can charge your phone and the
spare battery simultaneously.

The 8800 has an unbeatable slider (quality- and ergonomics-
wise) that we initially had no clue how to operate. Pushing

downward on the keypad recess to reveal the keypad does nothing
and we thought, “Oi, what’s up here!” Instead, you have to

push upward on the silver-coloured protrusion. Voila!
The display and keypad slide out together. Engaging
is a very decisive metal click. We must have done
this at least 200 times on the phone—absolutely no

give in the mechanism, superb!
The 8800 Sirocco has 128 MB of memory onboard

with no expansion. Music quality is good; however, with
a paltry amount of storage, you’re never going to ditch

your PMP. The camera is strictly decent—more for show
than anything. Incidentally, the lack of a POP port (ugly

things those!) means you will be solely reliant on Bluetooth
for data syncing. Best leave that task to your PA.

The 8800 Sirocco, true to its pedigree, is all about class and
less about functionality. It’s a full fledged phone and gives you

the added functionality of a camera and a music player. This is not
where the charm lies in though—simply carrying around a Sirocco is
bound to get you a lot of attention! Think of more as a fashion
accessory and an essential part of your designer wardrobe! At
rupees 65,000 it’ll bring out the latent class in that Armani (while
ensuring your PA stays busy!).

Samsung SGH-E840
Slick Slider
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Performance
Camera…? One word—K790i. This is perhaps the
best 3.2 megapixel camera out there (neck and
neck with the N73’s camera). Brilliant image
quality, and colours are reasonably neutral, with
only a slight hint of red. All this at default set-
tings; we could have seen better results with a
little tweaking, but we reminded ourselves that
this wasn’t a digital camera test. The other cam-
eras are mostly mediocre, with the Sony
Ericssons sporting the best image capture hard-
ware. The only possible gripe against the K790i is
the painful SIM removal. To be sure, not many
users would keep swapping SIMs, so this should-
n’t sway you.

The Nokia N70 performed surprisingly badly
in the signal quality tests—we even got a couple
of disconnected calls. Voice quality wasn’t bad,
but the call getting disconnected wasn’t fun.
This happened in zone 1; zone 2 was a little reas-
suring, but still by far the worst of the phones.
Hands-free quality was, strangely, the best in the
test.

Coming to PMP capabilities, we were sur-
prised to see the “best sounding as an MP3 play-
er” award going to a non-Walkman phone. In
fact, the K790i pushed away from all its
Walkman siblings to grab the accolades here. It’s
just limited by the mediocre headphones.

Nokia’s 5700 did well in the music test, aided
by good headphones of the supra-aural type. We
also liked the concept of the wireless earphones
on the ROKR E6. While these sound good, they
are a little uncomfortable. People with smaller
ear canals, watch out!

Our Conclusion
Sony Ericsson’s K790i is simply unbeatable—an
excellent camera, great music quality, an excel-
lent screen to add to a good keypad, and excellent
joystick. A no-brainer—the Digit Best Buy Gold to
this excellent all-rounder. Highly recommended
if you have a budget of rupees 16,000.

The Digit Best Silver award has been bagged
by Nokia’s 5700 Xpress Music, we declare. Good
music quality, a good screen, and nifty MP3 but-
tons! Do pad up your thumb before touching the
joypad though!

If you want something slim yet very incon-
spicuous looking, consider SE’s W880i. Just
remember, you’ll pay a hefty premium for the
features. If you’re OK with something just a lit-
tle less slim, go with the SE W610i—it’s a little
flashy (lots of orange). Both these phones per-
formed well overall. Remember, these should
only be your choice if you absolutely do not like

Sony Ericsson K790i
Awesome camera, great
music…
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the looks of the K790i. However, this would be a
rare event indeed, and most users will just blind-
ly buy the K790i—superlative choice really…

Nokia’s 5700 is not an option—not with the
K790i around in a similar price range.

The Motorola ROKR E6 is another phone that
grabs attention. A touchscreen and a Bluetooth
headset (which costs Rs 3,000 extra), this is some-
thing for those who like to flash their handsets
around.

Super, Smart, Sexy
(Above Rs 20,000)
Features
The LG KG-920 stands out here—very gimmicky-
looking, with an array of buttons sticking out
from nearly every angle. A lot of buttons usually
spells ergonomics with a capital E. The camera
button is beautiful—soft click (less chances of
shaking) with great feedback; not so the other
buttons. The joypad is hard on the fingers owing
to sharp ridges. The tiny keypad is a pain for all
except the tiniest fingers. The sharp screen is a
plus.

The Sony Ericsson W950i is basically an
M600 in a different garb—the Walkman series
colour tones are evident, and the QWERTY is
absent. The diaphragm type keys work well, but
longevity is an issue with such keypads—you
can’t replace the keys. A brilliant screen domi-
nates the W950i. The stylus gets slippery in its
sheath after a few weeks, though.

The Nokia N73 Music Edition is a weirdly
long phone. Wonder why so much of space was
wasted below the gorgeous screen! A larger key-
pad would have been appreciated. Feedback is
good, though, but the joypad is once again a
pain. No such ergonomic issues on the other
Nokias, though. The N80 feels a little chunky
and boasts of a surprisingly high resolution
screen (352 x 416) pixels. We’d like to have seen
a larger screen though—just not enough real-
estate to take advantage of all those pixels! The
N73ME is all black, and comes with a 2 GB
memory card. Nokia’s POP to 3.5 mm converter
is bundled too—this accessory costs Rs 1,000 all
by itself.

The N95 is superb in every way except one: its
slider isn’t tactile, and feels tacky. Whether this
is intentional or not we don’t know, but extra
friction should affect life, in our opinion. The
display’s absolutely superb, and with 2.6 inches
displaying 16 million colours, everything looks
clear, crisp, and rich… The phone also has GPS
inbuilt; although Nokia’s maps are currently
rudimentary, this can only get better.

Performance
We spent a lot of time with the N73ME, having
used the N73 before this. The inbuilt speakers are
powerful—more so than those on the N95. Music
quality is very good, with higher volumes than
those on the SE K790i. Clarity is good, but the
midtones sound a little recessed. A good set of
earplugs will get the most out of this phone.

The N95 has a superlative camera, a little 
better than that on the LG KG920, which

Company Web SiteBrand

Contact Sheet Cellphone Test

ASUS
BenQ-Siemens
HP
HTC
Imate
LG
Motorola
Nokia
O2
RIM (Blackberry)
Samsung
Sony Ericsson

ASUS Technology Pvt. Ltd. 
BenQ India Pvt. Ltd.
Hewlett Packard India Pvt. Ltd.
Dopod Communication (India) Pvt. Ltd. 
Fourth Generation Mobiles Pvt. Ltd.
LG Electronics India (Pvt.) Ltd. 
Motorola India
Nokia India 
O2 
Available with select Hutch and Airtel outlet
Samsung Telecommunications India 
Sony Ericsson Mobile Communications (India) Pvt Ltd 

www.in.asus.com 
benq.co.in
www.hp.com
www.dopodasia.com 
NA
www.lgindia.com
www.motorola.com
www.nokia.com
www.seeO2.com 
www.blackberry.com
in.samsungmobile.com 
www.sonyericsson.com 



BRAND 
MODEL

*for category Multimedia Phones above 20,000

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 52/53*)
Performance (Out of 38/39*)
Price Index (Out of 10/8*)
Features
Form Factor
Network Bands
Screen Resolution (Pixels/inches)
No of Colours (Screen)
Touchscreen/Dual-screen (✔ /✖ )
Dimensions (LxWxH) (mm)
Weight (grams)
Memory
Phone Memory
Expandable Memory/Type
Other Features
Keypad (Regular/QWERTY)
Address Book Capacity
Voice Recorder/Dialling
Talk Time/Standby Time *
OS
Connectivity
Browsing (GPRS/HSCSD/EDGE/3G) 
Connectivity (WiFi/Bluetooth/IR/USB)
Bluetooth Version/A2DP support
Accessories
Bundled Accessories
Memory card provided (size)
Build Quality (So 10)
Body/Keys
Flaps, Slider/Other Movable Parts
Ergonomics (So 10)
User Interface/Navagation/Joystick
Keypad Layout/Comfort/Backlight
Shortcut Key/Additional Key ergonomics
Playlist Features (So 10)
FM Radio (✔ /✖ )
Camera Specs
Camera (Y/N)/Megapixels
Video Capture Resolution (pixels)
Lens Protection/Rear Mirror/flash (✔ /✖ )
Camera Settings (So 10)
Auto Focus/Zoom(Optical/Digital) (✔ /✖ )
Performance
Signal Reception (So 10)
Zone 1/Zone 2
Voice Clarity (So 10)
Zone 1/Zone 2
Handsfree Clarity
Multimedia Performance
Audio / Earphone Quality(So 10)
Video Playback Quality (So 10)
Captured Image Quality (So 10)
Colour/Crispness
Video Quality
Processing Speed (So 10)

Scoreboard       Multimedia Phones—Rs 12,501 to Rs 20,000
Motorola
ROKR E6

Rs 14,985
+ Gimmicky

– Ergonomics

57.74
30.71
19.22
7.81

Bar
Triband
240 x 320 / 2.4”
256K
✔ /✖

111 x 51.5 x 14.5 mm
121 gm

8 MB
✔ /SD

None
Unlimited
✔ /✔

7 / 235 hrs
Linux

GPRS, EDGE
Bluetooth, USB
2/✔

headset, charger, data cable

512 MB

6.5 / 6.5
NA / 6.25

6 / 6.25 / 6.25
6 / 6 / 6.5
5
5.5
✔

✔ /2 MP
176 x 144
✖ /✔ /✖

4.25
✖ /✖ /✔

4 / 5

4.5 / 5.75
5.25

6 / 5.75
5

5.25 / 4.5
3.75
6

Nokia
5700

Rs 14,799
+ Looks, music quality

– Very hard joypad

63.83
32.76
23.16
7.91

Twist
Triband / UMTS
240 x 320 / 2.2”
16M
✖ /✖

108 x 50 x 17 mm
115 gm

35 MB
✔ /microSD

Regular
Unlimited
✔ /✔

3.3/290 hrs
Symbian OS v.9.2(S60)

GPRS, HSCSD, EDGE, 3G
Bluetooth, IR, USB
2/✔

Charger, data cable, handsfree

512 MB

6.5 / 6.5
6.75 / 6.75

6.5 / 6.75 / 3
6.25 / 6.5 / 6.75
5.75
6.75
✔

✔ /2 MP
352 x 288
✖ /✖ /✔

6.25
✖ /✖ /✔

6 / 6.5

5.5 / 6.25
6.5

6.5 / 6.5
6.25

5.75 / 5.75
6
5

Sony Ericsson
W880i

Rs 19,529
+ Very slim

– Poor call quality

60.64
34.28
20.37
5.99

Bar
Triband / UMTS
240 x 320 / 1.8”
256K
✖ /✖

103 x 46.5 x 9.5 mm
71 gm

16 MB
✔ /M2

Regular
1000
✔ /✔

6.3 / 425 hrs
Proprietary

GPRS, HSCSD, 3G
Bluetooth, USB
2/✔

Charger, data cable, handsfree

1 GB

7 / 6.75
NA / 6.5

5.75 / 6 / 5.5
6 / 4 / 5.75
6.25
6.25
✔

✔ /2 MP
176 x 144
✖ /✖ /✔

5
✔ /✖ /✔

5.25 / 5.75

3 / 5.5
5.75

6.25 / 6
5.5

5.5 / 5.75
5
6.25

Nokia
N70

Rs 16,699
+ Good looks

– Screen, cramped keypad

58.23
31.46
19.76
7.01

Bar
Triband / UMTS
176 x 208 / 2.25”
256K
✖ /✖

108.8 x 53 x 21.8 mm
126 gm

22 MB (shared)
✔ /RSMMC

Regular
Unlimited
✔ /✔

3.3 / 265 hrs
Symbian 8.1a (S60)

GPRS, EDGE, 3G
Bluetooth, USB
2/✖

Charger, data cable, handsfree

128 MB

6.5 / 7
5.75 / 7

6.5 / 6.75 / 5.5
6 / 6 / 6
5.75
6
✔

✔ /2 MP
176 x 144
✔ /✖ /✔

5
✖ /✖ /✔

4.75 / 5.5

4 / 5
6.25

6 / 6
4.75

5 / 4.5
4.75
6

Sony Ericsson
K790i

Rs 16,222
+ Great all round

– Camera slider flimsy

65.08
35.22
22.65
7.21

Bar
Triband
240 x 320 / 2”
256K
✖ /✖

105 x 47 x 22 mm
115 gm

64 MB
✔ /M2

Regular
1000
✔ /✔

7 / 350 hrs
Proprietary

GPRS, HSCSD, EDGE
Bluetooth, IR, USB
2/✔

Charger, data cable, handsfree

512 MB

7.25 / 6.5
6 / 6.5

6.25 / 6 / 6.5
6.75 / 6.5 / 6.5
6
5.5
✔

✔ /3.15 MP
176 x 144
✔ /✔ /✔ (Xenon)
7
✔ /✖ /✔

5 / 6

3.5 / 6
6.25

7.5 / 6
6.25

7.25 / 7.5
6.25
6.5
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Multimedia Phones Above Rs 20,000
Sony Ericsson

W610i

Rs 15,151
+ Great build

– Tiny keys

61.49
33.82
19.95
7.72

Bar
Triband
176 x 220 / 1.96”
256K
✖ /✖

102 x 46 x 14 mm
95 gm

64 MB
✔ /M2

Regular
1000
✔ /✔

7 / 350 hrs
Proprietary

GPRS, HSCSD, EDGE
Bluetooth, IR, USB
2/✔

Charger, data cable, handsfree

512 MB

6.5 / 6.5
NA / 6.5

5.75 / 6 / 6
6.5 / 6 / 7
6
6.25
✔

✔ /2 MP
176 x 144
✖ /✔ /✔

5
✔ /✖ /✔

4.75 / 5.5

3 / 5.5
6

6 / 6
5.5

5.5 / 5.75
4.5
6.25

Sony Ericsson
W810i

Rs 13,000
+ Compact

– Small screen

60.94
30.93
21.01
9.00

Bar
Triband
176 x 220 / 1.8”
256K
✖ /✖

100 x 46 x 19.5 mm
99 gm

20 MB (shared)
✔ /MS Pro Duo

Regular
1000
✔ /✔

8 / 350 hrs
Proprietary

GPRS, HSCSD, EDGE
Bluetooth, IR, USB
2/✖

Charger, data cable, handsfree

64 MB

6.5 / 6.5
NA / 6.25

6.25 / 6.5 / 6.25
6.75 / 6.5 / 6.25
6
6.75
✔

✔ /2 MP
176 x 144
✖ /✔ /✔

6.25
✔ /✖ /✔

5 / 5.75

4 / 5.5
6

6.5 / 6
5.75

5.5 / 5.75
5
6.5

LG
KG920

Rs 22,000
+ Great camera

– Bad ergonomics

55.71
26.33
22.17
7.20

Twist
Triband
240 x 320 / 2”
256K
✖ /✖

108 x 50 x 18 mm
138 gm

8 MB
✔ /miniSD

Regular
1000
✖ /✖

3 / 180 hrs
Proprietary

GPRS
Bluetooth, USB
1.2/✖

Charger, data cable, handsfree

256 MB

6.75 / 6.25
6.5 / 6.75

6.5 / 6.25 / 4
5 / 5 / 6.75
6.25
6.5
✖

✔ /5 MP
352 x 288
✔ /✔ /✔ (Strobe)
7
✔ /✖ /✔

5 / 5.5

5 / 6
6.25

5.5 / 4.75
6.25

6.75 / 6.5
6
6.25

Nokia
N95

Rs 40,249
+ Great camera, usability

– Slider quality not the best

68.52
38.84
25.75
3.94

Slider
Triband / HSDPA
240 x 320 / 2.6”
16M
✖ /✖

99 x 53 x 21 mm
120 gm

160 MB (shared)
✔ /microSD

Regular
Unlimited
✔ /✔

6.3 / 220 hrs
Symbian 9.2 (S60)

GPRS, HSCSD, EDGE, 3G
Wi-Fi, Bluetooth, IR, USB
2/✔

Charger, data cable, handsfree

128 MB

6.75 / 6.75
6.5 / 7

6.75 / 6.75 / 7
6.75 / 7.25 / 7.5
7
7
✔

✔ /5 MP
352 x 288
✔ /✔ /✔

7
✔ /✖ /✔

6.25 / 6.5

6.25 / 6.75
7

6.5/6.25
7

7.5 / 7
6.25
6.5

Nokia
N73ME

Rs 24,349
+ Good camera, sound quality

– Wierdly oblong

70.01
38.36
25.15
6.51

Bar
Triband / UMTS
240 x 320 / 2.4”
256K
✖ /✖

110 x 49 x 19 mm
116 gm

42 MB
✔ /miniSD

Regular
Unlimited
✔ /✔

3.7 / 350 hrs
Symbian 9.1 (S60)

GPRS, HSCSD, EDGE, 3G
Bluetooth, IR, USB
2/✖

Charger, data cable, handsfree

2 GB

6.75 / 6.75
NA / 7.25

6.75 / 6.75 / 5.75
6 / 6 / 7
6.5
7
✔

✔ /3.15 MP
176 x 144
✔ /✔ /✔

6.75
✔ /✖ /✔

6 / 6.5

6/6.5
7

7 / 6.25
6.5

6.5 / 6.75
6
6.5

Nokia
N80

Rs 23,019
+ High res screen

– Small screen size

65.72
34.39
24.45
6.88

Slider
Triband / UMTS
352 x 416 / 2.2”
256k
✖ /✖

95 x 50 x 26 mm
134 gm

40 MB
✔ /miniSD

Regular
Unlimited
✔ /✔

3 / 192 hrs
Symbian 9.1(S60)

GPRS, EDGE, 3G
Wi-Fi,Bluetooth, IR, USB
1.2/✖

Charger, data cable, handsfree

128 MB

6.75 / 7
6.25 / 7

6.5 / 6.75 / 6.75
6.75 / 6.75 / 6.5
6.5
6.5
✔

✔ /3 MP
176 x 144
✔ /✖ /✔

6.25
✖ /✖ /✔

6 / 6.5

6 / 6.5
7

6 / 6
6.25

6.25 / 6.25
6
6.5

Sony Ericsson
W950i

Rs 24,995
+ Great display, features

– No camera, low volume

52.90
31.28
15.29
6.34

Bar
Triband/UMTS
240 x 320 / 2.6”
256K
✔ /✖

106 x 54 x 15 mm
112 gm

4 GB
✖

Regular
Unlimited
✔ /✔

7.3 / 340 hrs
Symbian 9.1 (UIQ 3)

GPRS, EDGE, 3G
Bluetooth, IR, USB
2/✔

Charger, data cable, handsfree

NA

6.5/6
NA / 5.75

6 / 6 / 5.75
6.25 / 5.75 / 6.25
6.5
6.75
✔

✖ /NA
NA
NA / NA / NA
NA
NA / NA / NA

5 / 6

0 / 5
5.75

6.5 / 5.75
5.5

NA / NA
NA
3
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BRAND 
MODEL

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 48) 
Performance (Out of 38) 
Price Index (Out of 14) 
Physical Specs
Form Factor
Network Bands
Screen Resolution (Pixels/inches)
No of Colours (Screen)
Touchscreen/Dual-screen (✔ /N)
Dimensions (LxWxH) (mm)
Weight (grams)
Memory
Phone Memory
Expandable Memory/Type
Other Features
Keypad (Regular/QWERTY)
Address Book Capacity
Voice Recorder/Dialling
Talk Time/Standby Time *
OS
Connectivity
Browsing (GPRS/HSCSD/EDGE/3G) 
Connectivity (WiFi/Bluetooth/IR/USB)
Bluetooth Version/A2DP support
Accessories
Bundled Accessories
Memory card provided (size)
Build Quality (So 10)
Body/Keys
Flaps, Slider/Other Movable Parts
Ergonomics (So 10)
User Interface/Navagation/Joystick
Keypad Layout/Comfort/Backlight
Shortcut Key/Additional Key ergonomics
Playlist Features (So 10)
FM Radio (Y/N)
Camera Specs
Camera (Y/N)/Megapixels
Video Capture Resolution (pixels)
Lens Protection/Rear Mirror/flash (✔ /✖ )
Camera Settings (So 10)
Auto Focus/Zoom(Optical/Digital) (✔ /✖ )
Performance
Signal Reception (So 10)
Zone 1/Zone 2
Voice Clarity (So 10)
Zone 1/Zone 2
Handsfree Clarity
Multimedia Performance
Audio /Earphone Quality(So 10)
Video Playback Quality (So 10)
Captured Image Quality (So 10)
Colour/Crispness
Video Quality
Processing Speed (So 10)

Scoreboard                             Multimedia Phones Up to Rs 12,500
BenQ-Siemens

EF51

Rs 7,810
+ Very compact

– Tiny screen

56.47
25.14
18.83
12.50

Bar with flip pad
Triband
120 x 128/1.6”
256K
✖ /✖

89 x 49 x 18 mm
95 gm

20 MB
✔ /miniSD

Regular
500
✔ /✔

4/200 hrs
Proprietary

GPRS
Bluetooth, USB
1.2/N

Charger, data cable, handsfree

128 MB

7.75/7
7/6.5

5/5.5/6.25
6/6/6.25
6.5
6
✔

✔ /1.3 MP
176 x 144
✖ /✔ /✖

3.5
✖ /✖ /✔

4.5/6

4/5.5
6

5/5
4.5

4.5/4.5
3
6.5

Motorola
KRZR K1

Rs 9,520
+ Ergonomic

– Music quality

57.00
28.11
18.64
10.26

Flip
Triband
176 x 220/96 x 80/2”
256K (Both)
✖ /✔

103 x 42 x 16 mm
102 gm

20 MB
✔ /microSD

Regular
1000
✔ /✔

6/300 hrs
Proprietary

GPRS, EDGE
Bluetooth, USB
2/✔

Charger, data cable, handsfree

1 GB

7/6.75
6.75/6.25

6/6/6.75
6.5/6.75/7
6
5.5
✔

✔ /2 MP
176 x 144
✖ /✖ /✖

3.75
✖ /✖ /✔

5/5.5

4/5.5
5

5/4.75
4.75

5/4
3.75
6.5

Nokia
6300

Rs 11,489
+ Great screen, build

– Hard joystick

60.46
29.84
22.12
8.50

Bar
Triband
240 x 320/2”
16M
✖ /✖

106.4 x 43.6 x 11.7 mm
91 gm

7.8 MB
✔ /microSD

Regular
1000
✔ /✔

3.3/348 hrs
Symbian (S40)

GPRS, HSCSD, EDGE
Bluetooth, USB
2/✖

Charger, data cable, handsfree

512 MB

7.5/7.25
NA/7.25

6.5/7/6.5
7.25/6.5/7.25
5
5.25
✔

✔ /2 MP
352 x 288
✖ /✖ /✖

5
✖ /✖ /✔

5.5/6.5

6/6.25
6.25

6.25 / 5
6

4.5/4.75
4.75
6.5

LG
KE820

Rs 11,990
+ Build, form factor

– Display quality

54.74
25.82
20.78
8.14

Bar
Triband
220 x 176/2.2”
256K
✖ /✖

95 x 52 x 9.9 mm
73 gm

16 MB
✔ /microSD

Regular
1000
✖ /✖

2.2/250 hrs
Proprietary

GPRS
Bluetooth, USB
1.2/✖

Charger, data cable, handsfree

256 MB

6.75/7.5
NA/6

6.25/6.25/4.5
7.75/7.75/6.25
4.5
6
✔

✔ /2 MP
176 x 144
✖ /✔ /✔

5.5
✖ /✖ /✔

5.25/6

5/6.25
6.25

5.5/5
5

5/4.75
4.5
6.5

Samsung
SGH-E490

Rs 7,749
+ Slim

– Screen

56.31
23.79
19.92
12.60

Clamshell
Triband
176 x 220 / 2.2”
65K
✖ /✖

94 x 49 x 15.5 mm
83 gm

22 MB (shared)
✔ /microSD

Regular
1000
✔ /✔

6.5/310 hrs
Proprietary

GPRS, EDGE
Bluetooth, USB
1.2/✖

Charger, data cable, handsfree

NA

6.5/7
6.25/5.5

5/5.25/6.5
7/6.75/7.25
4.25
4.5
✖

✔ /1.3 MP
176 x 144
✖ /✖ /✖

6.25
✖ /✖ /✔

4.75/6

5.25/6.25
6

5/4.5
5

4.5/4.5
3.5
6.75
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nonetheless has the second-best camera in this entire test. Excellent colour rendition,
great clarity and crispness, with good detail mean both these phones can easily
replace a mediocre digital camera. The N73ME also has a brilliant camera, and places 
a joint third (with the K790i, not part of this category).

The N80’s camera isn’t as good as those on the other two Nokias—no auto-focus is
a big no-no for anyone even remotely interested in cell phone photography. The slid-
er on the N80 is more tactile than the one on the N95. Once again, longevity cannot
be commented on, considering our limited duration hands on with these phones.

Sony Ericsson’s W950i offers good quality music. The only problem is the poor
maximum volume levels. The N73 / N95 duo wins hand down here. The LG KG920
isn’t quite in the same league as the other phones when it comes to PMP capabilities.

Our Conclusion
The Nokia N95 is a very expensive device but also the most powerful multimedia
phone in the market right now. An excellent camera, great keypad, great music,
excellent screen, 160 MB of onboard memory, and a fast processor that runs the
inbuilt GPS application flawlessly. Our Digit Best Buy Silver award belongs here—a
topping on an already delicious treat.

Our Best Buy Gold—the N73 Music Edition—is a little
more down-to-earth, something you (and with luck, we!) can
afford. This phone has a great camera, superb music per-
formance, and a crisp, large screen.

If you want a touchscreen phone, look at SE’s W950i—
though we can’t really recommend it because of the high price
tag (Rs 24,995). The 4 GB inbuilt memory is a plus, too.

Nokia’s N80 is a classy-looking phone if you can get
past the bulk. For the same price as the N73ME, you get
Wi-Fi. You get a less capable camera and music player
in return.

LG’s KG920 has a lot of features for the price, but
it loses out on ergonomics big time. Still, it’s attrac-
tive-looking in a unique way!

Summing It All Up
We’ve noticed the sharp increase in the number of
higher-end phones—Rs 16,000 and above—in the
market. Convergence is a keyword with such
phones. It’s a pleasant surprise to see people
demanding more out of their phones. Better cam-
eras, better PMP capabilities, and all-round usabil-
ity: people have turned demanding, and more
importantly, discerning. Earlier all a vendor did
was say glibly, “This phone has FM”—done deal,
sold. Now customers want to know whether the
phone supports Wi-Fi, and whether the
Bluetooth supports A2DP. They know their MMCs
from their miniSDs! This is a trend we’re thrilled to
see emerge—may it continue! This trend has also
caused prices to fall drastically. Although MRP prices take a while to fall, it’s the
all-determining street prices that keep plummeting.

By December 2006, India was ranked among the top five cellular markets glob-
ally, behind giants like China and the US. By 2008, cell phone penetration is expect-
ed to cross the magical 50 per cent mark worldwide. India is expected to contribute
upwards of $25 billion (Rs 1,00,000 crore) as annual revenue by 2011 (current rev-
enues are around a third of that figure). The contributing factor to this growth is,
naturally, demand. Demand itself is a function of the binaries of population and
necessity on one hand, and falling service provider charges on the other. The recent
entry of Vodafone in the Indian market should also be a factor as it will, in all prob-
ability, affect international call rates. With domestic rates at an all-time low, many
people are actually opting for a second cell phone and entirely doing away with their
fixed voice lines.

The only area we’re still to see cell phones really penetrate is the data arena
where broadband is still reigning supreme, and Internet browsing is largely restrict-
ed to mail checking, downloading little themes, etc. Wi-Fi is emerging as a connec-
tivity option, but is largely restricted to airports and certain large shopping malls.
Current devices support extremely high speeds, but infrastructure is lacking. Storage
is another issue… solid-state drives promise to resolve that one, and we’re seeing 16
GB Flash modules penetrate the computer market. More please! 

michael_browne@thinkdigit.com

Nokia N73ME
The audiophile’s delight!
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Samsung
SGH-X820

Rs 10,999
+ Slim

– Build quality

53.17
24.47
19.83
8.88

Bar
Triband
220 x 176/2.2”
256K
✖ /✖

113 x 50  x 6.9 mm
66 gm

80 MB (shared)
NA

Regular
1000
✔ /✔

2.3/210 hrs
Proprietary

GPRS, EDGE
Bluetooth, USB
1.2/✖

Charger, data cable, handsfree

NA

6.75/6.5
NA/6

5/5.25/6
7/6.5/7
4
4.5
✖

✔ /2 MP
176 x 144
✖ /✖ /✖

6.25
✖ /✖ /✔

5/5.5

4.75/6
6

5/4.5
5

5/5
4
6.75

Samsung
SGH-E840

Rs 10,700
+ Great build, slider

– Keypad tactility

60.34
29.77
21.44
9.12

Slider
Triband
240 x 320/2.2”
256K
✖ /✖

101.5 x 52.5 x 10.6 mm
83 gm

70 MB
✔ /microSD

Regular
1000
✔ /✔

3.3/250 hrs
Proprietary

GPRS, EDGE
Bluetooth, USB
2/✔

Charger, data cable, handsfree

128 MB

6.75/6.5
7.25/6.5

6/6/6
7/6.75 /7
4
5
✔

✔ /2 MP
176 x 144
✔ /✔ /✖

5.5
✖ /✖ /✔

5.25/6.25

5.5/6.25
6.25

5/5.5
5.5

5.25/5.5
4.5
6.75
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Intel’s new P35 chipset
(code-named Bearlake)
marks the launch of yet

another milestone for
Desktop computing, namely
DDR3 memory.  Though the
chipset supports DDR3, in
the initial phase,
motherboards will be
offered with DDR2 memory
to streamline the transition
to DDR3. Memory speed
apart, the new chipset
ushers in support for the
new, yet-to-be-launched
Penryn processors (45nm at
1333 MHz FSB).  

In this round-up, we have
four motherboards: the
ASUS P5K Deluxe, MSI
Platinum, Gigabyte GA-P35-
DQ6, and the Foxconn P35A.
The former three are geared
towards enthusiasts (read:
bells and whistles attached).

Features
All four motherboards use
the ATX form factor, and
hence demand a full ATX
cabinet. And all of them
have taken to silent cooling.
The MSI Platinum has oodles
of copper pipes running
around the Northbridge,
with fins to

increase surface area. ASUS
has its own implementation;
Gigabyte goes a step forward
and includes a back plate to
cool the PCB. These
substantial coolers will
impede installation of a
larger heatsink-fan combo
for the processor.

The same pipes run
towards the Southbridge,
terminating into either a
copper heatsink with fins
(Gigabyte, MSI) or without
them (ASUS). The Foxconn
motherboard hasn’t gone
with silent cooling—this is
their P35 for the masses.

The placement of the 24-
pin ATX connector is spot-on
on the ASUS and the
Foxconn boards, but the
dense heat pipes on the
Gigabyte and the MSI hinder
easy installation of the ATX
connector. On all the boards,
extra power is available via a
four-pin Molex connector.

The memory slots on the
ASUS and Foxconn don’t
interfere with the graphics
card. Sadly, Gigabyte and
MSI miss the mark by a few
inches; the Corsair
Dominator (as will any
memory with a bulky heat
spreader) comes dangerously

close to the graphics card’s
PCB. And with the MSI
and ASUS, a long

graphics card will run over
the SATA ports.

Gigabyte’s DQ6’s Front
Panel Audio gets trapped in
between the back panel I/O
ports and the thermal pipe
solution, so Gigabyte
implements a pin-raiser for
easy access to it. The USB
extension headers are placed
at the bottom of all the
boards, with ASUS and
Foxconn using plastic
brackets for trouble-free
installation. 

Gigabyte implements
three PCIe x1 slots, whereas
the ASUS P5K Deluxe and
MSI P35 Platinum have two.
The Foxconn provides just
one. ASUS and Foxconn
implement three PCI slots;
MSI and Gigabyte, two each.

The ASUS lacks a PS2
port and alongwith P35
Platinum both of them have
six USB, one FireWire, and
two eSATA ports. The
Foxconn P35A and Gigabyte
GA-P35-DQ6 both provide
four USB ports. The Foxconn
also has an eSATA port.

All the boards have 8-
channel audio; the ASUS P5K
Deluxe and the Gigabyte GA-
P35-DQ6 have multi-
streamed audio, a
technology that allows
separate signals to be sent to
the rear speaker connectors

and headphones, separating
background audio streams
from communications
applications.

Power And The BIOS
Gigabyte has opted for a 
12-phase power design—
supposedly good for
overclocking. ASUS offers 
8-phase power, which should
be good enough for driving
the CPU to crazy overclocks.
The Foxconn P35A and MSI
P35 Platinum use a simpler,
4-phase power—no problems
for stock systems, but could
limit the CPU’s overclocking
potential.

Though 1066 MHz DDR2
RAM is supported on all
boards, the Foxconn and
MSI required adjustment to
run the Corsair Dominator
at 1066 MHz.

The ASUS has a feature-
rich BIOS with controls for
the North / Southbridge
voltage, and also for the CPU
Damper, Transaction
Booster, and Clock Over-
Charging Mode.

The Gigabyte C.I.A 2 has
five preset overclocking
profiles, whereas the ASUS
provides two user-
configurable overclocking
profiles. All the boards come
with utilities for

Intel P35 Motherboards: ASUS P5K Deluxe / Foxconn P35A / Gigabyte
GA-P35-DQ6 / MSI P35 Platinum
Bearlake 4 under the scanner

Bazaar

ASUS P5K Deluxe
Rs 14,750

Wi-Fi antenna with magnetic base

8 Diagnostic LED’s: Easy Diagnosis of
boot-up failures.

MSI P35 Platinum
Rs 13,000

Bazaar We test the latest hardware 
and software products available 
in the market
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overclocking through
Windows, as also a utility to
update the BIOS.

The ASUS and Gigabyte
provide crash-free BIOSes.
The MSI P35 Platinum has
eight diagnostic LEDs and a
BIOS reset switch—just in
case. The Foxconn P35A
provides onboard power and
reset switches for fine-tuning
the system before fitting.

Performance 
Testing the boards resulted
in mixed scores with only
tiny differences. In PC Mark
05, a score of 7327 by the
ASUS P5K Deluxe left the MSI 
P35 Platinum just behind at
7326. The Gigabyte GA-P35-
DQ6 scored 10818 in 3D Mark
06, while ASUS P5K Deluxe 

ran a score of 10813; the
10814 by the Foxconn P35A
in 3D Mark 06 fetched it
second position. In the
SiSoft Processor Arithmetic
and Multimedia test, the
P5K Deluxe took the lead,
while the Foxconn P35A a
close second.

We used Corsair
Dominator memory at 1066
MHz for our tests—no
problems here. The Right
Mark Memory Analyzer put
the Gigabyte GA-P35-DQ6
ahead with a latency of
28.94 and a bandwidth of
4562.43.

The Asus P5K Deluxe
was neck-to-neck with the
Gigabyte, but lagged behind
in the latency test with a
score of 31.77 against the
28.94 of the GA-P35-DQ6.
The ASUS P5K Deluxe
completed Wprime in
32.859 seconds, followed by

Gigabyte at 32.937; in Super
Pi, both scored 18.797
seconds.

In the gaming
benchmarks, the Asus P5K
Deluxe churned out 128.8
fps in Company of Heroes, the
Gigabyte came in just
behind with 128.1. The MSI
P35 Platinum and Foxconn
P35A clock 127.9 and 126.5
fps respectively.

The Foxconn P35A
managed a score of 59.4
MBps in the Average Read
test with a Random Access
time of 64 ms in HD Tach.
The Asus P5K Deluxe
followed closely, but we saw
a burst speed of 133.7 MBps.
None of the boards really
had a clear lead.

The Bundle
ASUS packs in a great
bundle, with Wi-Fi and
dual Gigabit LAN. The Q-
Connector from ASUS
simplifies installation of
the chassis front panel
connector by providing a
pluggable, labelled
connector.

The Foxconn P35A
includes an SLI bridge in
the package. The Gigabyte
provides 4 eSATA 2
extensions along with

external power Molex for
faster peripheral data
transfer. All the boards
come with a single
FireWire port and SPDIF
out (Sony/Philips Digital
Interconnect Format) ;
drivers for XP and Vista
come bundled.

Our Conclusion
ASUS’ new P5K Deluxe
doesn’t disappoint.
Combining fabulous
features, great
overclocking potential, and
superb performance, this
new board is still
reasonably priced.  

The Gigabyte GA-P35-DQ6
is crafted beautifully, with
superb on-paper specs, and it
delivers—but at Rs 18,000,
it’s a little too expensive.

The MSI Platinum P35 is
a good motherboard,
especially by virtue of its
pricing. Extensive (ab)use of
copper for silent cooling
and some component
placement issues mar an
otherwise great product.

The Foxconn P35A is an
excellent product, but the
over-the-head pricing is
something Foxconn should
consider revising.

Testing a newly-launched
motherboard is a nightmare mostly
because of memory compatibility
issues; this is something we faced,
and you’ll face them too—till new
BIOSes are introduced, of course. 

Luckily, Corsair’s Dominator memory worked flawlessly,
and we recommend these if you plan to buy any

of these motherboards. These memory
modules are SPD programmed for 5-5-5-18

timings at 800 MHz, and do 5-5-5-15-2T at
1066MHz 2.2V. The 2 GB Dominator kit is a matched
pair of 1 GB DDR2 memory modules—best used in dual-
channel configuration.

Corssair Dominator XMS2
2GB DDR2 Kit 1066MHz 2x1024 PhoneCompany E-mailBrand

Contact Sheet

ASUS 
Foxconn
Gigabyte
MSI 

ASUS Technology Pvt Ltd
Jupiter Infotech
Gigabyte Technology India Ltd
Micro Star International 

022-67668800
033-22121406
022-30616666
011-41758808/09

www.in.asus.com
info@jil-jupiter.com 
prashanta@gigabyte.in
sanyam@msi-india.com 

OnBoard Power and Reset switch:
Benchtester Friendly

Foxconn P35A
Rs 15,000

Gigabyte P35-DQ6
Rs 18,900

Crazy Cool: enhances Heat 
desipation on rear side of Motherboard 
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With a design similar to
that of the ultra-sexy

Bordeaux series we reviewed
earlier, the 19-inch 932B is
all curves. Monitors just can’t
go wrong with piano black!

Build quality is
excellent, and the curvy
body is definitely a relief
from all the monitors we’ve
seen in recent days. The
stand tries to keep up with
aesthetics but could use a
little more creativity in
that direction.

The menu buttons are
underneath the bottom
bezel—good looks, but they
come at the cost of usability.

The 932B uses a TN
panel, with decent on-paper
specifications—a 700:1
contrast ratio and a
brightness of 300 cd/m2. A
response time of 5 ms is
good enough for most
applications.

Our DisplayMate tests
showed good screen pixel
resolution. Colour

separation was good, and
the 932S did well with
the primary colours. All
this means the 932S is
good for working with
applications that use a
lot of colour.

In our game tests,
F.E.A.R. looked crisp: good
contrast, and good colour
and detailing. Ditto
Oblivion. Movie playback
was also good—great
colours. Our only grouse
is that it’s not
widescreen.

Specifications
Contrast ratio: TN panel,
3000:1 (700:1 actual);
lumens: 300 cd/m2; 19-inch
TFT; native resolution 1280 x
1024; response time: 5 ms.

Samsung SyncMaster 932B 
Black and lovin’ it

Contact: Samsung India Electronics
Pvt. Ltd.
Phone: 011-41511234
E-mail: rengith.nair@samsung.com
Web site: www.samsungindia.com
Price: Rs 19,000

Performance  
Features
Build Quality
Value for Money
Overall 

RATINGS

This is an ADSL modem,
four-port router, and

wireless access point all in
one—just what you need to
share an Internet
connection on your home
network. A firmware
upgrade gives it ADSL2/2+
compliance as well. 

It supports enhanced
wireless security using WPA
and WEP. The integrated
firewall has NAT and SPI
capabilities, and can ably
handle DoS attacks. URL and
domain blocking is

supported, too. Also
featured is the inbuilt IPSec
VPN with DES, 3DES and
AES encryption.

Wi-Fi speeds are blazing
fast. The device transferred a
sequential file at 2.5 MB/s in
the closest zone, while
managing 1.19 in the

farthest zone, making it at
least 50 per cent faster than
its closest competitors, the
Netgear DG834G and the D-
Link DSL-2640T.

If you are setting up a
home network, this is a
must-buy.

Specifications
ADSL compliant (ADSL2 via
firmware upgrade); ports: 1 x
ADSL RJ-11 for 24/26 AWG
twisted-pair telephone wire; 4
x 10/100 LAN RJ-45; PS/2; Wi-
Fi standard: 802.11b/g;

cables: CAT-5 UTP Ethernet,
RJ-11 (telephone), PS2/RS-232

Performance  
Features
Ease of Use
Value for Money
Overall 

RATINGS

The 5 MegaPixel Canon
PowerShot A460 is out

to make a point that you
don’t need to have an
expensive digital camera to
take good shots. While a bit
bulky, the A460 still looks
OK. You can choose from
five modes for different
types of photo and video
shooting and previewing.

The custom timer lets
you choose the timing and
the number of the shots to
be taken. The Slow Synchro
synchronises the flash with
slower shutter speeds to
effectively prevent

background
blackouts
while using
the flash.

The
quality of the
photos is
pretty good—not
too vibrant or
enhanced, but some purple

fringing can be seen
along bright edges.

Movie recording
performance is pretty
appalling with just 10 fps at
640 x 480.

One irritant is that the
camera must be switched to
Playback mode to transfer
images. ZoomBrowser EX, a
plain-looking bundled

software, enables the camera
to send images to a PC at a
press of a button.

You get a set of batteries
but no charger. The camera
is well priced at Rs 9,795. It’s
an easy camera and good for
beginners, and will allow you
to take some impressive
shots as well.

Specifications
5 megapixel; 4x optical zoom;
aperture: f/2.8—f/5.8; ISO
levels: 80—400; shutter
speed: 15—1/2000 second

Canon PowerShot A460 
A well-priced entry-level cam

Performance  
Features
Build Quality
Value for Money
Overall 

RATINGS

Contact: Canon India Pvt Ltd
Phone: 1800-345-33-66
E-mail: info@canon.co.in
Web site: www.canon.co.in
Price: Rs 9,795

Billion BIPAC 7402G 802.11g ADSL2+ VPN Firewall Router
Your broadband facilitator

Contact: One Network (India) Pvt Ltd
Phone: 022-26056300
E-mail: sales@onenetwork.co.in
Web site: www.billion.com
Price: Rs 9,500
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The VU Boss is a small
form factor PC that

targets the growing trend
of small and slim in the
lifestyle segment of
Desktop computing.

This PC is tiffin-box-
sized. The wireless RF
keyboard incorporates a
tracker ball and is the sole
input device. The ball is
placed on the right, with the
click buttons on the left—
these allow for free use of
the keyboard in your palms.

The 22-inch widescreen
LCD panel makes the VU
Boss a pleasure of a
computing experience. On
a sour note, accessing the
power switch on the box
becomes a tricky thing
when it’s behind the LCD.
In a cold start scenario, the
power switch on the
keyboard just doesn’t work,
making one depend on the

main
power
switch
on VU—
difficult
to get to
if the box is
hooked
behind the 22-
inch panel.

The LCD
panel’s base
is sturdy,
but there’s
no swirl—not a good thing
for a big screen. The
integrated 2 W stereo
speakers in the LCD panel
just manages to get the job
done! The S-Video/DVI out
ports being on the back
panel of the VU PC beside
the AV/TV in ports makes
hooking up to a TV
straightforward job: this is a
viable idea for a media
centre PC.

Taking the box apart
reveals the Intel Mobile
class Core Duo T2350
(1866 MHz) processor
running on the Intel
i945GM chipset. The
integrated INTEL GMA
950 graphics solution
manages a score of 396
in 3D Mark 05—decent
for a machine of this
form factor.

The PC Mark 05 score of
2985 reflects average
processing power. The VU
PC is pre-loaded with
Windows XP Professional,

and with 512 MB of RAM,
performance is good
enough for word
processing, surfing, and
other everyday computing
staples. The optical drive is
a smooth-operating slide-in
Matshita DVD-ROM.

Rs 65,000 for the VU
Boss doesn’t make too
much sense in terms of
value. But if you have a
really cramped desk and

are looking for a space-
saving Desktop—
besides a 22-inch

widescreen—the VU
Boss might prove worth it.

Specifications
Intel Core Duo T2350 mobile
processor; Intel i945GM chipset;
512 MB DDR2 RAM; Matshita
DVD-ROM; 80 GB HDD; 22-inch
widescreen LCD panel

Contact: Vu Technologies Pvt Ltd
Phone: 26450224 / 26452727
Email: info@technologies.vu
Web site: www.technologies.vu
Price: Rs 65,000

VU Boss
Dinky Desktop Power

The Intel XScale-based
N4100 NAS (Network

Attached Storage) server by
Thecus is an excellent
answer to your data
sharing, storage, and
backup needs. Less than
half the size of a regular PC
cabinet, the N4100 is stur-
dily built. It has four drive
caddies that can hold a 500
GB SATA hard drive each,
thus touching 2 TB.

Installing drives is a
cinch; thanks to the preci-
sion rail mechanism, the
drive gets neatly engaged
with the SATA connectors
inside—no cables involved.
The activity LEDs indicate
drive status. Bearing no
resemblance to boring file
servers, it is, in fact, very
presentable, and you
wouldn’t mind letting it
adorn your desktop!

The CD guides you
through the process of ini-
tialising the server, and
also lets you configure the

hard drives in RAID 0, 1,
JBOD, or even RAID 5 arrays
if you give data security top
priority. The easy-to-use
browser interface also
allows you to set up the
N4100 as an FTP, iTunes,
file, print, or a backup
server, and lets you create
shared folders, with user
and group access rights.

If a drive fails, Hot PnP
lets you remove it on the
fly and replace it with a
new one, and the server
won’t be down at all. The
RAID array starts getting
rebuilt as soon as the hard
drive is replaced, or even
when a new drive is added.
Alarms sound when one of
the drives fails, and an e-

mail alert is
sent to the
system
admin.

It takes
just over two
minutes to
transfer a
1 GB
file to
the
N4100—good
enough. The
only problem here
is inadequate ventila-
tion, even with the 80 mm
fan at the back.

In addition to the setup
program, the accompa-
nying CD contains a
backup utility.

Unfortunately, the
N4100 will set you back by a
good Rs 37,500, which will
put it out of reach of most
SoHos. And yes, we must
remind you that the N4100
does not come with any
hard drives.

Specifications
CPU: Intel IOP; SATA controller:
Intel (supports Hot PnP);
memory: 128 MB DDR; Flash

memory:
16 MB; interfaces:

2 x Gigabit ports, 2 x USB
2.0 ports; RAID levels: 0, 1, 5,
JBOD; 4 x SATA drive bays;
maximum capacity: 2 TB (4 x
500 GB); dimensions: 167 x
199 x 223 mm (W x H x D);
power supply: 200 W; client
platforms: Windows
98/ME/NT/2000/XP,
UNIX/Linux/BSD (by CIFS),
Apple OS X (AFP)

Thecus N4100 
Stack your data!

Contact: Apical Impex Pvt Ltd
Phone: +919821349177
E-mail: tejas@apical.in
Web site: www.apical.in
Price: Rs 37,500 
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Build Quality
Value for Money
Overall 
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Here’s a utility that
claims it has the

features to make file
handling and disk
exploring much simpler
and less repetitive than
with Windows Explorer. 

When the program is
first run, you are informed
about some plugins that
might be required to display
information on formats
such as PDF and MP3.
Unlike the classic Windows
Explorer view where you
have two panes, xplorer²
gives you three, which
means more flexibility. You
do have the option to revert
to two panes.

The interface, like in
Windows Explorer, is
modular, so you can disable
toolbars you don’t need.
xplorer² keeps track of all
the locations you’ve been
visiting, and you can easily

jump back to any of them
with two clicks. Filters are
implemented in the
program, so you can choose
to only view files of a
certain format, such as
Excel spreadsheets. If you
find any files interesting
and want to access them
later, you can do so by
dragging and dropping
them into a temporary
location called a scrap
container, which creates
within it links to those files.

Other features include
file and folder comparison,
and the option to collapse
all folders so only the files

from all the subdirectories
are listed together. For
example, if you have
separate folders full of
images, xplorer² will let
you view all the images as
if they were in one big
folder. A feature called
Sticky Selection lets you
click all the files you want
to select without having to
hold down the [Ctrl] or
[Shift] keys. Quick
Viewer is a panel that
allows you to view the
contents of a file without
having to open it. Data
transfer rates are displayed

during copying and
moving as well.

Memory consumption
is very low, at around 500
to 700 KB when minimised
and around 3 MB when
maximised.

We can sum up xplorer²
as being Windows Explorer
on steroids. It is priced at
$29.95 (Rs 1,350), which
might be worth it if you’re
willing to make the jump
considering it will take
some time to get used to it.

xplorer² 1.6.5.3 
A cool replacement for Explorer

Web site: www.zabkat.com
Price: $29.95 (Rs 1,350)

Adobe has been well-
known mostly for

Photoshop. CorelDraw and
later Jasc Software’s Paint
Shop Pro were competition
back then. Jasc was taken
over by Corel, and Paint
Shop Pro has been
developed by Corel ever
since. We put Corel’s latest
release of Paint Shop Pro
Photo—version XI—to the
test to see if the “Photo” tag
at the end of the name has
any substance to it.

The interface is pretty
cluttered with toolbars,
organisers, and help panels,
leaving little space to
actually work on. It’s a good
thing you can turn them
off. There are tons of
features, but we didn’t
really find a lot specifically
made for photograph
manipulation. Skin
smoothing, red-eye removal,
and digital camera noise
removal were some that
would be useful for
photographers. A button
called “Enhance Photo”

brings in additional
features that find the best
parameters for a photo. 

We found traces of
features from other Corel
products—Painter, for
example. Paint Shop Pro
Photo has a mixer that lets
you add certain amounts of
colours and mix them about
till you get the right shade.
Another feature is the option
to choose the texture of the
canvas when you create a
new image.

The software isn’t much
of a memory hog, unlike
some image editing tools
where memory
consumption goes well over
three digits in megabytes.
The software peaked out at
a moderate 77 MB of RAM
with four images open and
some effects in place.

The Windows help
documentation explains all
of Paint Shop Pro Photo’s
features with screenshots as
well as the icons you find in
the interface. The learning
bar explains features and

also gets tasks done in quick
steps without you having to
go through multiple menus
and windows.

If you need a software
specifically for photo

manipulation, Adobe’s
Lightroom is the better
choice. Paint Shop Pro
Photo seems more like a
contemporary of Photoshop.
The price is $89.99—less
than half that of
Lightroom—and could be
well worth it if you want
something that can tweak
photos and also edit images.

Web site: www.corel.com
Price : Rs $89.99 (Rs 3,600)

Performance  
Features
Ease of Use
Value for Money
Overall 

RATINGS

RATINGS

Corel Paint Shop Pro Photo XI
Some of this, some of that

Performance  
Features
Ease of Use
Value for Money
Overall
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The ZoneAlarm Security
Suite is a lot more than

just a personal firewall.
But at first look, we
weren’t too impressed.
ZoneAlarm has lost the
friendly look most people
are used to. Instead, a
fairly bland colour scheme
with equally tasteless icons
and indicators make up
the interface.

The firewall and anti-
virus form a comparatively
smaller portion of the
features. There’s a spyware
scanner to accompany the
anti-virus engine. Other
than that, the e-mail
protection can be set to scan
all incoming and outgoing
mails. The junk mail feature
is pretty advanced, we
think: it features a large
number of parameters.

Then there’s the parental
control feature: parents can
now choose from a long list
of categories to be blocked. A
very useful feature is Game
Mode, which ensures you

aren’t interrupted in
between gaming sessions by
alert pop-ups. The Privacy
component takes care of all
ads and cookie blocking.

IM Security is another
feature that ensures
security isn’t compromised
through instant
messengers—AOL, ICQ,
MSN, and Yahoo!.
Conversations can be
encrypted, but both users
need to install the suite.

There are slider bars in
each of the suite’s
components; these help in
easily switching strictness
levels. Similarly, most of
the features have an
Advanced view, which lets
you make precise changes
to the rules. In addition,

you can use the Backup
and Restore Security
Settings feature to save and
load settings.

The suite ran well in our
test, without creating any
problems on our Athlon 64
3800+ with 1 GB of RAM.
Memory consumption was
around 45 MB most of the
time, but the CPU
utilisation shot all the way
up to 90% while scanning
for viruses.

It’s pretty rare to find a

suite such as this with as
many features and
functionality. At $49.95 (Rs
2,000), ZoneAlarm Security
Suite is a wee bit overpriced.

It’s interesting to note
that ZoneAlarm’s image as
the friendly, casual-user’s
firewall has now been
replaced by one of the no-
nonsense system protector.

ZoneAlarm Security Suite 
Ultra-protective

Web site: www.zonealarm.com
Price: $49.95 (~Rs 2,000)

Productivity tools are
software that can help

make work and planning
easier and more efficient.
XMIND is a mind-mapping
software that runs on Java,
and we’ve told you in an
earlier issue how mind-
mapping software can help
increase productivity.
We’re assuming you know
a little about such
software. Mind mapping
software can be a tiny bit
confusing to start with,
and XMIND is no different
in this respect.

The interface, to its
credit, looks pretty clean
and well-laid-out. There are
five templates to suit your
style and the feel of your
work, other than the
default template.

Elements such as
shapes, lines, and
boundaries are pretty well-

designed, and go well with
the templates. You can add
external templates to the
current list. Using the
software is pretty
straightforward, and the
shortcuts are easy to
remember and well-placed.
It appears all the shortcuts
used in the program can
be changed to those of
your choice.

When you are done with
your work, you can export
it to PDF, image formats, a
PowerPoint presentation, or
a Word file.

The help provided is
quite detailed. There are
screenshots where you
need them. A feature called
Dynamic Help provides
quick help in a sidebar
whenever you click on a
particular tool or feature. 

Although this software
runs on Java, it doesn’t feel

too heavy, but uses over 120
MB of memory!

There doesn’t seem to
be a lot wrong with XMIND
other than the price. At
$100 for a single license,

it’s quite a bit to ask for a
software like this. There
are alternatives: FreeMind,
for example, is a free, open
source program that can
do more or less what
XMIND does! The only
reason you would want to
go buy this software is
perhaps for its fairly
refined look and feel.

XMIND 2007 
Extend your mind

Web site: www.xmind.org
Price: $100 (~Rs 4,000)
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Ease of Use
Value for Money
Overall 
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Wi-Fi Access Points
Linksys WAP54G

Great performance
None in particular

Contact Ingram Micro India Pvt Ltd
Phone 9323112279
E-mail sunil.z@ingrammicro.co.in
Price Rs 3,816

5.1 Speaker Sets
Artis S6600R/FM

Good performance, radio
None in particular 

Contact Kunhar Peripherals Pvt Ltd
Phone 022-66345758
E-mail mail@kunhar.com
Price Rs 8,500

Processors
Intel QX6700 Core 2 Extreme

Extreme performance
Expensive
Contact Intel Corporation
Phone 080-25075000
E-mail saranya.rustagi@intel.com
Price Rs 52,000

Projectors
Acer PD726W

Great overall performance
No remote sensor at rear

Contact Acer India Pvt Ltd
Phone 9880544226
E-mail alankar_s@acer.co.in
Price Rs 1,50,000

Digital Cameras
(High-End)
Sony Cybershot W50

Excellent image quality,
vibrant colours
Trouble focusing in low light
Contact Macro Photo
Phone 022-22618639
E-mail macro.photo@gmail.com
Price Rs 15,000

Flash Drives
Transcend JetFlash 150 1 GB

Fast
Poor package bundle

Contact Mediaman Infotech Pvt
Ltd

Phone 022-23828100 
E-mail santosh@

mediamangroup.com  
Price Rs 1,500

LCD Monitors (19-inch)
AOC 197S

Good looks and performance
Gloss finish catches smudges

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 12,000

LCD Monitors (17-inch)
AOC 177V

Good performance
None in particular

Contact AOC India
Phone 1800 425 4318
E-mail info@in.aocmonitor.com
Price Rs 9,800

MP3 Players up to Rs 4,000
MobiBlu DAH-2100

Good performer
Tiny screen for video

Contact J.J.Mehta & Sons
Phone 022-24306356
E-mail   info@jjmehta.com
Price Rs 4,000

MP3 Players up to Rs 10,000
Sandisk Sansa e250

Good performance, 
feature-rich
Tacky scroll wheel

Contact Rashi Peripherals Pvt Ltd
Phone 022-67090909
E-mail navinderc@

rptechindia.com
Price Rs 8,150

Internal DVD-Writers
Lite-On LH-20A1P

Fast performance, 20x 
writing to DVD+R and DVD-R 
None in particular

ContactMediatech India
Distribution Pvt Ltd

Phone 022-26361111
E-mail digit@ 

mediatechindia.com
Price Rs 2,095

Internal SATA Hard Drives
WD Caviar SE16 WD5000AAKS

Fast transfer speeds
None in particular

Contact Champion Computers 
Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 7,500

Graphics Cards (High-End) 
NVIDIA GeForce 8800 GTX

Blistering-fast
Runs slightly hot
CCoonnttaacctt Rashi Peripherals Pvt Ltd
PPhhoonnee 022-67090810
EE--mmaaiill navinderc@

rptechindia.com
PPrriiccee Rs 41,000 + taxes

Graphics Cards (Mid-range) 
XFX 8600GTS

Best of the mid-range cards
Could do with more memory
CCoonnttaacctt Rashi Peripherals
PPhhoonnee 022-67090909
EE--mmaaiill navinderc@

rptechindia.com
PPrriiccee Rs 16,000

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular
Contact Champion Computers 

Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 6,500

Internal SATA Hard Drives
WD Caviar SE16 WD3200AAKS

Value for money, 
performance
None in particular

Contact Champion Computers 
Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 4,500

The best products tested so far in different 
hardware and software categoriesThe A-List
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Multimedia Phones
Rs 12,501 to Rs 20,000
Sony Ericsson CyberShot K790i

Great all round
Cam slider flimsy
Contact Sony Ericsson Mobile 

Comm. India Pvt Ltd
Web site www.sonyericsson.com
Price Rs 16,222

Up to 12,500
Nokia 6300

Great screen, build
Hard joystick

Contact Nokia India
Web site www.nokia.com
Price Rs 11,489

Intel High-end Motherboards
Foxconn 975X7AB-8EKRS2H

Inexpensive, good performer
None in particular

Contact Mediatech India 
Distribution Pvt Ltd

Phone 022-26361111
E-mail info@mediatechindia.com
Price Rs 10,750

Intel Mid-range Motherboards
Gigabyte GA-965P-DQ6

Good build quality and 
performance
Expensive 

Contact GIGABYTE Technology 
India Ltd

Phone 022-26526696
E-mail sales@gigabyte.in  
Price Rs 16,000

AMD AM2 Motherboards
ASUS Crosshair AM2

Great bundle and performance;
accessories for the enthusiast
None in particular

Contact ASUSTeK Computer Inc
Phone 022-40058888 
E-mail media_india@asus.com
Price Rs 15,400

AMD 939 Motherboards
ASUS A8R MVP

Good performance
Skimpy bundle 

Contact ASUSTeK Computer Inc
Phone 022-40058888 
E-mail media_india@asus.com
Price Rs 8,700

Home Inkjet MFDs
Canon PIXMA MP160

Good performance
No memory card reader 

Contact Canon India Pvt Ltd
Phone 1800-345-33-66
E-mail info@canon.co.in
Price Rs 5,999

Office Inkjet MFDs
HP Photosmart C4188 All-in-One

Good print quality
No fax

Contact HP India Sales Pvt. Ltd.
Phone 0124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix (India)
Pvt Ltd

Phone 044-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Mono Laser Printers
HP LaserJet 1020

Good combination of speed,   
print quality, and warranty
A bit slow in comparison to
others

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone 0124-2566111
E-mail kakuni.mahto@hp.com  
Price Rs 6,999

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone 022-26571160
E-mail response@logitech.com
Price Rs 8,000

Performance Laptops
HP DV6226tx

Funky Looker, features 
Needs better graphics

Contact Hewlett-Packard India
Phone 0124-2838700
E-mail tapoti-t.tipnis@hp.com
Price Rs 56,990

73

Up to 12,500
Samsung SGH-E840

Great build, slider
Keypad tactility

Contact Samsung Telecomm.
India

Web site in.samsungmobile.com  
Price Rs 10,700

PDA Phones Above Rs.25K
Nokia Communicator E90

Extremely powerful
Heavy, bulky

Contact Nokia India 
Web site: www.nokia.com
Price Rs 40,499

Mono Laser MFDs
Samsung SCX-4521F

Good performance and
quality
Low input tray capacity 

Contact Samsung India
Electronics Pvt Ltd 

Phone 011-26431313
E-mail vikram.negi@

samsung.com
Price Rs 21,990

PC Webcams
Tech-Com SSD-641-MP

Good image quality; 
inexpensive
No software bundle; 
poor build quality

Contact Shree Sagarmatha Dist 
India Pvt Ltd

Phone 011-26428541
E-mail contact@

techcomin-india.com
Price Rs 549
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Forget Passwords and you will be
asked for the password henceforth.

Set Mails As Tasks
Many times, mails can be related

to a task you have to keep in mind; you
can set a mail to be a task so you can
be reminded easily. Right-click on any
mail and select Convert to Task. If
you switch to the Tasks section from
the left panel you will find the mail
there. You can double-click on it to
set a start and end date, and add
any additional summary you might
want to.

Disabling Plugins 
Evolution’s features come from

plugins, so it’s pretty easy to turn on
and off features when you want to.
Most of us don’t use all of them anyway.
In Evolution, turn off plugins under

Edit > Plug-ins. Uncheck the box
against the features you don’t use. This
will save memory consumption and also
speed up loading times a bit.

Setting Time Zones In Tasks 
You might have contacts not based

in India. While creating tasks or
appointments for such contacts, you

need to keep their time zones in mind. 
Create a new task by selecting New

> Task. Enter all the necessary details
and click on Time Zone on the toolbar.
Select the time zone of the location of
the person you have the appointment
with. Click OK. Evolution will
automatically adjust the time to match
your current time zone. This feature can
also be found in other components like
Meeting and Appointments.

Image Loading Preferences 
Most mail clients block access to

images through mails hosted on the
Internet—mostly for security reasons.
Evolution does this, but if you want to
be able to view these images, select Edit
> Preferences. Select Mail
Preferences in the left pane and then
the HTML Mail tab on top. Here you
have the option to either enable or
disable images from sites altogether.

Another useful option is to allow access
to images from sites only for mails from
people in your contacts list.

Importing Contacts From Gaim
Evolution has a feature that allows

you to create entries in the address
book from contacts in Gaim (now

Pidgin), the instant messenger. This is
really useful to add many known
contacts, in an instant, into your mail
client instead of manually entering
each entry.

Go to Edit > Preferences >
Mail Preferences tab >
Automatic Contacts. In the
Instant Messaging Contacts
section, click Synchronize with
Buddy List Now to add your
contacts. Check the box against
Periodically synchronize
contact information and
images from Gaim list to
update Evolution with the new changes
in Gaim.

EVOLUTION
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Evolution is probably the most
preferred mail client in Linux, and
for that reason, comes bundled

with most distributions today. Other
than being a feature-filled mail client,
it’s also a good PIM. We look at how you
can make a few daily activities easier
using Evolution.

Forget Passwords
There are times when there are

many people using your PC—you wouldn’t
want them to access or download your
mail by mistake (or intentionally, in the
case that you have friends of the
snooping type). In such cases, you can
make Evolution forget the passwords it
has saved. To do this, go to File >

Illustrations Harsho Mohan Chattoraj

Disable plugins to save on system resources

Images from sites can be blocked or
unblocked

Gaim contacts can be quickly added and syn-
chronised into Evolution
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Word processing software for
Linux is in fair abundance; not
so for spreadsheet applications.

OpenOffice Calc is the heavyweight in
this category, and is the preferred Linux
equivalent of Microsoft’s Excel.

Tracking Changes 
If you changed a cell’s value, and

made twenty more changes to different
cells before deciding that you wanted the
first cell’s original value, you’d have undo
all twenty steps to get it back. A better
option is to track all the changes made to
your spreadsheet.

Go to Edit > Changes > Record.
From now on, all changes made to cells
will be tracked. Modified cells from will
be shown with a red border; move
the mouse over a cell to see its
previous value. 

Customising The Interface For
A Single Spreadsheet

Calc lets you customise its layout for a
single spreadsheet only, leaving the
default for other sheets. 

Select Tools > Customize.
Choose the toolbars you want to disable
or change the order of. You can do the
same for all the toolbars in OpenOffice
Calc. Now to bind the customisations to
only the file you are working on, click
Save in the drop-down menu, and
choose the file. Click OK to save.

Macros For Events 
Macros in OpenOffice can be

bound to events as well, so you can have
a macro to run the moment you open a
file, for example. 

Click on Tools > Customize.
Then click on the Events tab. Choose the
even that you want to bind the macro to.
Click the Macro button. From the
library, select the macro you want and
click OK. 

Styles And Conditional
Formatting 

Conditional Formatting automatically
formats cells matching criteria you set,
as you might know.

First create some unique styles if
you don’t like the ones provided by
OpenOffice. Select Format > Styles
and Formatting. Right-click in the
window and click New. Enter a name for
the style and use the tabs Fonts, Font
Effects, Borders, etc.—to create your
own style. You can use this style on any
cell from the toolbars.

Now to set up conditional
formatting. Select Format >

Conditional Formatting. Set the
values for the conditions—equal to, less
than, and so on—and select the Cell Style
using the drop-down menu. Your custom
style will be present as well. When done,
click OK. All the cells matching the
criteria should then appear in the style
you created.

The Function Wizard 
Some of us might have knowledge

of a fair number of functions for Calc,
but not all. The entire list of functions
can be viewed using the Function
Wizard. Select Insert > Function or
press [Ctrl] + [F2]. Choose the Category
of functions in the drop-down menu and
click on a particular function. A brief
description of the function is displayed. 

To implement the function, click
Next. You will be asked to enter the
information needed for the function.
Instead of entering values, you can get

Calc to pick up data from the spreadsheet
by clicking on a particular cell. Click OK
when all the parameters are filled in. To
have the function list available at all
times as a sidebar, select Insert >
Function List. Click on Fx in the
sidebar to use a particular function and
manually enter the values needed.

Comparing Spreadsheets
When a single spreadsheet is passed

around among people, there are some
changes and feedback that may be added
to the spreadsheet. Select Edit >
Compare Document. Browse to the
location of the other spreadsheet and
click Open. You’ll get a detailed list of
differences, with the option to reject or
accept changes. The necessary changes are
then made to the spreadsheet you were
initially working on. 

Set Print Ranges
Cells not in the print range in

OpenOffice Calc are regions that won’t
be printed or exported—this is useful if
you’ve used a few cells to take notes or
just don’t want them to print. To add
regions to a print range, highlight a
selection of cells. Then go to Format >
Print Ranges > Define. You can
further add and remove cells in the
same manner by clicking on Add and
Remove from the same menu.

Tracking Versions 
Calc lets you save multiple versions

of your spreadsheet and switch to any one
when you need to. To save the state of the
spreadsheet, go to File > Version >
Save New Version and enter a
summary for the version. Multiple
versions can be saved in the same manner.
To access any of the versions, click on a
version and click Open. A new read-only
spreadsheet with the saved state will load. 

Automatic Value Highlighting
While entering huge amounts of

data including headings and numbers,
Calc can help reduce the confusion by
automatically assigning colours to
numerical values. Select View > Value
Highlighting or press [Ctrl] + [F8]. All
numerical values will automatically
appear in different colours.

OPENOFFICE CALC

Illustrations Harsho Mohan Chattoraj

Detailed changes made to any cell can
easily be viewed

Macros can be set to be triggered by events in Calc

Cells can be formatted automatically
according to set criteria

The Function Wizard is an easy way to access
and implement the huge database of functions
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Creating HDR Images  
HDR (High Dynamic Range) in

photography is a technique to display a
larger range of light intensities than can
be captured in a single camera shot. Start
with taking the same shot at different
shutter speeds to get multiple exposures.
When you have your images ready,
Photoshop CS3 can put them all together
and create an HDR image. 

To create HDR images, go to File >
Automate > Merge to HDR. Click
Browse and select the files you want to
make the HDR image out of. If you have a
folder with the images, you can also
choose that instead of separate files. Click
OK, and Photoshop CS3 will process the
images before displaying a window. This
window lets you set the white point for
the image. When you are satisfied with
the results, click OK. 

Creating Multiple Exposures
For A Single Image   

If you haven’t taken multiple photos, you
can still get yourself an HDR image using
the Exposure filter. This simulates
multiple exposures and can be used to
get somewhat decent results in creating
HDR images. Go to Image >
Adjustments > Exposure. Alter the
levels and click on OK. Save the file and
make a couple of variations. Use these
images to create HDR images as
explained in the previous tip.

Zoom With The Scroll Wheel   
If you want to zoom into your

image, you
could hold
down [Alt] and
use the scroll
wheel, but this
can get
inconvenient,
especially if you
use [Space]
immediately after to pan around your
image—the window’s [Alt] + [Space]
menu comes up! Photoshop CS3 does let
you use the scroll wheel for zooming, but
it’s not enabled by default. Go to Edit >
Preferences > General and check
the box against Zoom with Scroll Wheel.
Click OK.

Refining selection edges   
Selections made aren’t always

refined and smooth as you’d want them
to be. Photoshop’s selection tool now has
a new feature called Refine Edge. By
allowing you to alter settings for
selection after it is made, much better
control over the edges of the selection is
made available. 

Make a selection like you normally
would with any of the selection tools—
Marquee, Quick Selection, Lasso, etc. On

The king of all image-editing
software—Adobe Photoshop—has
now been rejuvenated as Photoshop

CS3! It’s faster and more feature-packed
than before! We go through the best of
the newly-added features and how you
can use them to make an impression
through your work. 

Big Toolbar... Small Toolbar!  
Almost all computer graphics

creation tools—be it image editors or 3D
modelling software—
can have millions of
toolbars and menus,
which often crowd
your workspace. The
new Photoshop CS3
allows you to minimise
the toolbars to a more
compact layout.

The toolbar on the
left and the docks to
the right, which
contain the history,
histogram, layers, etc.,
have this feature. Click
on the title bar of the
toolbar on the left and
it will toggle between a
wider and vertically-
expanded mode.

Similarly, click the title bar of the docks
on the right and they will minimise to a
compact bar. You can still access all the
features in the docks, but they are hidden
automatically whenever you move focus
away from them. 

Additionally, use [Tab] to hide all the
palettes, and hold your mouse cursor at
the edge of the screen to un-hide them.
Once you’re done, they’ll go back into the
edge of your screen, leaving you with
your image.

the Options bar on top, click the
Refine Edges button. The area outside
your selection will fade out, and you can
make changes to parameters such as
Smoothness, Feather, and Contrast to get
the result you need.

Adding Plugins To Photoshop   
Plugins are usually written by third-

party developers to allow programs to
extend their capabilities. You can find
Photoshop plugins at

www.adobe.com/products/plugins/photoshop.
You can add a separate folder to have
Photoshop automatically pick up plugins
from if you have put them there. This
also helps when the time comes to
uninstall a plugin you don’t care too
much for. Go to Edit > Preferences
> Plug-Ins, and check the box against
Additional PlugIns Folder.
Navigate to the folder you want to use
and save your preferences. 

Using The New Advanced
Clone Tool   

Do not mistake the Clone Stamp tool in
CS3 to be just like the one in the earlier
versions. This new version allows you set
five different clone sources so you don’t
have to go selecting the source over and
over again. 

First, click the Clone Stamp Tool
from the left toolbar. Click on the
Stamp Source dock to the right (its
icon is similar to the Clone Stamp icon).

Switching to a
compact toolbar
helps in saving
some workspace

Access to the zoom func-
tion is easy with the
mouse scroll

You can access third-party plugins in a sepa-
rate folder from Photoshop

The clone tool in CS3 allows multiple clone
sources

ADOBE PHOTOSHOP CS3 
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With Mobipocket’s Reader and Creator, you can turn your PC and smartphone into
your own library!

Jayesh Limaye

Now that the mobile phone is a fix-
ture in your pockets, you might as

well use it to entertain or educate your-
self on those long, boring commutes.
With Mobipocket Creator for your PC
and Reader for your smartphone, you
can turn any document—PDF, HTML,
Word, even plain text documents—into e-
books that you can read on the go. You’ll
find the Mobipocket Creator and Reader
for your PC on this month’s CD.

Your First E-book
To start creating your e-book, select
Blank Publication on the left in
Mobipocket Creator’s main screen. The
Publication Files window then lets you
add files to your new e-book. These could
be HTML documents (the best option),
XML, or JPG or BMP images, but you’ll
have to use the other wizards to create e-
books out of PDF or Word documents.
Add a cover image to the book, and your
first rudimentary e-book is done!

Importing Gutenberg Books
Project Gutenberg (www.gutenberg.org)
offers a large number of free e-books,
but they’re in the text format. What’s
more, this text is rife with premature
line breaks to make PC reading easier,
but they look unsightly on a mobile
device. You’ll have to go through a bit of
torture to convert these into Mobipocket
books. Our way out:

In Creator’s main window, select
Import from Text Document. In
the import dialog, check the box against
Suppress Single Carriage-
returns. Extracting chapter titles to
build a table of contents is a bit trickier...

In the same import dialog, you can
specify Header Extraction rules, which
will add the <h1> HTML tag to text that
conforms to these rules. This comes in
handy when you’re building a Table Of
Contents (more about that later). For
example, \X detects a string of upper-
case characters, and \n detects a car-
riage return.

The Table Of Contents
Like PDF bookmarks, a Table Of
Contents (TOC) lets you jump to chapters
in your book directly. Importing a PDF
with links will automatically create a

TOC for you, but if you’re building a
book from HTML or text files, this can
get tricky, and you’ll need some HTML
knowledge for it to work. 

If you’re importing a text file as
above, titles will be enclosed in the <h1>
tag, so to build your TOC, enter “<h1>”
under Tag Name as your first TOC level
and hit Update to generate a TOC for
your e-book. If you’re building a book
from HTML files, use a HTML tag like
“<text class=heading>” to denote your
titles. In the Table Of Contents dialog,

enter “text” under Tag Name, “class”
under Attribute, and “heading” under
Value to generate your TOC.

Publish!
You don’t really need to bother with
Book Settings, but you should spend a
little time in the Metadata section to
enter your book’s details—the title,
author, genre, and so on. 

If your e-book contains multiple
files, you can use Guide items to point to
them. These will appear in the Go To
menu in Mobipocket Reader—both on
your PC and smartphone. Use these
items to let your reader jump directly to,
say, the cover of your book.

When you’re all done, hit Build to
start creating your publication.

If you’re worried about the security
of your work, you can choose to encrypt
your publication. The Content
Encryption option ensures that the
source material of your publication can’t
be deciphered, but anyone with
Mobipocket Reader can read the content.
You can also choose to encrypt your
book with a password or DRM—the latter
only if you’re planning to upload the
book for sale.

Read!
Once your book is built, you can open it
in Mobipocket Reader to read on your PC
(it’s not the best desktop reader, we
must warn you). If you have a Symbian-,
Palm- or Windows Mobile-based smart
phone, connect it to your PC and it will
appear under Reading Devices in
Mobipocket Reader, which will then
download the installer for your
smartphone. Your e-books will now be
synchronised between your PC and
phone every time you connect it and fire
up Mobipocket Reader.

Enrich Your Reading Experience
On your mobile, you can use your e-book
like a regular book—make annotations
and notes, highlight items of interest,
add bookmarks to come back to later
and so on. The mobile Reader supports
touch-screens, so you can configure it so
a tap on the right of the screen goes to
the next page, and a tap on the left goes
to the previous. Purchase and install a
dictionary from www.mobipocket.com,
and you’ll also have the added ability to
highlight and look up any word from
the dictionary! 

jayesh_limaye@thinkdigit.com

Mobipocket Creator Publisher Edition

Add the Table of Contents

Specify the book settings here

Add files to Your E-book
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You will find five identical clone source
icons. Click on one of them and [Alt] +
click on the area of the image you want
to use as a clone source. Perform the
same steps for the other clone sources.

Another new feature is the ability
to use other open images as clone
sources.

The New Vanishing Point   
In drawing terms, a vanishing point

helps people draw objects in the right
perspective. It consists of parallel lines
that eventually appear to meet up at a
single point. Vanishing point in
Photoshop CS3 is meant to do the
same thing. 

To access the Vanishing Point tool, go
to Filter > Vanishing Point. A
window will appear. Click the Create
Plane tool if it isn’t already selected, and
draw four points that should denote a
plane in your image; this could be a wall,
a table top, a box cover, and so on. A
densely-created mesh appears in its place.
You can now use the draw or clone tool to
work with objects in that perspective.
Click OK when done. You can always go
back to the Vanishing Point tool without
having to recreate the entire plane.

Creating PDF Presentations    
Photoshop CS3 allows you to export

images as a PDF presentation—just like
PowerPoint. Go to
File >
Automate >
PDF
Presentation.
Click the
Presentation
radio button and
then click on
Browse to select
the images you
want in your
presentation.
Select what
details of the
image you would
like to have
displayed, the

colour of the background, and the
transition effects between slides. Click
Save. Enter a location and filename for
the PDF and click Save.

You can choose from one of the
presets for compression of images.
Click Save PDF to finish saving the
presentation. 

3D Objects In Photoshop?  
Photoshop CS3 has a feature called

3D Layers, which
lets you import 3D
models into
Photoshop. It
supports some of
the commonly
used formats—OBJ
and 3DS, to name
the most popular.
To add a 3D layer,
go to Layers >
3D Layers >
New Layer
from 3D file.
Select the file
from its location
and click Open. 

Once the
model has been
added, you can move it around using the
Move tool. To get more controls on the
imported model, go to Layers > 3D
Layers > Transform 3D Model. The
Options bar on top changes with several
controls that let you rotate, roll, and
move the model around. More advanced
options such as changing the lighting
and moving the camera around are also
available. When you’ve made your
changes, click on the Commit 3D
Transform icon on the Options toolbar.

Modifying Textures  
3D models generally need a mix of

materials and textures to get their look,
and most artists use Photoshop to create
their textures. Now you can use
Photoshop to create the texture and
preview it in Photoshop itself. Once you
have the model in Photoshop, you will
find the textures in use present as layers.
Double-click on the texture you want to
edit and Photoshop will open the file in a
new window. Make the necessary changes
and Save it. The changes will be reflected
in the 3D model. 

A Layered Cake  
Creating layers out of multiple

images has always been a pain—and a
lengthy process. The Load Files into Stack
script allows you to do this in a single
step. Go to File > Scripts > Load
Files into Stack. Choose files if you
want to select separate files or if you have
all the images in a single folder choose
folder from the dropdown. Click Browse
and select the files and folders from the

list. Click OK and a new file will be
created with all the images put in
separate layers.

Batch-Processing Images   
Photoshop’s image processing

function can help you batch-process
multiple images in one go instead of
changing parameters for every image one
after another. You can find the image
processor feature by going to File >
Scripts > Image Processor. There
are four steps that required to be set up.
First, you select the images you want to
process. Click the Open Images radio
button and choose the folder where the
images are present. 

In the next step, select the location
where you want the processed images to
be dumped. The third step involves
setting what format you wish to save the
file and the quality level. You can also
choose to resize it to another resolution.
The final step is one of the more
interesting ones. You can record actions—
Photoshop’s version of macros—which you
can set to run all the steps you normally
follow.  

When this is done, click the Run
button to start the batch processing. You
can also save the preset using the Save
button, or load presets using the Load
and Save buttons.

Adding multiple images into separates layers
is now effortless

Compositing of 3D
objects in images can be
done in Photoshop after
importing

PDFs can be created and
used as a slideshow
using the PDF
Presentation option

Bet You Didn’t Know

Custom
Workspaces 
Photoshop CS3 has
workspace presets for
different tasks which you
can switch to quickly just
like in AfterEffects. The
workspace icon can be
found at the top right
corner of Photoshop CS3.
Click on this and choose
from one of the presets—Automation, Image
Analysis, Painting and Retouching, etc. Any
changes you make to the layout of the
workspace can be saved as well by clicking
on “Save Workspace”.

Custom
Workspace have
layouts optimised
for various tasks

The Vanishing Point tool allows you to set up
the perspective of an image
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voiceover for slides, which can be useful
if you’re not making your presentation
to a live audience.

To record a narration, first click the
Slide Show tab in the ribbon. Click the
Record Narration icon. Here you
have the option to change the
microphone volume, quality, and where
the file should be saved. Click OK once
you’re done with the changes. Click the
Current Slide button if you want to
record a voiceover starting from the

current slide, or click the First Slide
button if you want to start from the very
beginning. The slideshow will then start
and you can start speaking into the
microphone. Click to switch to the next
slide and continue speaking as
necessary. When all the slides are done,
you’ll be asked whether you want to save
the timings for each slide. Click Save. 

Quickly Apply
Transition Effects 

Little visual details like transition effects
can make presentations stand out. With
older versions of PowerPoint, you were
required to right-click on a slide, click
on Slide Transition, and then
choose from a list of effects from a
sidebar.

In PowerPoint 2007, click the
Animations tab in the ribbon. You will
find a list of transition effects displayed

as colourful icons. Click on the slide you
want to change or set an effect to and
choose a transition effect from the
ribbon. Typically, you only see five or so
effects, but the scrollbar and the drop-
down will reveal a lot more.

PowerPoint 2007 also gives you other
options like the ability to change or set
sounds, timings, and speeds for the
effect.

Accurate Placement
Placing elements and then

aligning them or accurately placing
them can be a little irritating, but is
worth the effort. Click the object and
use the direction keys to move them
into place. Holding down [Ctrl] while
you do this gives you pixel-accurate
movement, which means you can move
them even more closely and even more
perfectly. Don’t forget to use gridlines
to align objects better—under the View
tab, check the box against Gridlines.

Formatting Images
Previous Office versions would also

let you do some changes to the images in
your presentations but in a rather non-
interactive manner. The new PowerPoint
2007 shows you live previews after every
change made. 

Click on an Image and click the
Format tab that appears in the ribbon.
Here a wide range of settings such as
Picture Styles, Brightness, Contrast, and
Colour parameters can be modified. Move
your mouse over any of the styles and the
preview will be shown on the image right
in the slide.

Using SmartArt
SmartArt are designs and shapes to

be used in presentations. The specialty
with these is that their colours change
to suit the theme you use for the
presentation, so you don’t have to worry
about them individually.

Go to the Insert tab on the Ribbon
and then select the SmartArt icon. A
wide variety can be found here. The
same goes for Shapes tool—their colours
change accordingly as well.

Disable Image Compression
By default, PowerPoint 2007

compresses images put into a
presentation while saving. While this
saves file size, it can result in a loss
of quality—which you might not
always want.

To disable compression, select the
Office Button > Save As. Then
select Tools > Compress Pictures.
Click Options. Uncheck the box against
Automatically perform basic
compression on Save. You can also
change the density (pixels per inch) of

POWERPOINT 2007

Managing presentations can be
part of our professional life or
just a way to quickly show

funny or interesting photos to people
through e-mail. We know of no better
application than Microsoft’s PowerPoint
to do the job. 

Create Photo Albums with
PowerPoint 

Creating photo albums can become a
dilemma for some of us. PowerPoint 2007
has a feature that lets you create a photo
slideshow within seconds. First click on
the Insert tab in the ribbon. Click the
Photo Album icon and choose New

Photo Album. Click the File/Disk
button to add images to the album.
Select the photos you want in the
sideshow and click Insert. You can use
the Up and Down arrows here to change
the order of the photos. You can also
alter the brightness, contrast, and
orientation of the images. When you’re
done, click the Create button and your
Photo Album is ready. You can now
continue adding notes to each slide.

Recording Narrations
PowerPoint lets you record a

Creating photo albums in PowerPoint to show
your friends

Record voice-overs for presentations for
events you can’t be present at

Transition effects for slides can be quickly
accessed through the ribbon



81DIGIT AUGUST 2007

Digital Tools l Tips & Tricks

Minding Your Money
Yes, you can manage your personal finances easily—and for free

Jayesh Limaye

Managing personal finances was only
for those with a commerce

background, or so you thought. Turns
out it’s not: you have Buddi, a free, open
source personal finance and budgeting
program. It’s available for Windows, Mac,
and Linux, and also as platform-
independent Java, from
http://buddi.soundforge.net. The
Windows version is just a 4.5 MB
download. Buddi does not require
installation—it can run standalone. Upon
first run, you are prompted to create a
new database. After doing that, you can
opt to encrypt it. You are then ready to
get started with your new personal
accounting database.

Set Up Your Accounts
You will notice the My Accounts tab in
the first screen. You can create two
types of accounts, Credit and Debit.
Credit accounts are marked in red,
and debit accounts are black. Click
New, and specify the account name,
starting balance, and account type.

You will notice that the Net Worth
value is listed at the bottom of the
window. This is the sum of the balance
of all your accounts. If you make a
mistake while creating or adding an
account, worry not—you can always
delete it and start over.

Get To Know Budget Categories
Clicking the My Budget tab will take
you to the Budget category list. Click
New to create a category. Budget
categories are the details of the credit
and debit of an account, and are
therefore divided into Income and
Expenses. There are a number of preset
parent categories in each of the two to
choose from, and these can be
modified to suit your needs. Examples

of categories under Income are salary
and interest earned; examples of
Expenses are money spent on groceries,
fuel, etc. In these categories, you can
enter the amount received or to be
spent. You can create sub-categories
under parent categories as necessary.
The Budgeted Net Income / Month
at the bottom of the window shows the
difference between the budgeted
income and the expenses.

Managing Transactions
This is perhaps the most important
section of the software; you will likely
spend the most time here. You can

define money transfers, either between
accounts or to budget categories. To
open the transaction screen, click on
the account to which you want to
transfer or from which you want to
withdraw—in the My Accounts tab—and
click Open. You can enter the details of
transactions such as amount, date,
description, transaction number (such
as a cheque number), category from and
category to, as well as a memo to
yourself about the transaction. Click
Record, and it will appear in the
Transaction window along with the
updated Net Worth. If you made a
mistake while entering the details, you
can simply select the transaction and
click Update (which was earlier the
Record button).

Generating Reports And Graphs
Buddi has a nice reporting system that
helps you monitor your spending habits.
Reports can be easily created—select a
report and timeframe, and the results
will pop up in a browser window. Graphs
and reports include a textual breakdown
of income and expenses compared with
the budget estimates, pie charts of
expenses and income over a given time
period, breakdown of Net Worth, changes
in Net Worth over time, and more.

Backing Up The Database
Buddi automatically keeps a rolling
backup of the most recently used data
files (the number of backups depends
on the settings in the Preferences), and
you can manually back up or restore as
necessary. You can work with more
than one data file, too, if you want to
keep a permanent backup of a previous
database. Buddi will automatically open
only the last used database and keep
the other databases untouched.

Fiddling With The Preferences
Clicking on Edit, you can enter your
preferences. Preferences has several
tabs, the first being View, where you
can set the appearance of the interface
such as whether deleted accounts and
categories should be shown. In the
Locale tab, you can set the language,
date format, and currency format. Since
INR or Rs is not available in the drop-
down list, click Other and enter Rs.
Buddi also has support for third-party
plugins, which are JAVA files (.JAR); you
can manage these in the Plugins tab.
An example of a useful plugin is one
that lets you import and export reports
to CSV files, which can be read by
applications such as Excel. In the
Advanced tab, you can set the
budgeting interval and the number of
backups, and add or edit the existing
account types. 

jayesh_limaye@thinkdigit.com

View and manage your accounts

Manage your budget categories

Graphs will help you analyse your budget

Add, edit and review your transactions
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a hidden tab in the ribbon. It allows you
to create and run or edit macros. To
enable it, click on the Office Button
and then the PowerPoint Options
button. Under the Popular section,
check the box against Show Developer
tab in the Ribbon. Click OK to save
the changes. The Developer bar will
appear in the ribbon on top and can be
accessed by clicking on the tab.

Setting Up Layouts
The layout of presentation

elements in a slide should be altered
depending on the amount and type of
information in it. Generally, the entire
slide has a title, a footer, and text in
between—usually numbered or
bulleted items.

To modify layouts and create your
own ones, go to the View tab in the
ribbon and click the Insert
Placeholder drop-down icon. Choose
the type of media you intend to put in it.
Next click and drag a box of the size you
want in the slide. 

Page Setup For Presentations
Depending on the type of projector

or screen you use or the impact you need
to deliver with a presentation, it is wise
to change the resolution of the
presentation accordingly. For example,
presentations at standard 4:3 resolutions

will look awkward on widescreens so
while creating the presentation you
would want it in that resolution or
aspect ratio.

To change the page setup, simply go
to the View tab in the ribbon and then
click on Slide Master. Click on the
Page setup icon and here, you can set
what you want the slides sized for. A
range of presets are available and you
can enter your own custom size as well.

If you’ve chosen one of the
readymade design themes or even created
one by yourself, you want to be a little
careful while changing the page setup—it
can wreak havoc on the design. 

Creating Custom Shows 
If you have a really long slideshow,

but don’t need a lot of slides for a
particular audience, the Custom Slide
Show comes in handy.

Open your presentation. To create
your own custom show from this, click

on the Slide Show tab in the ribbon.
Next, click on the Custom Slide Show
drop-down icon and click Custom
Shows. Click New to create a new custom
show. From the pane on the left, select
the slides you want in the custom show
and click Add. You can use the Up and
Down arrows to change the order of the
slides as well. Click OK. 

To play the new show, click on the
Custom Slide Show drop-down and
click on the custom show you just
created.

Changing Resolutions
On The Fly 

Large presentations with high-resolution
images can be a burden on slower
machines. To avoid any embarrassment
during presentations, PowerPoint has a
useful feature that can switch
resolutions of the presentations down to
more manageable levels. 

Click on the Slide Show tab on the
ribbon. Under Monitors, click the
Resolution drop-down and select a
suitable resolution. The next time you
run the slideshow, the resolution will be
switched to the one you specified.

Pin Recent Presentations 
Some presentations are visited

more often than others. Instead of
having to browse to the location and
manually open up the presentation
every time, you can choose to have the
most-used presentations pinned to the
Recent Files list.

Click on the Office Button and
you will find the most-recently-opened
presentations in the list to the right. To
the right of each file, there’s a pin icon
that can be clicked to permanently pin
the file to that list. Use the pin again to
remove it.

the images saved.
Keep in mind that this option will

only be set for the current presentation,
which means you have to do this over
again when you work on another
presentation.

To enable this for all the
presentations you make, you need to
turn to the Registry (back up your
Registry before proceeding). Start the
Registry Editor. Navigate to
HKEY_CURRENT_USER\Software\Micr
osoft\Office\12.0\PowerPoint\Op
tions. Create a new DWORD here. Call it
AutomaticPictureCompressionDefa
ult. The default value will be 0. This
disables the automatic compression of
pictures. If at anytime you want it
enabled, double-click the DWORD and
change its value to 1. 

Save Presentations To The
PowerPoint 97-2003 Format 

Like the rest of the Office 2007
applications, PowerPoint 2007 saves files
in the new .pptx format, so previous
versions of Office are bound to have
issues opening them. 

You can force PowerPoint 2007 to
save presentations in an older
PowerPoint format. Go to the Office
Button and click PowerPoint
Options. Go to Save in the left pane.
Click on the drop-down menu for Save
files in this format, and choose
PowerPoint Presentation 97-
2003. 

The Developer Tab 
The Developer tab in PowerPoint is

Fix compatibility issues for previous Office
version users by forcing saving to older 
formats

Page Setup allows you to create slides for dif-
ferent display or print setups

PowerPoint gives you an option to switch res-
olutions just for playing back presentations

Custom Shows give you the option to only
show a small selection of slides

The Developer mode allows better control
over macros

Disable compressing of images to obtain
better quality
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Cable Trouble
My system stops responding suddenly while I’m
in the middle of my work. I can do nothing but

restart it. After restarting, it says “DISK BOOT FAIL-
URE: PLEASE INSERT SYSTEM DISK AND PRESS
ENTER”. I then have to remove the cabinet, move the
cables, and restart. The system works fine for a day
or two, and then it’s the same thing over again.

Ashok Pothana

Your problem is essentially a result of
faulty power connectors. The fault devel-

ops with Molex connectors over a period of
time, usually if they are frequently removed
from and attached to devices. We advise you get
the power connectors replaced as soon as possi-
ble; faulty connectors can lead to hard drive
errors and eventually drive failure.

Certification Obsession
I have an NVIDIA GeForce FX 5200 graphics
card. The drivers supplied with it are not

WHQL certified. When I try to install drivers from
NVIDIA Forceware versions 77.37, 93.13, and
others, I see an error like “No supported drivers
found compatible for your GPU.”

Gaurav Warhekar

Go ahead and install the drivers that came
with your card even if they are not WHQL

certified. WHQL certification is not a prerequi-
site for the thing to work. The driver numbers
you mentioned do not support GeForce FX
5200 GPU-based graphics cards. Download the
latest NVIDIA drivers for your card from
www.nvidia.com if you are experiencing any
issues with the older drivers.

The Mother Of All Errors!
When I switch on my computer, I see the
following message: “Intel CPU uCode

Loading Error”. Please help.
Vinay Tiwari

Your motherboard needs a BIOS upgrade.
Visit the Web site of your motherboard

manufacturer and download the latest BIOS for
your motherboard—and also the utility to flash
the BIOS. You might be able to flash your BIOS
through Windows, but if it can only be flashed
in DOS mode, you will need to boot using a
Windows 95/98 bootable CD or disk.

Wired!
My friend and I have computers with Windows
XP SP2, and we have the same broadband ISP.

Each of us has a static IP address. How can we
remotely access each other’s computers?

Manan Pandya

Windows XP has a utility, called Remote
Desktop Connection, which lets you access

a computer remotely. You can use it to access
your friend’s computer and vice-versa in the
following way. First, enable Remote Desktop on
both the PCs. Open System in the Control
Panel and click the Remote tab. Check the box
next to Allow users to connect remotely
to this computer under the Remote
Desktop section, and click OK. That’s it; you
can connect to each other’s computers and
view each other’s Desktops.

For those who do not have a static IP, there
are other ways: register for free at
www.LogMeIn.com, and download and install the
application on the PC that is to be accessed
remotely. The host PC does not require the
application to be installed; all you need to do is
log on to the site and sign in. You can immedi-
ately start accessing the Desktop of the target
PC. This works even if either or both of the PCs
is / are behind a proxy server.

Time To Upgrade!
I have 3 GHz Pentium IV, a motherboard with
SiS Mirage onboard graphics, 512 MB of RAM,

and an 80 GB hard drive. I installed two games,
Shadowgrounds and Lord of the Rings from your
DVD, but when I start them up, the game window
launches for a moment and closes automatically.
I have Windows XP Pro SP2 and have even
installed DirectX 9c.

Sameer Ahmed

The games you’ve mentioned require a
DirectX 9c compatible graphics card, and

the SiS Mirage graphics solution won’t do. Just
installing DirectX 9c does not fulfil the require-
ments; the hardware needs to be fully compati-
ble to be able to render the graphics in newer
games. We suggest you upgrade to a newer
graphics card such as the NVIDIA 8500 / 8600
series if price is of concern. If it’s not, you can
opt for higher-performance cards such as the
NVIDIA 8800 series. You will also need to
upgrade your motherboard to be able to
support one of these PCIe cards, so make sure

Your Questions, Our Answers

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Questionable
licenses and truant
uninstallers—all
dealt with right
here!

You can use unsigned drivers as long as you know
where they came from
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your CPU is compatible with the motherboard
you might upgrade to.

Talk Unlimited
What is VoIP, and software for it is available in
the market? I have heard that one can call for

free through VoIP anywhere in India and abroad.
Is that true? I have a broadband connection. I have
a 1.5 GHz processor and 256 MB of RAM, and I use
Windows XP. Do I have to reconfigure my system
for dialling abroad?

Tahir Hussain

VoIP stands for Voice Over Internet Protocol.
It is a form of telephony that involves the

routing of voice calls over an IP-based network
(such as the Internet), thus making cheaper call
rates possible. There are no providers offering
free calls to India, but a few VoIP providers such
as Globe7 at www.globe7.com, VoipBuster at
www.voipbuster.com, and Gizmogear at www.gizmo-
project.com allow you to call free to certain desti-
nations, but only after you pay for a minimum
amount of credit.

The minimum system requirements usually
quoted by VoIP providers is a computer
running Windows 2000/XP/Vista with a 300
MHz processor, 128 MB RAM, 10 MB free hard
drive space, a full-duplex sound card, a head-
set, and at least a 64 Kbps Internet connection.
You should have no problems with your config-
uration as far as VoIP is concerned. It does not
require any special hardware. All you need to
do is download the VoIP
software client from the
above Web sites, buy credit,
and start calling.

Run Fun
Each drive on a friend’s
Windows XP computer has

a unique icon, and a certain
program runs when he double-
clicks on them in My Computer. I
am fascinated! How I can achieve
this on my PC?

Yogesh Bhuskute

The icon displayed for each
drive in My Computer is

due to the presence of an
Autorun.inf in the root of the
drive. This is exactly the same
as in the case of the autorun
feature of a CD or DVD.
Autorun.inf is an instruc-

tion file associated with the Autorun function.
A simple autorun.inf file looks like so:
[autorun]
open=autorun.exe
icon=autorun.ico

Here, autorun.exe is the executable file
that is launched when the CD is inserted, and
autorun.ico is the icon file that gives the CD
its icon. In case of a disk partition, this file
executes when you double-click the drive icon
in My Computer. Sometimes an executable file
or a DLL that might contain an icon is also used
instead of an icon file.

You can also try a freeware Autorun file
editor such as the one from http://autorun.moon-
valley.com if you wish to play around with
autorun files.

How Do I Tell?
I recently bought a PC with Windows XP
Professional SP2 from a local PC assembler.

He says the Windows is legal and is pre-activated.
Please tell me how I can ascertain as to whether I
have a legal and pre-activated copy of Windows.

Mayur Patel

To check whether your Windows XP is
already activated, open the Run dialog box,

enter oobe/msoobe /a and click OK. If your
copy is activated, you will be greeted with a
“Thank you” screen; if not, you will be
prompted to activate Windows.

To ascertain whether your copy of Windows
XP was legally purchased, use Microsoft’s online
validation process: try to download any of the
Genuine Windows downloads from the Microsoft
Download Center. You will be prompted to vali-
date your copy online; simply follow the instruc-
tions and you will be able to verify within a
couple of minutes whether your copy of Windows
is legal. For more information about this, go to
www.microsoft.com/resources/howtotell/ to learn
about how to tell whether a Microsoft product is
legal or pirated.

Back To Square One
My Windows XP computer is in a bad state,
and after searching for all possible solutions,

I’ve found that reinstalling Windows is the only
way out. Please explain the process of reinstalling
Windows—many people like me are afraid to try it
because of the fear of losing data.

Parag Shah

You are right—sometimes the only solution
is to reinstall XP. Actually, this is better

A Meaner Tuner
I have an Intel 1.1 GHz Pentium III with 256 MB of RAM and
an 80 GB hard drive, along with a Tech-Com TV-Tuner.

When I try to capture a TV program, it drops too many frames.
Ankit Sarang

The system configuration you have is more than enough
to view TV using a TV tuner. But it is not enough to

record live TV at high quality. You will be able to record in
the MPEG-1 format (VCD quality) without dropping a frame,

but if you try to record in MPEG-2 format (DVD
quality), you will drop a lot of frames (the
resultant captured file will be of poor quality).
If you want to record in MPEG-2, consider
upgrading your hardware to at least a 2 GHz Intel processor
or a 2000+ processor from AMD. To capture in MPEG-2 with
a really good quality, you will require a TV-Tuner card with
hardware MPEG capture capability, such as those from
Leadtek Winfast. Check out the TV-Tuner comparison test in
our April 2007 issue for more details about TV-Tuners.

Question 

of the

Month

Illustrations Harsho Mohan Chattoraj
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Create Web Pages Using Nvu 

Rossi Fernandes

With blogs, you don’t always have
complete freedom to design your

pages the way you want them to be—
you typically end up choosing one of
the themes available. Of course, a
hundred other bloggers have chosen
the same theme, and when you land
upon a blog that has the same theme
as yours, you suddenly feel smaller,
less unique…

Let’s look at Nvu, a free, open
source WYSIWYG Web designing soft-
ware. (What You See Is What You Get
means pretty much that… that the
final result will look just like what
you’re seeing while you’re going about
designing it.) Nvu is based on
Composer from the Mozilla package.
It’s a free download from www.nvu.com.

Set Page Parameters
Before you start, remember to
place all the files you create in

one folder so as to avoid hyperlinking
problems between pages and images.

A blank page comes up when you
first start Nvu. You first need to set up
the basic parameters for the page you’re
going to create. Select Format > Page
Title and Properties. If you don’t
enter the title of the page here, the
default title or no title at all will be
displayed in the browser’s title bar.

To change the basic colour parame-
ters for the page, choose Format >
Page Colors and Background.
Here, click the “Use custom colors”
radio button and select the colours you
want to use for various types of text
such as active links, visited links, link
text, etc. on the page. 

Add Visuals To Your Page
Most of the text formatting
and styling that you might do

in Nvu is similar to doing it in any
word processor, so we don’t need to tell
you much. But for any kind of appeal,
you need the visual element. To add
images to your page, select Insert >
Image. Choose the path for your image.
It can be a path on your local drive or a
location on the Internet. If it’s a loca-
tion on the hard drive, keep the image
in the same folder as your HTML file.

Create Links
To create a hyperlink, first
select some text (or an image).

Right-click on it and select Create
Link. In the window that appears,
enter the desired URL and click OK. 

Make Changes To The Code
Advanced Web designers code
complete pages by hand in

simple text editors, and Nvu does let
you alter the code it generates. Click
on the Source tab and make the
changes you want to. These will be
reflected both in the Preview and the
Normal views.

Add CSS To Your Pages
Nvu has a CSS (Cascading Style
Sheets) Editor to set up styles.

To access it, select Tools > CSS
Editor. Click the Rule button. Enter a
name for the style. Click the Create
Style Rule button. Here you can set the
colours, font styles and sizes, and many
other parameters for that style. Click
Close when you’re done.

To set a style to a selection of text,
first highlight that text. Then in the
drop-down menu for the setting of a
selection to a class, choose the style you
just created, and it will be applied.
(Classes are used to identify groups so
all the objects in one class are given
the same style.)

You can also choose to import exter-
nal Cascading Style Sheets: make sure
you have the Web page saved, and in
the CSS Editor, click the Link elt
button. Click Choose, point to the
external CSS file on your drive or at the

site that holds the file, and click on
Create Stylesheet.

Before you go ahead with publish-
ing your page, you can clean up unnec-
essary code using a feature called
Markup Cleaner, accessible from Tools
> Markup Cleaner. 

Publish Your Page
It’s now time to upload your
pages to your Web space

provider’s server. The upload is typically
to an FTP server. Your provider would
have given you a username, a password,
and the FTP server details. To upload the
pages, select File > Publish. Enter
the site name, publishing server, user-
name, password, and other details. Click
Publish and the files will be uploaded.

If you use multiple Web space
providers, the Site Manager is a good
way to store details for all the sites. The
Site Manager should be on by default,
on the left side of the window. If it’s
not, go to View > Show/Hide >
Site Manager. Select Edit Sites,

and you can enter authentication and
connection details for many sites.

Most of us don’t require dedicated
Web hosts for (small) personal Web
pages, and free services should suffice.
Gmail and other Google service users
can register for a free Web hosting serv-
ice called Google Pages
(www.googlepages.com) and you’ll get a
site address that should look like
http://YourUserName.googlepages.com. In
fact, there are many free providers you
can easily find: Google up “free web
hosting” or “free web hosts”, and you’ll
find plenty of them. Note that some
services, including Google, allow no
FTP access; you need to use a Web inter-
face and upload files one by one.

rossi_fernandes@thinkdigit.com

Break free of templates… without working too hard!

CSS gives pages a much more modern and
elegant look

Create hyperlinks to friends’ sites or blogs,
for example

Quickly upload pages to remote servers
using the Publish feature
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than doing a fresh install, which takes longer
because of the need to install everything, from
the drivers to the software; besides, you need to
reset the data settings.

Regarding reinstallation, you can reinstall
XP right over the existing setup to repair most
problems. Before starting the reinstallation, we
advise that you back up important data.

There are two ways to do it. If you are able to
boot into Windows, simply pop the XP CD into
the drive and select Install > Upgrade
[Recommended]. This will install XP over the
previous installation and repair most problems.
If you have an OEM version, this option will not
be available, and you will need to reinstall using
the second method, which we will explain
shortly. Also, if you have an XP CD with a version
lower than that of your existing OS (that is, if you
installed service packs), you will get a message
stating that a newer version of Windows was
found and that you will not be able to run the
upgrade. In this case, too, you’ll have to use the
second method, but bear in mind that you will
lose any service packs you installed.

In the second method, boot using the XP CD.
Press [Enter] when at the setup screen and
press [F8] when you see the License Agreement
screen. You will be presented with the option to
either do a fresh (clean) install or to repair the
selected Windows XP installation. To run a
Repair Install, press [R]. XP will copy the neces-
sary files to your hard drive to begin the installa-
tion and will reboot. When prompted to “Press
any key to boot from CD”, do not press any key,
and let the PC continue booting. You will see the
usual Windows XP setup screens. After the instal-
lation is done, you will find all your previously
installed programs and settings intact. Reinstall
all service packs and security updates.

A Question Of Codecs
I am not able to play the trailers and movies
you give out on your DVDs. Please tell me what

video format they’re in and how I can view them.
Hassan

The videos
on the Digit

DVDs are
usually in the
DivX video
format; some
might be in the
QuickTime or MP4
formats. To view
these videos, you
can either install
the DivX codecs (for
DivX movies) and
QuickTime for
Windows (for
Q u i c k T i m e
movies), or you can
install and use
VLC Media player,
which is given
out on every Digit
CD (under
Essentials )

Go Away!
My Add/Remove Programs window shows a
blank space and I am not able to uninstall

most of the programs I had previously installed.
I am running Windows 2000 Standard Edition.

Rajnish Barot

Locate the file Mshtml.dll and ensure
that its permissions are set to Full Control.

Open the command prompt and enter the
following commands.
regsvr32 /u c:\winnt\system32\
appwiz.cpl
regsvr32 /u c:\winnt\system32\
mshtml.dll
regsvr32 /u “c:\program files\common
files\system\ole db\oledb32.dll”
regsvr32 c:\winnt\system32\appwiz.cpl
regsvr32 c:\winnt\system32\mshtml.dll
regsvr32 “c:\program files\common
files\system\ole db\oledb32.dll”

If this does not solve the problem, you may
need repair your XP installation. We have
covered that aspect as well in this section. 

De-Moded
I recently bought a DVD-Writer, the Sony DVD-
RW DRU-820A. DVD reading is very slow; it

reads DVDs at just 0.85x. While creating a DVD
image using Nero, the maximum speed it could
achieve was 1150 KB/s. What could the problem be?

Bhuvnesh Agrawal

The drive is most likely running in PIO
mode rather than DMA. You can check for

this thus: open the Device Manager by running
devmgmt.msc. Under IDE ATA/ATAPI
Controllers, check the properties of all the
channels, and in each case, check in the
Advanced Tab whether the Transfer Mode is set
to DMA or PIO. Set it to DMA if it happens to be
PIO. Restart your PC. If that doesn’t set it to DMA
mode, delete that particular channel from the
Device Manager and restart your computer. This
time, the channel should be re-detected, and the
DMA mode should be enabled. If this doesn’t
work for you, the drive is faulty. 

Set the transfer mode to DMA in Device Manager
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Onboard’s Awful!

15 per cent more performance. The 8600GT / GTS
are DX10-ready, but do not be fooled—these
won’t offer great performance on DX10 titles,
however the silver lining—unlike DX9 cards, they
will at least be able to run DX10 titles.

The next vendor showed us a Leadtek
GeForce 8800GTS 320 MB. This one was priced at
Rs 22,000. Other brands like XFX, Palit, and
Zebronics also have these cards. The bigger
brands—ASUS, Gigabyte, and MSI—also have the
full range of GeForce cards. In fact, we found an
XFX 8800GTS 640 priced at an astronomical
30,000 rupees. The GeForce 8800GTX is also avail-
able on demand; no vendor stocks the card—the
price (Rs 34,000 and upwards depending on the
brand) is probably the deterrent. ATI’s latest HD
2000 series isn’t available in India right now. We
did find a vendor saying he could arrange for an
HD2900XT for Rs 30,000. This card has a massive
320 shader units, although all bets are off till we
actually test one.

The older ATI cards are still in the market—a
Sapphire X1950 Pro was available for Rs 16,500.
A very good gaming option for older and cur-
rent-generation games, for all but the highest
detail and resolution settings. An X1950XTX is
also available for Rs 25,000, but this is, frankly,
too much to spend on a DX9 card. I cautioned
my friends to be thrifty, particularly if they
wanted to go with a DX9-only solution, as any-
thing in that space would be strictly stop-gap.

We had a cola at a nearby restaurant as I
racked my grey matter for the perfect solutions.
I was looking at frugality, performance on all
fronts, and future proofing as essential parame-

ters. Eventually, I decided on a GeForce 8600GT
for my first friend; he was happy, since his

budget was much higher. I even coun-
selled him on SLI as a later possibility.
We settled for the Palit 8600GT, though
I couldn’t get the guy to go lower—
8,000 bucks. My friend wouldn’t pay
the premium that XFX demands as
a larger consumer brand. I was OK
with it, since the warranty period
was the same. Friend number two
was thrilled with the Zebronics

8500GT for 5,000 bucks (my bar-
gaining skills failed again). 

On the way home, my friends
started ribbing me about me not

having a graphics card myself! I took it
all good-naturedly. But to let you in on a

little secret, I’m expecting a big green box
very soon… 

With DX 10 and all that it’s promising
just around the corner, a lot of people
have begun thinking of buying

graphics cards. Both NVIDIA and ATI have
launched mid-range and entry-level graphics
solutions, which have pushed prices of earlier
graphics hardware even lower; this is the ideal
time, in my opinion, to buy a graphics card.
Why? Well, for one—and (sigh!) I’ve been saying
this over and over—integrated graphics just
doesn’t cut it for the current crop of Desktop
applications, let alone games, any more. You
have high-resolution movies, and image and 3D
editing, not to mention games. Indulgence
requires sacrifice, of course—a few thousand
rupees to be exact.

Two of my close friends finally decided to for-
tify their computers with graphics cards this
month. One is upgrading, and the other is an
onboard graphics user. After some deliberation,
the three of us decided to meet at Lamington
Road on a Saturday. They had different require-
ments, though—the first pal could spare 14,000
rupees, and he wanted a good gaming solution.
The other had only Rs 5,000, and humbly
requested we make the best of what he had.

The NVIDIA GeForce 7 series and ATI Radeon
X1000 series are still very much around,
although NVIDIA has a good supply of their
latest 8 series cards coming in to our shores. ATI
should follow suit, though to their defence, they
launched their DX10 range only very recently.

There was this one guy who had a couple of
graphics cards on display. He showed us an XFX
7600GT for Rs 6,000. This is a solid DX9 solu-
tion, and is a touch faster than an
8500GT. A Zebronics 8500GT was
also on display—just Rs 5,000. I
was shocked to see the prices of
the latest cards: A Palit
8600GT costs just Rs 8,000—
excellent value for money.
Such cards will run all cur-
rent games at medium set-
tings and resolutions.
They’re even more suitable
for movies, where their
superior decoding capabilities
come into play.

There were also some older
cards—a powerful XFX 7900GS for
Rs 13,800 and a GeForce 7900GT for Rs
16,000. The 7900GT is your best bet for
gaming in the sub-20,000 category, unless
you can find a 7900GTO / GTX, which offers
512 MB of RAM (the other 7900s all feature 256
MB) and higher core and memory clocks. An
XFX 8600GTS was on display for Rs 11,000; this
is basically an overclocked 8600GT that offers

Want more of Agent 001? Turn over to read his
answers to your buying questions

Agent 001

Illustration Shrikrishna Patkar

Buying a graphics card? Best DX9 or middling DX10? Games or HD content? Not sure what to
choose? Read!
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More Power To The Desktop

I’m looking to get myself a powerful Desktop…
it’ll need to run Windows Vista, Visual Studio

2005, and SQL server 2005, along with other soft-
ware that are heavy on system resources. I will be
using it for gaming as well. So what should I buy?
Should I go quad-core, or will a Core 2 Duo suffice?
Also, should I wait for DDR3?

Gaurav Kumar

Your requirements are
high, but you haven’t

mentioned a budget. You also
haven’t said whether your
gaming is going to be casual or
“hardcore.” So, with some guess-
work involved, I’d place the price
for your new computer at
around Rs 50,000. Listed along-
side are the specs I’d recommend.

Make sure to pick a roomy cabinet to avoid
overheating. If you want a better graphics solu-
tion for decent gaming at medium resolutions
opt for the 8600GT (Rs 8,000). A quad-core will be
good for multitasking, but not necessarily better
for gaming. In the programming and application
development departments, there will likely be a
small performance increase. If you want to go
quad-core, I suggest waiting till  Intel’s price
drop, expected some time during August—this
should see the Core 2 Quad Q6600 become really
affordable. However, current applications do not
really benefit from more than two cores. Go
quad core only if you want to future proof. The
Core 2 Duo E6750 will also make its market
debut at that time. And yes, drop the idea of
DDR3—it’ll be a long wait!

Thou Shalt Upgrade
My current configuration is an AMD Athlon 64
3000+ @ 2.0 GHz, 512 MB of RAM, a 256 MB

GeForce FX5200, an 80 GB HDD, and an MSI K8 M800.
I’d like to play some of the new games like Test Drive
Unlimited on my system. Will it be possible if:
1. I get 512 MB more RAM?
2. A new display card with only the existing memory?
I can spend a maximum of Rs 5,000.

Aneesh

Aneesh, I know it’s tough, but you will
need a memory and graphics upgrade at

the least to play Test Drive Unlimited. However, a
better graphics card would also help a great deal,
more so than a memory upgrade. Keep in mind
that AGP cards are costlier than their PCI-Express
counterparts.

Look for a graphics card based on NVIDIA’s
GeForce 7600GS chipset; this should cost you
roughly Rs 5,000. The card should have 256 MB
of video memory and would help you play Test
Drive Unlimited.

Music, Not Noise
I want to buy an in-ear set of earbuds with good
noise isolation. My budget is Rs 5,000. Any help

you can offer?
Ashwin Mendonca

The Creative EP630 for Rs 1,200, without a
doubt! There’s nothing better available for

even double this price. You may get these for even
less; we’ve seen sets going as low as 900 bucks.

Money To Burn
I want to buy a PC with the following specifica-
tions: a 250 GB SATA hard drive, 1 GB of RAM, a

graphics card with 512 MB of memory, a dual-layer DVD-
Writer, and Genuine Windows Vista Ultimate. My budget
is Rs 1 lakh.

Vega Jeet

You will get something much better than
what you’ve mentioned for less than a

lakh, I assure you! However, you haven’t men-
tioned what you intend to do with such a rig. I sur-
mise you’re into gaming, or at least that you
intend to subject the PC to heavy multimedia
usage. Here are my recommendations.

The Core 2 Duo E6750 should be available by
the first week of August for a little less than the
current price of the the E6700.

Creative All The Way?
I’m a little confused between Creative’s Gigaworks
Pro-gamer G550W and the Inspire P7800. Which

gives better performance? I have a Creative Sound
Blaster Audigy 4 sound card.

Venkat Kumar S

The Gigaworks Pro-gamer would defi-
nitely perform better, and is worth a look

at Rs 16,000. Also look at the Logitech Z5300, a
great 5.1 system for gaming and movies with its
booming bass for around Rs 11,000. For music, I
don’t recommend a 5.1 system; instead, opt for
the Altec Lansing MX5021 at Rs 8,000; nothing
even comes close for music.

Work ‘n’ Play
I want to buy laptop for study purposes, and for
some gaming. My budget is Rs 35,000.                     

Gokul

You might want to check out last month’s
issue for more options, but no laptop

with a price tag of below Rs 35,000 comes with
a decent graphics solution. I recommend upping
your budget a bit if you want to game, and get an
ACI Ethos Duo 1430D. This laptop also has a good
processor (Core 2 Duo T5200). If you cannot
spend more, then the Compaq Presario v3225AU
makes a superb deal at Rs 32,990. It’s a very good-
looking laptop, with all the features. It will
handle older games easily. 

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related
questions in this space.

Ask Away!

Ask Agent 001

Processor
Motherboard
Memory
Graphics Card
Monitor
Hard Drive
Power Supply

Rs.
11000
8000
8500
5000
13000
4000
4800

E6600
ASUS P5B
4x1 GB DDR2 667 Kingston
Geforce 8500GT
ViewSonic VA1912W
Western Digital 320 GB
VIP 600 Watt

Agent 001’s Recommendation

Processor
Motherboard
Memory
Graphics Card
Monitor
Hard Drive
Power Supply
DVD Writer

Rs.
16000
11500
4700
26000
22000
8000
4800
1800

Core 2 Duo E6700 (2.66 GHz)
ASUS P5B Deluxe
2x1 GB DDR2 667 MHz Kingston
Geforce 8800GTS (640MB)
ViewSonic VA2235WM
Western Digital 320 x 2 GB
VIP 600 Watt
Sony DRU830A

Agent 001’s Recommendation
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Asfaq Tapia

If you’re a Windows user who
hasn’t experimented with the
myriad of free Linux distros

available, this one’s for you. Let’s
take a look at some of the most
popular Linux Desktop Environ-
ments that sit on top of the Oper-
ating System (OS).

A Desktop Environment (DE)
typically provides a GUI: windows,
icons, folders, toolbars, and abili-
ties like dragging and dropping of
files from one folder to another.
Any DE will therefore include a
window manager, file manager,
taskbar, and more.

GNOME
The GNU Network
Object Model Environ-

ment, or GNOME, is an interna-
tional open source effort to build
the simplest and most intuitive
GUI for a DE. It’s one of the few DEs
that have consistently matched
their production timelines, releas-
ing a new version every six months.
Currently, it stands at version 2.18.
This version focuses on document

security, and
i n c o r p o r a t e s
privacy features
that enable you
to digitally sign
or authenticate
files using
Seahorse, an
a p p l i c a t i o n
created for the
purpose. That

apart, this version also focuses on
managing laptop batteries effi-
ciently, and increases the stability
and responsiveness of the OS.

GNOME’s popularity in the
open source world is due to its
exhaustive set of developer guide-
lines—known as Human Interface
Guidelines—to be followed when
creating an application for the
environment. The guidelines
ensure applications don’t look too
different from each other, and that
some basic options like closing,
minimising, and re-sizing, among
others, are placed in the same loca-
tion across all applications.

GNOME’s design keeps novices
in mind. The DE does not have a lot
customisation options, and
contains menus with an exhaus-
tive set of explanation notes. The
main reason most Windows-
converts should stick to this DE is
because it provides a well-docu-
mented FAQ section, and a very
active online community that will
answer any newbie’s questions.

KDE
The K Desktop Environ-
ment, or KDE, is
another DE that runs

on Unix and Linux distros.
KDE believes in the manifesto

that all components used to build
the DE, and the applications that
come bundled with it, have to be
free and open source in the truest
sense of the word, with no restric-
tions whatsoever on the user.

The major difference from
GNOME lies in the fact that KDE is
not entirely geared towards the
novice. It allows for complete
customisation, which might intim-
idate; having said that, there are a
good set of applications that allow
you to start using a KDE-based
distro as soon as you install it.
Applications like KOffice, Amarok,
and Konqueror are some of the
more popular KDE applications.
KDE allows you to mimic OSes such
as Mac OS X, so if you’re the type
who likes to have complete control
over each and every aspect of his
OS, this is the platform you might
want to use.

The most popular distribu-
tions on this platform include
Fedora (formerly Fedora Core)—
though it’s not the default envi-
ronment—and Knoppix.

Xfce
Unlike GNOME or KDE,
Xfce is a lightweight DE
designed to work with

computers that have both older
and newer hardware. 

It is very user-friendly, and
incorporates a minimal set of
customisable options. The filesys-
tem hides system and configura-
tion files from view so they can’t be
tampered with by the novice. In

comparison to GNOME or KDE,
Xfce is regarded the most respon-
sive DE. It uses its own file
manager, called Thunar. One
advantage of using Xfce is its install
size, all of 50 MB to be exact.

Popular distros that use Xfce as
their default DE include Xubuntu,
SLAX, and dyne:bolic.

There are other DEs not as
popular as the three above, but
worth a mention:

Mezzo
A proof-of-concept DE based on the
“Laws of Interface Design.” It aims
at presenting all information
collectively, in one place, thereby
completely debunking popular
concepts such as the Desktop being
a folder, and the menu system
having nested folders. Instead, it
presents all the needed informa-
tion on the Desktop, and holds
tasks and files related to “System”,
“Files”, “Programs”, and “Trash” in
four windows on the screen. Mezzo
is available as a .deb package,
which is like an .exe file in
Windows, for installation on all
Debian-based distros like Ubuntu,
Freespire, and Knoppix.

Project Looking Glass
A DE written entirely in Java,
Project Looking Glass aims at creat-
ing a 3D Desktop Environment
that can run on computers with
low-end hardware. One of the most
notable features is the creation of
“reversible windows”: you can
write notes or leave comments on
the back of any window! Windows
can be tilted or rotated to the angle
of your choice, and can also be
made semi-transparent. You’ll find
the Looking Glass Live CD on this
month’s DVD. 

asfaq_tapia@thinkdigit.com
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Linux Desktop Environments
You’ve heard about “Gnome” and “KDE” and more—these Linux-related things are “Desktop
Environments.” If you’re making the switch, which one is for you?

The GNOME environment in action in
Ubuntu

The Xfce environment in all its splendour
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If you are clued into the Web 2.0
phenomenon, you’ve noticed

the sudden explosion of online
applications that can be accessed
anywhere and everywhere. Into
this chaos enters SimpleSpark.
com, a site that catalogues all the
fast-emerging Web 2.0 applica-
tions. The categories on the site
range from “calendar” apps to
the quirky “loans” applications

that you can use to keep track of
your financial commitments.

Searching for “write”, for
instance, on SimpleSpark.com,
brings up a list of all online word
processing applications—from the

popular Zoho Writer (http://
writer.zoho.com) to Writeboard
(www.writeboard.com). We even
found Just Anger (www.jus-
tanger.com), a site that lets you
vent when you’re angry and in dis-
tress! Every Web application listed
in the search results has a little
description below it. This lets you
quickly find the app that best suits
your need, without your needing to

bother to visit the Web site
and use its services.

Once you make an
account, you can add
applications you come
across to the existing cat-
alogue, and these  will
show up in the listings
once they’ve been
approved by the site
administrators.

The site allows users
to add more details to
reviews of apps, too, so
you can add screenshots

and give more detailed descrip-
tions of the apps listed there.
Having said that, the short
descriptions are illustrative
enough to tell you enough about
the site you’ve found.

New-age Wonders

Sparking your imagination with Web apps

Digital Tools l 3 Incredibly Useful Sites

Browsing through social news sites can be so boring when you do it
every day. Fret not—the grand-daddy of all social news site aggre-

gators is here: PopURLs, the place to go to if you want your news con-
tent aggregated in one place. The site shows you content from the most
popularly subscribed RSS feeds on the Web—from Digg to Del.icio.us to

Google News. You can play around with the customisation
options, like changing the background colour and layout of
the displayed feeds. You can choose to turn off video and
image feeds from sites like Youtube and Flickr. The Story
Preview feature can be a irritating; thankfully, it can be
switched off. Another smart little feature, aptly named “buzz
mania,” increases the content on the page by showing you
double the number of feeds on the front page. You can visit
the WAP version of the site at http://popurls.mobi. Hooked to
your RSS reader and want a place where you can get every-
thing at a glance? This is where you should head to.

SimpleSpark.com 

PopURLs.com 

The grand-daddy of social news site aggregators

DIGIT AUGUST 2007

TagTag.com 

Ever tried building a WAP site for yourself? The best
place to make those swanky little sites that load off

mobile phones, of the type you’ve always wanted to
make, is at TagTag.com.

A name synonymous with WAP sites, TagTag.com is
the one-stop shop for all your WAP-site-building needs.
An online, Java-based WAP site builder can be accessed
from the site.

Once you’ve created an account, you can browse
through the 20,000-odd members’ WAP sites hosted at
TagTag.com. You can visit your new WAP site at
http://tagtag.com/[username]. It is then tagged under a
specific section
such as
“games” or
“ p e r s o n a l
p a g e s ” — yo u
get to choose
from 21 other
categories. 

The WAP
site maker has
a simple graph-
ical interface,
like the type
you see when
composing an
e-mail: it lets
you change the
background image and colours on the site. You can add
hyperlinks and images, and make an unlimited number
of pages, too. There’s no need to learn to code in WAP,
WML, or XHTML. Each WAP site is allotted 1 MB of Web
space, which should allow you to host approximately 30
full ringtones, for instance.

TagTag.com offers a free WAP emulation browser
called TTemulator, which can be used from a PC to access
WAP sites. This application can be added to pages of other
Web sites too.

The site also offers a lot of free content—a collection
of games, wallpapers, and ringtones—from its PC-based
Web site.

Building your WAP site was never so easy

Asfaq Tapia

Getting things done without the hassle, thanks to Web 2.0
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This isn’t Bhutan,
where people leave
their doors open all
the time. Robbers
and burglars exist
here. Does raising a
dog for securing
your home make
sense… or should
you ditch Man’s
Best Friend and
install a security
system?

Since Caesar falls asleep sometimes, we installed a
security surveillance video phone at the front door and
intrusion-detection alarms on the windows. I now have
odd-looking boxes all over the house, not to mention a
Rs 12,000 hole in my pocket.

Returning home from work, I now have to speak to
mom on the video phone at the gate before getting
inside. Not good if she’s had a bad day. Sometimes she
even sends me on the occasional errand. I don’t like it.

Opened a window in my room, and a false alarm
was activated. A ruckus ensued; peace was restored
only after several calls to the technicians.

Sleeping at night feels better now. I know the
systems are working all the time—let Caesar sleep!
But old habits die hard, and I sometimes end up
checking the systems in the middle of the night.

The monthly maintenance charges for cleaning the
video camera and checking the alarm system wires
amount to Rs 600, and the electricity bill has gone up
by about a hundred.

I pity the burglar who can’t read this... ...and the one that disregards this

2

3

4

For use at home, the security systems were just too
problematic. Waiting at the door for your mom to

answer the phone is plain annoying. If you go in for a
cheaper, minimal security option, like just a video phone at
the entrance, or intrusion-detection alarms on the windows,
you aren’t fully protected. And don’t forget the Rs 700…

Having Caesar around is complete joy. This might not
sound too rational,  but the experience of raising a dog
compensates for security-related worries. No security
system will bring you your morning newspaper, all sloppy
and wet. And unless you live in a mansion, a dog can guard
your house from all things human, animal and alien.

OLD
WAY

TECH
WAY

Security Meter: 4

Emotional Meter: 8
Security Meter: 9

Emotional Meter: 0

And 
The

Winner
Is...

Asfaq Tapia (asfaq_tapia@thinkdigit.com)

Being paranoid, I take a quick walk around the house
at night to check if everything is OK. Caesar is fast
asleep… not good, but every dog has his night.

5 Caesar has been sick just once, and I don’t like to
term the vet’s charges “maintenance”—what’s Rs 700
in return for a friend with a cold, wet nose?

Home Security

Thanks to Caesar, the front door is always open
when I return home in the evening; he barks at
uninvited guests, as is the habit of most German
Shepherds. Moreover, he usually sits near the door,
so there’s this sense of security.

We have had Caesar, our German Shepherd, for
the past one year. It might sound insensitive to
calculate what it costs to feed him… but he
practically eats from our table. So cost: negligible.

Caesar guards the house not only from burglars but
also from other furry creatures. Since we have had
him, we haven’t heard from the monkeys that used
to pillage the kitchen for a late-evening snack.

1
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Samir Makwana

Linus Torvalds, the father of Linux,
adopted the penguin, nicknamed
Tux (because penguins look like

they’re wearing tuxedos), as the Linux
mascot. Tux was later adopted by the
Linux community as the mascot of the
Linux kernel, and that’s what the major-
ity of people associate Linux with.

The Linux kernel, which started off
life as a hobby of Torvalds’, had 10,000
lines of code, and was released under
the public licence. The open source
community has been actively involved
in the development and support of
Linux. Today, many Linux distributions
for specific use are available for free or
commercially, with software packs
bundled to meet users’ requirements. 

Commercially-available Linux OSes
include Red Hat Linux, Novell’s SUSE,
TurboLinux’s Fuji Linux, BOSS Linux,
and many others. A large number of
community-driven Linux flavours is
also available worldwide. 

Why Linux?
Why not? Linux is a robust, flexible,
and transparent open source operating
system. The Open Source Software com-
munity provides a variety of software
packages to be used with Linux OSes for
specific purposes. Many Individual
Software Vendors (ISVs) offer software
packages with Windows integration
and after-sales support. 

Support for community-driven
software is available from members of
the community. Linux is freely modifi-
able; it can be tweaked for optimum
performance. It also offers flexibility
and interoperability with several pro-
prietary OSes.

Across the globe, the use of Linux
within the business segments—as well
as governments—is spreading at an
unprecedented rate. Search giant
Google has several terabytes of data in
its index: it uses 3,500 Linux comput-
ers to respond to search queries and
index pages from the Web. Besides
that, corporate giants including com-
puter OEMs (Original Equipment
Manufacturers), banks, online shop-
ping portals, and many other indus-
tries use mission-critical applications
on Linux-based servers.

Scene India
The trend is currently a gradual

shift towards Linux. It’s happening
in too many cases for us to ignore it.
The best example would be that of the
Life Insurance Corporation of India:
they shifted their IT requirements onto
Linux servers in 2005. After saving Rs
20 lakh by using free software, LIC
expects to soon have more than
1,00,000 computers running on Linux. 

Indian enterprises were indeed ini-
tially hesitant to adopt Linux. It was
used in non-mission-critical operations
like Web hosting. But today, the Indian
corporate sector is playing a major role
in showing the way to migrate to Linux.
Linux has gained a strong foothold in
the server space. According to IDC
reports, Linux servers represented 12.7
per cent of the overall server market,
which is $1.6 billion (Rs 6,400 crore) for
the Q1 2007. Nandkumar Pradhan,
president and managing director, Red
Hat India, states, “The technical capa-
bilities of Linux are growing with tech-
nologies like virtualisation, real-time
computing, security, etc. being built
into the operating system. The aware-
ness of the capabilities of Linux and
open source is growing, and this will
lead to more rapid adoption over the
next few years in India.”

Your passion for Linux can
broaden your future
prospects… 

Tech Careers

Illustration Chaitanya Surpur

Business
Digital

How Technology Can Help Your Organisation

102 Lockdown! 104The Devil Has
Your Data 108 Trend

Master Of Penguins
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Besides the existence of free Linux distribu-
tions, the presence of two major Linux vendors—
Red Hat and Novell—has boosted adoption
amongst Indian enterprises. Many companies
are getting their workforce accustomed to work-
ing with Linux. It offers lower cost of ownership,
a variety of open source software packs, and
support for different hardware platforms.
Different industries, from BPOs and ITES-
enabled organisations to Banking, Finance and
Insurance Services (BFSI) all use Linux for mis-
sion-critical operations.

Linux is now being used for servers as well
as Desktops in enterprises such as AirTel, ABN
Amro, BSNL, Canara Bank, New India
Assurance, UTI Bank, and others. Even the gov-
ernments of Kerala, Maharashtra, Tamil Nadu,
and West Bengal have started adopting Linux in
their offices. 

Opportunity Knocks
The Linux platform is vast and diverse, and
there are ample career opportunities available
for enthusiasts. Technologists supporting open
source—as well as, of course, geeks—believe
Linux is a user-friendly operating system. True,
Linux is indeed flexible—customisable and con-
figurable according to requirement. For that
customisation, professionals who know Linux in
and out are in high demand. 

Linux “fanboys” and active members of the
open source community in general have a natu-
ral ability to fix problems as they occur. The fact
is, it takes an enthusiast—or at least a very inter-
ested mind—to dabble in Linux. 

Enterprises with different businesses and
goals will have different IT requirements for
their business operations. For instance, the
requirements of mobile payment services like
PayMate would be different from those of the
online payment services offered by HDFC
Bank. Both require their software applications
and database to be accessible to their cus-
tomers or clients. Handling such environ-
ments demands the Linux professional’s good
analytical and logical skills coupled with
inquisitiveness of mind.

Linux, in terms of career opportunities, can
offer jobs in the areas mentioned here. Suitable
education and training is required in any area,
but don’t underestimate self-learning through
practical application which is as important, if
not more so, than the former.

Tech Support / Help Desk
Support for Linux is not easily available; not
many certified professionals are available for
tech support. Demand of Linux tech support
professionals lies in providing solutions across
the spectrum from installing, optimising, trou-
bleshooting, and code debugging of Linux
installations. It also includes any maintenance
and support work on the computers of a compa-
ny. Knowledge of different Linux OS flavours
and widely-used open source applications such
as the OpenOffice suite is expected from them,
along with good hardware competency.

Programming Software
Development
Software development on the Linux platform
is very different from that for Windows.
Programmers for Linux have to write code
such that the application is interoperable with
Windows or other platforms. Programmers
with proficiency in languages like C++, JAVA,
Perl, Ruby on Rails, and Python for Linux fit
this segment. There are companies getting
into development of cross-platform software
packages that are used in Desktops and even
mobile devices. 

Web Development
Many Web hosting companies rely on Linux-
based servers for hosting their Web site, data-
bases, applications, and other development
work. A sizable requirement for Web develop-
ers on the Linux platform exists. At present,
demand for LAMP developers is high. LAMP
stands for “Linux, Apache, MySQL and PHP”.
Besides this, candidates proficient with Web
technologies and in programming as well as
scripting languages like Perl, Java, Ruby on
Rails, and Python can choose to enter the Web
development domain.

Saravanan Arumugam, Founder & CEO,
Lynus Academy, which imparts training for
Linux and open source software, speaks about
the scarcity of Web developers for Linux: “A
large number of Web development companies
today suffer from a scarcity of Linux profession-
als holding the LAMP certification.”

Kernel And Device Drivers
Development
Areas like chip designing, embedded devices
and systems, embedded Linux, etc. require
programming of the Linux kernel to work in
real-time. Therefore Linux distribution meant
for real-time programming and operations
such as VxWorks, RT Linux, and others are
used to perform specific functions and devel-
op device drivers for chips for embedded
devices. These programmers should be com-
fortable working with hardware languages
such as Verilog and VHDL for Real-Time Linux
design / model development.

“A high demand for Linux professionals is
observed in applications development and
device drivers for Linux-based systems,” says
Naresh Shah, Managing Director, Novell India
Development Center, the second-largest R&D
centre for Novell worldwide. 

What They Do, What They Are

Designation
Linux System Administrator
Linux Network Administrator
Network Security Engineer / Analyst
Technical Support Associate

Database Administrator
Software Engineer

Functional Area
System Administration, Network
Administration, Network Security, 
Web Server Administration 
Desktop Management and
Maintenance
Database Administration
Linux System Development 
Kernel Development 
Device Driver Development 
Application Development
Web Application Development

We prefer
individuals who
are passioate
about Linux /
Open Source and
choose to work on
these technologies
as part of their
academics”

Naresh Shah
Managing Director
Novell India
Development Centre
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System Administration
Here, it’s no different from system administra-
tion for Windows / UNIX / Mac. Although it
comes under Linux, it is a broad area with a lot
of options for super-specialisation. The system
administrator’s functional area is vast; he
might have to perform the functions of com-
puter maintenance, network administration,
network security, platform migration, system
analysis, and so on. A system administrator for
Linux is responsible for installation, trou-
bleshooting, and maintenance of IT hardware /
software for the Linux platform by providing
on-site administrative support to several
departments in an organisation.

For the Linux platform, a good system
administrator should necessarily have exhaus-
tive knowledge and be capable of working
cross-platform, that is, Linux, Windows, and
UNIX variants. 

Cluster servers consist of independent servers
having different OSes to work together for higher

performance.  With cluster servers and virtuali-
sation technology becoming popular, administra-
tors are required to manage these as well.
Demand for such professionals is expected to
shoot up as many enterprises shift to Linux. 

Network Administrators And
Security Engineers
Network administrators are responsible for
installation, configuration, and analysis of com-
puter networks in an organisation. Their daily
activities include troubleshooting of network
problems, reducing network bottlenecks, moni-
toring the network, and securing it. A Linux net-
work administrator plays a crucial role in any
“Linux-enabled” organisation.

But Linux network administrators are essen-
tially required for security of data at data cen-
tres. Confidential information is safeguarded
with regular backups, ensuring secured connec-
tions, etc. Network security engineers work
upon testing, configuring firewalls, and moni-
toring data flow. Hacking can be made next to
impossible if proper security mechanisms are
employed by the network security engineer.

Database Administration
Database professionals who hold certifications
of a particular database environment may well

opt for specialisation in that environment on
the Linux platform. Professionals already hold-
ing certifications from vendors like Oracle and
SAP will have to acquire certifications of using
database packages in cross-platform environ-
ments. The database vendors also offer mod-
ules for those already certified in Linux.

Web Server Administration
Candidates with a good knowledge of Web
applications and Web hosting servers are suit-
ed best for this kind of job. The main job of the
Web server admin is to maintain the Web site
server(s) and hosted Web apps to ensure site
responsiveness. Good understanding of dealing
with HTTP requests and responses through the
TCP/IP protocol suite is expected from Web
server administrators. Here, a knowledge of
basic programming and scripting is also
required so as to be able to work in different
server environments including Linux.
Experience of working on any of the popular
servers like Apache, MySQL, Microsoft SQL
Server, Windows Server 2003, and Microsoft
Exchange 2000 Server is necessary.

Training
The industry needs people with strong Linux
basics to train others working with it. Trainers
are hired for corporate training, educational
institutions, and governments. Organisations
that offer training services as their core busi-
ness operation are major employers of Linux
trainers. Training is a well-paying option.

Being a freelancer or consultant for any of
the above-mentioned career paths is also a well-
paying option. Organisations shifting to Linux
consult Linux specialists for specific purposes,
such as installing a Linux server for their day-to-
day operations. Yet, like freelancing options in
other fields, it depends upon how one has net-
worked and is recognised amongst peer groups.

Remuneration And The Growth Path
Organisations across industries follow their
own policies in assigning designations and
promotions, and offering remuneration. The
functional areas in Linux can be divided into
the top, middle, and bottom levels.
Designations like “Junior Programmer,”
“Assistant System Administrator,” etc. are
assigned to Linux professionals. In organisa-
tions that have employees for both the Linux
and Windows platforms, the platform tag is
carried separately after the designation.

The average time taken to grow level-wise is
approximately three to five years for any func-
tional area. And like in any other occupation,
salaries are offered based on qualification, per-
formance, and project contribution. (Refer
Table Remuneration)

In terms of hard skills, organisations look
for skills specific to the employee’s functional
domain. So for application developers, what
matters is knowledge of tools, programming
languages, any applications developed, period
since the candidate has been developing pro-
grams, etc. Soft skills are invariably important.
Hands-on working ability with computer 

Approximate Remuneration Matrix 

Entry Level
Rs 15,000 - 35,000

Rs 8,000 - 16,000

Rs 15,000 - 35,000

Rs 12,000 - 30,000

Middle Level
Rs 35,000 - 50,000

Rs 18,000 - 35,000

Rs 35,000 - 60,000

Rs 35,000 - 50,000

Top Level
Rs 60,000 - 83,000

Rs 40,000 - 60,000

Rs 70,000 - 1,00,000

Rs 60,000 - 75,000 

Department
System Administration /
Network Administration /
Web Server
Administration
Tech Support / Desktop
Management and
Maintenance
Device Drivers for
Embedded Systems and
Kernel Development
Applications
Development

All figures mentioned above are per-month, aggregated, and indicative.

Being a freelance
or consulting
trainer in Linux is
also a well-pay-
ing option
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systems, servers, and other hardware serves as
an add-on.

Education And Certifications
In the case of Linux, very few people—referred to
as self-proclaimed geeks—would have landed
decent jobs without formal Linux education,
training, or qualification.

“Most organisations prefer to hire experi-
enced candidates. For example, Linux certifica-
tion is a must for system administrators, and for
developers, a good programming background is
required,” informs R Krishnan, Executive direc-
tor at Aptech, who provide computer course-
ware, IT education, and training.

It is today advisable to choose courses
offered by Linux OS vendors—Red Hat or Novell—
and select certifications modules in accordance
with your area of interest. You could go the self-
learning way, using the freely-available Linux
OSes, but bear in mind that certification is
always preferred.

“Students from engineering backgrounds
with an exposure to working on Linux are con-
sidered the perfect fit. It’s a proven hypothesis
that students from mathematics and statistics
backgrounds make good programmers,” avers
Raj Ganti, CEO, SQL Star International, who are
involved in providing high-end IT training to
aspiring and practising IT professionals as well
as  corporate executives.

Vendors such as Red Hat and Novell, who
offer their Linux OSes for enterprises, have cer-
tification courses for individuals as well as pro-
fessionals. Visit the vendors’ Web sites for
detailed information about the certifications
offered:
Red Hat India: www.redhat.in/training/
Novell India: www.novell.com/training/
IBM: www-03.ibm.com/linux/va_3261.shtml
Sun: www.sun.com/training/catalog/operating_sys-
tems/index.xml
Oracle: www.oracle.com/global/us/education/linux/
training.html
Turbolinux: www.turbolinux.co.in/solution_service/
training.html

Courses are offered at three levels—Certified
Technician (Beginner), Professional (Intermed-
iate), and Administrator / Engineer (Advanced).
Structured programmes are available through
training partners. Courses by these vendors do
cover cross-platform environments.

The learning process doesn’t stop after
acquiring the necessary certification. “Well-
structured programmes help in getting the
basics right, which are very important in any
case. But the fact is that 80 per cent of applica-
tion and learning happens on the job. One has
to attend to problems and client queries, and to
troubleshoot, efficiently, which is possible
through constant learning and its practice
through implementation,” says Jeet Patel, who
works as Tech Support Analyst (Linux) with a
multinational company.

The Employer’s Expectations
Initial training includes induction and expo-
sure to the workflow of the company. As
required, organisations prefer Linux profession-

als to attend to and give exams for the struc-
tured programmes offered by the principal ven-
dors—Red Hat, Novell, Oracle, Sun, and IBM.

“Employee training programmes are very
important to keep the Linux professional
updated, and in the long run, to meet client
requirements. The initial training is imparted
for period of three to six months, based on the
domains in which they work. Corporate train-
ing sessions and classroom training 
programmes are organised for skill-
enhancement of the candidates in their
domain,” says Saravanan. 

Vendor companies like Oracle and SAP for
database packages, Sun for server networking
and security, and Sun for Java offer structured
programmes for those interested in working on
Linux in a particular area. A certificate of atten-
dance, besides the certification of passing, is
indeed offered by these organisations.

“Holding a certificate of having attended a
structured programme—and a certification of
passing—adds value to a candidate’s profile.
Also, it makes it easier for an employer to short-
list candidates,” says Ganti. 

Despite the fact that the demand/supply
gap for Linux professionals is very high, cer-
tain unsaid rules for enthusiasts prevail. The
most important and basic rule is, don’t take up
Linux as an option just to make money. A pas-
sion for constant learning is extremely impor-
tant. Do not get blinkered by billion-dollar fig-
ures of future opportunities. It’s therefore a
crucial decision at the outset; always think
about learning and growth, otherwise you
might just end up with a monotonous job with
negligible future prospects.

A Few Parting Words
Various activities now rely on Linux. Recently,
Dell started selling Desktops and laptops with
the Ubuntu f lavour of Linux pre-loaded.
Research firm IDC (International Data
Corporation) estimates that the Indian Linux
market will grow at the rate of 21% annually,
to Rs 91.5 crore in 2010, mostly for services.
Server shipments rose by 15.3% globally in the
fourth quarter of 2006. The server space is
responsible for the biggest pool of opportuni-
ties today. 

According to a forecast by ABI Research,
commercial Linux OSes will be enabled on more
than 1.3 crore mobile devices globally by 2012,
up from 81 lakh in 2007. 

These figures indicate future requirements,
but the reality is that an average Linux aspirant
could face stagnation in his or her career graph
after reaching the middle level. This could be
combated by constant learning and upgrada-
tion of one’s skill-sets.

Expertise in Windows can be gained by class-
room learning, while in the case of Linux,
remember what experience has taught Patel:
“The fact is that 80 per cent of application and
learning happens on the job.”

And so, at the end, geekiness is just the
beginning; if you want to make a career of a pas-
sion, learning should never stop. 

samir_makwana@thinkdigit.com

It is difficult for
a person to
master all core
areas in Linux.
The best option
is to choose a
career path in
Linux and then
specialise in it”

R Krishnan
Executive Director
Aptech
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Nimish Chandiramani

All of us know and love the company file
server. It’s where we dump our essential
data and programs (wink, wink), not to

mention actual work-related data. It’s a way of
ensuring that even if our workstations decide
to go south, all our hard work stays intact. It’s
not even an option—for every organisation with
more than one person, the centralised file
server has been a fixture since the early eighties. 

New Wave
We’re all used to file servers, but for small
businesses, Network Attached Storage (NAS) is
quickly emerging as a much better option.
Dedicated file servers can be expensive: con-
sider the cost of an extra license of Windows
Server 2003 or another support license for
Linux, not to mention the cost of the hardware
to run the OS. In companies where it isn’t fea-
sible to invest in different servers for every
purpose, these file servers double up as
domain controllers, DNS servers or Internet
gateways—much more demanding tasks.
Inevitably, their performance as file servers
begins to suffer, and worse, if they should
crash, they’d take down more than one essen-
tial service with them.

NAS servers are cheaper—mostly because
they use more basic hardware and run a rudi-
mentary operating system that’s built for the
sole purpose of managing storage. They also
support multiple file-sharing protocols, so Win-
dows users can use the Common Internet File
System (CIFS) protocol, and Linux users can use
the Network File System (NFS) protocol, to
access the same data. (Of course, this isn’t really
an issue if you’ve standardised a platform
across your organisation.)

While you can get a basic NAS server for as
little as Rs 8,000 (without the hard disks), the
ones with more features can cost a lot more—
even reaching a ridiculous Rs 35,000! And then,
there’s the option of turning an ageing old PC
into your own NAS server...
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The magic of a
brand new
Network
Attached Storage
(NAS) server with
none of the
monetary pain!

The Devil Has Your Data
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Ingredients
To start with, you’re going to need a PC of
modest configuration. Even a Pentium II with
128 MB of RAM will work for a team of up to
twenty people; you’ll need to consider some-
thing higher for bigger teams. If it’s got a moth-
erboard that supports SATA hard disks, so
much the better. A USB Flash drive is optional
(we’ll get to that in a bit), and you’ll need hard
disks—as many as your board can support, or as
many as you want, whichever is lesser. On this
month’s DVD, you’ll find FreeNAS—a FreeBSD-
based operating system built to manage your
NAS server. Burn the ISO on to a CD and boot
from it to start setting up your NAS server.

Setting Up
Installing FreeNAS to your system is optional—
it’ll do its job just as well running off the CD,
but remember that every time you reboot,
you’ll need to reconfigure the server all over
again. You can’t format or share any hard drive
you install FreeNAS on, so we recommend
installing it to a USB Flash drive instead (be sure

to first check whether your motherboard sup-
ports booting off USB). The installation is a no-
brainer (just remember that your USB disk will
be called “da0”), and in a couple of minutes,
you’ll find yourself being told to eject the CD-
ROM and reboot. Now that it’s installed, you
can consider disconnecting your CD-ROM drive
to make room for another hard disk.

When you boot into your new FreeNAS
installation, you’ll see a very simple console
menu. All you need to bother with here is to
assign an IP address and subnet mask to this
server to get it on your network; your work with

The FreeNAS Web interface—your command centre

Add your disks before anything else
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this particular machine is done. You can now
administer your FreeNAS server from any work-
station on the network, using the Web user
interface—just enter the server’s IP address in
your browser’s address bar and hit [Enter]. The
default username is admin and the password is
freenas—which you should change when
you’re done with your settings.

The Core
The first thing you need to do is add your hard
disks under Disks > Management. Use the +
icon to begin adding your disks. A hard disk
standby time of 30 minutes will give you a
respectable balance between performance and
power savings if your network is going to be
busy; if the NAS box isn’t going to be used too
often, you might even consider pulling it down
to five minutes. You can also decide how much
you want to trade off between performance and

disk noise—very useful if you work in a small,
quiet place where disk noise can become
extremely bothersome. Leave the Preformatted
FS option as Unformatted—you should format
your disks under Disks > Format when you’re
done with this part.

If you have two identical hard disks, con-
sider using a RAID-1 setup: the two hard disks
will appear as one, and data will be written to

both of them simultaneously—so if one disk
fails, your data is still intact. The disadvantage,
unfortunately, is that you lose the extra storage
the second hard disk offers you. To start with
your software RAID, select Software RAID
under File System in Disks > Format for both
the disks. Under Disks > Software RAID >
RAID-1, use the + icon to add a new RAID array;
give it a name and select the hard disks you
want to add. FreeNAS also supports other RAID
formats—for more dope on them, refer to Know
More About RAID in our January 2007 issue.

Spread The Joy
Once you’re done setting up your hard disks,
it’s time to share them with the world. The first
thing to do is mount the disks and give them a
share name, which will let people access the
disk over the network. You’ll find this option
under Disks > Mount Point. The next step is
to create Groups and Users (in that order, under
Access > Users and Groups) who will be
authorised to access the shared drives. If you’re
on a Windows domain, use the Active Directory
option—this will automatically authenticate all
the people on your network using their domain
usernames and passwords.

Finally, it’s time to decide on a sharing pro-
tocol. If you’re on a predominantly Windows-
based network, the CIFS protocol works best.
Your shared drives will show up as regular Win-
dows shares, and any Linux client that wanders
into your network can use a Samba client to
connect to it. On a Linux-based network, the
Network File System (NFS) is a better option—
it’s the native distributed file system for Unix-
and Linux-based networks. 

If you want your server to be accessible over
the Internet, enable the FTP protocol as well,
but do ensure that you disable Anonymous
Logins. You’ll also need to configure your router
to send FTP requests to the server’s IP address.

Beyond
At this point, you have a basic, working NAS
server. You can now customise it—its name, the
admin password and so on—under System >
General Setup. You can even encrypt your disks
for an added level of security.

When you’re through, disable the console
menu under System > Advanced, and discon-
nect your keyboard and monitor from the main
server. To ensure that nobody removes your
USB disk, you could get yourself a separate
front-panel USB attachment, but instead of
attaching it to your front panel, leave it loose.
Connect the drive and then leave inside the
system’s cabinet.

Endnote
One of the disadvantages of FreeNAS is that its
user management is somewhat rudimentary—
it’s either grant or deny. FreeNAS has none of
the depth we’re used to with regular operating
systems. That aside, if you have old hardware
that can’t serve a better purpose and don’t want
to invest in a new server, FreeNAS is the perfect
storage solution for your network. 

nimish_chandiramani@jasubhai.com

If you’re on a
predominantly
Windows-based
network, the
CIFS protocol
works best

Your shared disks can be accessible through various
protocols—even FTP

Set up a RAID array to protect your data better
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“At Sun, the first step in being eco-responsible is the “greening” of
our business, or minimising the environmental impact of our
operations. We are determined to integrate eco principles into

every aspect of our operations. We will implement a thin-client IT
architecture, where processing takes place on the network. In all, Sun has
facilities to significantly reduce both power and materials consumption.
We are making data centres smaller and more energy-efficient so they
will emit less carbon and cost less.

It is definitely feasible and absolutely necessary for others to take such
steps. A joint effort by all the companies in the industry will go a long way
in ensuring that the negative impact on our environment is minimised.
Efforts by one or two corporates will have limited impact.

There has been recent research by IIT Delhi along with Sun India, and
according to their recommendations, the Government should enforce
energy conservation steps by IT communities such as tax incentives and
guidelines that motivate computer professionals to purchase energy-
efficient components, foster voluntary industry efforts to develop energy-
efficient computing products, and engage in public / private partnerships
that highlight the cost benefits of energy-efficient data centres.

“Intel takes various steps to ensure
environment-friendly computing. At
our conference centre in Bangalore, we

have motion detectors that switch off lights
when no one has been in the room for more
than ten minutes. We don’t have Desktop
computers at Intel—laptops consume less
electricity, which again is good for the
environment. We have stringent e-disposal
policies applicable at our offices the world
over. Before we dispose of a computer, we see
if it can be used in other departments. If it
isn’t, we donate it to an NGO. If the
computers are not working at all, we scrap
them with a vendor who adheres to our
stringent disposal policies.

Every corporation should have policies for
environmentally-friendly computing:
disregarding this will come back in the form
of deteriorating employee health, increase in
costs, and so on. Yes, there is an investment
required, but it pays off in the long run. 

The government should have policies
pertaining to this, but organisations should
follow environment-friendly practices
regardless. In addition, making employees
aware of the big picture of their actions helps
more than dictating policies.”

Rahul Bedi
Director, Corporate Affairs
Intel South Asia and India
Business Operations
Manager

Arnab Roy
GM - Marketing 
Sun Microsystems India
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What are technology companies doing to be environment-friendly? Should the
Government enforce policies on them to make them go along those lines?

Companies
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Vimal Khanna 
General Manager (India)
NetXen

“At GLOPORE, we avoid taking printouts for internal
communication; even most of our outside communication is
done through e-mail. At a higher level, we have communicated

to our employees to switch off monitors when not in front of the
computer; this helps us save electricity. Our systems at the office have
LCD screens, which again contributes to saving electricity. We also
prefer to give laptops to employees for this reason, besides the
advantages of portability.

The monetary savings thanks to such practices aren’t much, but we
have not set them for monetary gain. It is our contribution to the society
and the environment. 

Other companies can replicate our conservation methods, and I
think even minor changes in policy can bring about a huge difference.

We don’t face any difficulty in enforcing these policies—employee
awareness works well, and once employees develop these habits—such
as switching off monitors and so on—they continue to implement
them at home, too.

Satish Kumar
CEO
GLOPORE IMS 

“At LG, our vision is to reduce energy costs by 20 per cent every year. We
have set our ACs to run at 24 degrees Celsius, the “green temperature,”
and this reduces electricity consumption. Wherever possible, we use

natural lighting. There is a team to ensure that employees switch off all lights,
ACs, laptops, and PCs. If they leave any devices on, a reminder note is put on
their desks as well as on their team head’s desk. At the factory, we have double-
glazed windows that allow for maximum natural lighting. LG has also installed
a solar water heater with a capacity of 5,000 litres. To reduce the running cost
per day, we have brought about various innovations in the factory that have
reduced resource intake by 50 - 70 per cent. A rainwater harvesting system has
been installed for efficient use of water. 

Other organisations should implement similar steps. It isn’t just
environment-friendly, it indirectly increases the brand image of the company
and also motivates employees. 

The Government should enforce implementable policies, and for some, they
should make suggestions. The Government should also create awareness among
industries.

It is difficult to enforce certain policies in the face of resentment—it took us
four to five years to get to the stage we are at now.

Dr Y V Verma
Director - HR & MS
LGEIL

As told to Prakash Ballakoor (prakash_ballakoor@thinkdigit.com)

“We understand that conservation of electricity is important,
and to reduce power consumption, we are moving to newer
server systems. These new servers don’t just consume less

power; they easily handle the load of three older servers. 
Employees have also been asked to switch off computers when leaving

the office. We have separate air conditioning for each department, so if
there are no employees in a section, the AC can be switched off. 

It is quite feasible for businesses similar to ours to adopt policies like
the ones we have. I believe small steps towards conservation by each
organisation will make a huge impact on the environment.

I don’t think the government should enforce policies for
environment-friendly computing, but they should make
recommendations.

It is not difficult to change the mindset of employees because they
understand the implications of wastage.

Going Green
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Prakash Ballakoor

Advancements in hardware compel one to
upgrade one’s system every three years or
so. When upgrading, what do most people

do with their old PCs? Sell it for peanuts. Newer
systems can be cheaper by 30 to 50 per cent than
systems bought just a couple of years earlier, and
can be twice as fast, thus forcing one to sell the
old system at less than a fourth of the original
price. For example, around two and half years
ago, a Pentium IV 2.4 GHz with 512 MB of RAM
cost Rs 28,000 to 32,000; now, you can get a
Pentium Core Duo or Pentium D 2.8 GHz system
for Rs 13,000 to 15,000.

Unhappy with what’s being offered for the old
system, some find it fit to dump it in the attic,
happy in the knowledge that one still owns the
system! Others just throw it away. 

There’s another option we rarely consider:
donating computers to people who really need it.
We’re talking about unprivileged children and
youths who would like to work at a computer and
get to know what computers are all about, but for
lack of money and knowledge, cannot do so.
Apart from computer education, there happen to
be other areas where organisations would
appreciate the donation of a computer.
You—like anyone else who has a computer—
can help when the time comes to upgrade.

Education First
Cash-strapped NGOs are trying hard to
procure systems. As Amita Chaurasia,
who works as documentation in-
charge at Pratham—a Mumbai-based
NGO—says, “Computers excite chil-
dren’s fantasies, and have
become a vital tool to attract
underprivileged children to
education.” Echoing this,
Imran Pathan (9), a student at
Pratham, says, “My computer
is really beautiful. I like it a lot.
It has lots of games. I am a
champion at Gaddivali.” Imran is
talking about games, but that’s
only the beginning. Having

Technology Beyond Work
Leisure
Digital

realised the potential of computers in education,
several NGOs such as Pratham (www.pratham.org),
United Way of Mumbai
(www.unitedwaymumbai.org), ChildLine India
(www.childlineindia.org.in), Aarambh, and Hamara
Foundation have introduced computers into
their educational programs. 

Pratham, initiated by UNICEF in 1994, is a
community-based grassroots organisation that
promotes the education of underprivileged chil-
dren in India. This NGO, headquartered in
Mumbai covers 21 states, with over a million chil-
dren under its care. Pratham’s programmes
include “Computer Assisted Learning” in munic-
ipal primary schools, government assisted
schools, and community centres in slums. Serv-
ing over 25,000 children under this programme,
the computer provides a perfect tool to Play And
Learn. Pratham has a software team that creates
maths and language games in local languages.
Nabbi Shaikh, 11, says, “My teacher teaches me
new things on the computer. The computer has
maths games which I learn and teach others. I
want to be a computer teacher when I grow up.”

IBM has donated four specially-designed
computers at the drop-in centre at Baiganwadi in
Mumbai in support of the programme. The

Baiganwadi area is close to the biggest
“dumping ground” in Mumbai, where thou-
sands of tons of garbage are generated. This
is the home of many children. Pratham
found it a big challenge to convince the chil-
dren to bathe, rest, engage in recreation, and

learn. They also found it tough to sustain the
children’s interest in reading and learning

activities. With the advent of computers
and interactive learning programs,

Pratham was amazed how the chil-
dren were eager to operate the

machines. When the computers
were installed, the children
became adept at using the
systems, especially the maths
and language games. 

Pratham says they have to
date had more than 2,500 chil-
dren availing this facility. Chaura-
sia says, “The need for computers
exists in all our facilities, and there

133121Behind The
Screen
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Anonymous114 Game On

Touched By Tech

Imaging Shrikrishna Patkar

Generosity 2.0
Donating old computers not only reduces e-waste, it can also improve someone’s life
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is huge shortage of good working computers.” The
NGO has 13 computer centres with 10 PCs each in
Mumbai municipal schools, and three computer
centres in Delhi municipal schools with six PCs
each.

If you want to donate your old computer to
Pratham, you can drop it at your local Pratham
office, whose address can be found at
www.pratham.org/contact/indian_inter.php. You can
also call the local Pratham office, and they will
pick up the system from your home.

Helping To Help
United Way of Mumbai is an NGO that accepts
community investments from corporates, and
from corporate employees on a monthly basis.

They focus on providing
financial and other assis-
tance to other NGOs who
work in the field of child
welfare, women empower-
ment, community devel-
opment, and disaster
relief. Under child welfare,
United Way of Mumbai
has a program called
“Computer Pool,” where
one can donate old
computers. This project
was conceived to equip
NGOs with computers in
order to stay efficient and
competitive: NGOs the
world over are unable to
get basic office equipment
due to lack of funds—
United Way of Mumbai is
trying to address this.

Charu Jain, program
manager, says, “The
response to this program
has been good, but during
the initial stages, we were
getting a lot of computers
that didn’t work and
needed repair, which was
expensive.” They now

accept PCs only after reviewing its configuration:
visit www.unitedwaymumbai.org/CompNGOs_Donate
.asp to fill up the form. Donated computers are
distributed to NGOs that have sent in requests for
computers. United Way has donated computers to
NGOs like Hamara, Aarambh and ChildLine India.

Helping Amidst Chaos
The ChildLine India Foundation, set up in 1996, is
the country’s first toll-free tele-helpline for street
children in distress. It operates in 75 cities, and
has responded to over 12 million calls from all over
India. ChildLine uses computers to run software
called ChildNET, which was developed by Tata
Consultancy Services, to record and report distress
calls. Since ChildLine only has one toll-free
number, 1098, it receives thousand of calls a day;
it is difficult to store and retrieve the data without
a proper mechanism in place. Computers play a
vital role in the process of analysis, storage,
retrieval, and reporting. Nishit Kumar, incharge
of Awareness and Advocacy, says, “The call analy-

sis that we generate contains city-wise reports of a
number of cases of child abuse, missing children,
child labour, sexual abuse, needed medical atten-
tion, and victims of natural calamities.” This is
then discussed with the local advisory board
comprising decision-making authorities—like the
city commissioner, the concerned ministers, state
ministers, the judiciary, the police, NGOs, and the
media of the city in question. Plans to address
these problems are chalked out and corrective
actions are implemented. One can get in touch
with ChildLine India Foundation at dial1098@child-
lineindia.org.in or nishit@childlineindia.org.in. 

Education Towards Employment
There are NGOs that cater to one locality or city;
Aarambh, for example, helps with the educational
and psychological needs of children who drop out
of education in Navi Mumbai. Aarambh provides
vocational training like screen printing, filing
papers, making paper bags, and computer courses.

Aarambh conducts a basic three-month course
for youth who have matriculated, and help them
get further training with small offices and profes-
sionals. To date, they have trained over a hundred
individuals. Shobha Murthy, founder and trustee
of Aarambh, says, “Many offices employ young
boys and girls as assistants for odd jobs like clean-
ing, and assure them their jobs would be upgraded
in terms of salary and post once they have
acquired basic computer knowledge. While some
recently-matriculated trainees have opted for
further studies, there are many who have taken
up jobs. We think the future looks bright for these
children.” Aarambh has four computer training
centres in the midst of the slums of Navi Mumbai,
and all the 15 computers are old ones in working
condition, donated by corporates and banks.

A computer can be donated to Aarambh by
calling them at 022-27680965; they will pick it up
from your doorstep. Better still, you could drop it
off at one of their computer centres, which can
be located at www.aarambh.org/Funding.html; this
way, you can see your computer being set up in
the centre and even used by the students.

Other NGOs that accept old computers
include Samarthanam and Pratham in Mysore
and Bangalore, Deepalaya in Delhi, and Azad
India in Bihar. We’d like to encourage you to find
one such NGO in your town or city.

A Concluding Note
One needs to remember, though, that old comput-
ers to be donated need to run a workable OS like
Windows 98 or Windows XP. Computers that need
repair also should not be donated; they are more
of a burden than a gift. It would be a very good
idea to get the system repaired by yourself first.
Prof Asha of Hamara Foundation also tells us, “We
don’t want computer parts; it is expensive to get
the rest of the parts and build a complete system.”
Go that extra mile and give something of value!

Wanting to help a social cause is a noble senti-
ment. We hope we’ve convinced you that donat-
ing your old computer is quite the best use you
can put it to. You might not literally see how it is
being used, but you can be sure it’s changing the
life of someone, somewhere. 

prakash_ballakoor@thinkdigit.com
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Remember that
computers in
need of repair
are more burden
than gift

Children getting their computing dose at Pratham

Navi Mumbai’s Aarambh helps school drop-outs
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A
fter last year’s Legend, our faith in the Tomb Raider
franchise was restored—new developers Crystal
Dynamics brought us a highly enjoyable, if short,
action-packed adventure that still stayed true to Tomb
Raider’s original puzzle-solving philosophy. This time

round, they’ve resurrected the 10th Anniversary Edition of the
game, abandoned last year by the previous developers. The
game follows the same storyline as the very first Tomb Raider,
but is built on Legend’s engine.

If you haven’t played the first game (it was eleven years ago,
after all), here’s what you need to know: Lara’s on the hunt for
the Scion of Atlantis, a mysterious and powerful talisman (what
else?), torn asunder with pieces scattered all over the world.
Her quest will take her from Peru to Greece to Egypt to heav-
en-knows-where-else, she’ll have to deal with plenty of
unfriendly wildlife, smart-mouthed mercenaries, and race
against another rival archaeologist in the pay of the devious
Jacqueline Natla. Just another day at the office.

Legend-ised
Tomb Raider Anniversary (TRA) gives you the same, enjoyable
gameplay as Legend—Lara’s moves are fluid, and the control
system lets you execute a series of moves quite quickly without
fumbling. Her grappling hook is back, and is much better-
utilised this time round. I’ve had a bunch of issues with the cam-
era angles—most notably at times where you get the feeling you

OLD TOMB, NEW

Even the best fumble sometimes Hmm...it’s interesting what a really powerful sneeze can do
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have to jump, but the camera hampers
you from finding out where exactly you
have to jump to.

The game’s also riddled with check-
points so you never really have to save your
game, but this also has the potential to be
an annoyance—if you backtrack, walk into
a checkpoint and die, you end up undoing
all the work you did before backtracking. 

I liked the direction that Legend took
the franchise in—more action made it a
lot more entertaining—but TRA turns its
focus strongly on puzzle-solving. The rare
dose of action that you do get from the
few enemies isn’t much—they’re freak-
ishly dumb: bears who can’t climb stairs,
for example, and are quite content stand-
ing around while you perch on high
ground and finish them off at your
leisure. One nice touch is the Adrenaline
Dodge, which lets you dodge charging
enemies with a bullet-time effect, though
you end up hardly using it due to reasons
quoted in the previous sentences.

The environments are large—massive
at times—and puzzles are spread out
across them. This can get pretty confusing:
you’ll find yourself solving (or choosing not
to solve) mini-puzzles only to realise much
later that they were part of a much bigger
picture. This can get pretty frustrating if
you don’t realise the big picture quickly
enough, but is quite exhilarating when you
have your Moment of Realisation. 

TRA’s huge environments lend them-
selves to a fairly boring feeling of soli-
tude—you encounter other life forms very

rarely, and unlike in Legend, you don’t
have the banter between Croft and her
assistants to keep you entertained. It’s
just you and the puzzles. It gets so boring
that you’ll soon want to befriend the odd
wolf, if only the blasted creatures would
stop trying to kill you.

The Croft Manor is back too, so when
you’re done with the game, you can spend
some time in Lara’s family home solving
more puzzles and unlocking rewards—
including cheats and new outfits for Lara.

TRA looks fetching, and it’s a
humungous joy that it’ll run just fine even
on my now-ancient NVIDIA 6600, but it
doesn’t seem to exploit newer, more pow-
erful cards like we’d have expected it to—
our monstrous 8800 Ultra seems wasted
on it. Still, keeping in mind that there are
many people who don’t jump at the lat-
est graphics card the second it comes out,
you can enjoy the game without shelling
out for new hardware. 

Final Thoughts
TRA isn’t as much fun as Legend—it sadly for-
sakes the action and intensity that we saw
with the latter: one of the caveats of remak-
ing an old game, I guess. The puzzles, how-
ever, are very well-designed, and while chal-
lenging, aren’t especially tough—at no point
did I find myself completely lost. It’s also
longer than Legend, so the fun doesn’t have
to end prematurely. Give it some well-
deserved space on your Lara Croft shelf—if
nothing else, it’s miles ahead of the original.

nimish_chandiramani@thinkdigit.com

All right...who hit the big red button on the time machine? I may not have textures, but I’m still cooler than you

Rating: 7/10
Developer: Crystal Dynamics

Publisher: Eidos
Distributor: E-Xpress Interactive

Contact: sales@e-xpressindia.com
Price: Rs 699
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Digital Leisure l Game On

H
ere at Digit, we’ve
been quite happy with
Burnout: Revenge and
Dominator. Slamming
rivals into walls and

pillars and coming down on
their heads from above never
gets tired. Why, then, would
Criterion even bother with a
new title having already
achieved its sadistic zenith?

We had us a little chat with
Alex Ward, Creative Director at
Criterion, to find out for our-
selves. Burnout: Paradise will
naturally be the best-looking
game of the series, but it’s the
new features we can’t wait for...

Some choice pickings:

On Paradise:
What we’re out to achieve
with the new game is to take
the Burnout experience to a
new place.

The main themes of this
development centre around
freedom and freedom to play
Burnout however you would

like to. This is your Burnout at
your pace. Now you are free to
do whatever you want when-
ever you want to do it. We
want to remove the restric-
tions of the old generation of
hardware and break with
many conventions.

Burnout: Paradise is the
biggest open-world game EA
has ever made, with every-
thing open from the start; you
can go anywhere and do any-
thing from the get-go, and
your first hour of play will be
totally different from other
players’. 

I personally enjoyed play-
ing the game Mercenaries,
where I got a kick out of doing
things I was not really sup-
posed to be doing. Burnout:
Paradise offers a similar sen-
sation, exploring the city, play-
ing with different types of
cars, hanging with buddies,
doing massive drifts, jumping
from roof to roof—anything
you can think of.

On The New Features:
Because Burnout: Paradise is a
completely open world, there
is no more jumping back and
forth from menu to go into dif-
ferent race modes.  There is no
such thing as “modes” any-
more—every “mode” is seam-
less, and an extension of your
driving experience.  The state
of driving freely in the open
world is called “Free Burn,”
during which you can drive
around exploring the city and
discovering new areas and hid-
den gimmicks.  At any time
while Free-burning, you can
choose to engage in various
racing experiences:

Road Rules
Each road has a set of best
records for who drove fastest
and who caused the biggest
crash—beat your friends’
scores to rule the road!

Race
Each traffic light in the game
represents a different game,
and you can choose (or not) to
participate in any race with
absolutely no loading time.

Crash
We re-invented this experience
so you can go into crashes with
a push of a button at anytime,
anywhere.  This new crash
experience is called Show
Time.  The objective of Show
Time is to time your crash so
you can keep flying and move
forward, while crashing your
car into a pulp—the distance
you can travel while crashing
will determine your score.

Marked Man And Payback
When playing with multiple
players online, you can decide
to “mark” certain player and
go after him together.  Taking
down a “marked” player will
let you earn a special trophy
as a collectible item.

To be fair to the marked
man, we offer these players a
chance for a comeback by giv-
ing them a special ability called
“Payback.”   These randomly-
chosen abilities include pulling
stunts on other players like
reversing their controls, taking
away their breaks and boosts,
and such—just fun gimmicks to
allow players to have fun mess-
ing with each other.  

Watch these pages for our
review when the game is
released for the PS3 and Xbox
360 in November this year!

nimish_chandiramani
@thinkdigit.com
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A Glimpse Of Paradise

Alex Ward
Creative Director, Criterion
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C
olin McRae: DiRT is
undoubtedly one of the
best-looking car games
for the PC. Unlike other
racing titles, this one

has nothing to do with story-
lines, creating mansions, or
playing fairy godmother in a
fantasy world. DiRT is the latest
and probably the most antici-
pated of all the Colin McRae
Rally releases. It’s one that’s
come out on gaming consoles
alongside the PC.

The entire game is based
around tiers or levels. You make
your way to the end of the game
by scoring points on a tier
through races, time trials, or
super specials. The reason I’ll be
using the term “vehicle” is that
DiRT isn’t only cars—there are
buggies and trucks, too, which
takes the game to an all-new
level! In fact, there are 13 class-
es of vehicles: FWD, RWD, 4WD,
Classics, and more. You go
through plenty of tiers and lev-
els before you finish the game.
When you do complete them you
can dive straight into the multi-
player game on the Internet or
on a local network.

The handling of the cars and
trucks differs a lot from one to
the other. The slower cars, like
the Fiat Punto, are extremely dif-
ficult when you first try them.

They react aggressively to tiny
inputs, which results in you
swinging from side to side hitting
guardrails even on a straight
road. This coupled with wet
roads means you’ve really had
it... The trucks and buggies have
a rather unique, sim-like feel.

DiRT isn’t an easy game to
start with even at the Rookie
level. The damage levels and AI
difficulty increases as you go up
the levels. It takes a while before
you can hold the cars by the
scruff of the neck and throw
them around the place.

Looks-wise, DiRT is fantastic.
The models are well-detailed,
and this can be noticed when you
scrape your vehicle on rocks
alongside the track or into walls,
which results in shedding of pan-
els of your vehicle and exposing
of the insides. Fallen pieces of
mangled metal and other wreck-
age you and other players cause
lie scattered all around the track.
It can become an obstacle course
at times—you need to be careful
not to run over them while mak-
ing a second round through the
track. Dents and folds on the
metal appear when you bang
your vehicle onto something a lit-
tle more solid. The sensation of
holes being pieced into my retina
was proof enough that the HDR
effect was being shamelessly
abused in DiRT.

It’s really bright and dis-
tracting when it’s really sunny
in-game. The tracks are unique
and pretty long as well, which
adds some amount of the
authenticity of rally car racing.

There’s even the legendary Pikes
Peak track!

We substituted our tem-
porarily indisposed 8800 Ultra
with a GeForce 7900GTX on
our gaming rig for this—the
game will make any machine
beg for mercy—frame rates at
1440 x 900 were nothing more
than 20 fps with the quality
turned all the way up, but
without any multisampling.

There are some nice details
in the sounds: the turbo whine
gets louder as the rpm reaches
the peak. Drive under a bridge
or along narrow streets and you
immediately get the audio feed-
back from the change in ambi-
ent environmental sounds.

DiRT isn’t perfect by any
means. Many of the cars have
very odd handling, and the
game doesn’t seem to have
been optimised enough. Once
upon a time, the Colin McRae
series was considered the ulti-
mate rally simulation. Ever
since Richard Burns Rally
arrived in the second half of
2004 and took over CMR’s
place, it hasn’t been dethroned
from its perch, and we’re sad
to announce it still fails. This
isn’t necessarily a bad thing
for DiRT: it’s is great, and can
be really good fun once you
get the hang of it.  I’m sure the
ecstatic crowd of drooling
gamers and non-gamers gath-
ered behind me waiting for
their turn will agree with me
with thumps on the table.

rossi_fernandes@thinkdigit.com

The Road Less
Travelled

XFX GeForce 8800Ultra,
Intel Core 2 Duo E6600, 4
GB RAM, Windows Vista

Ultimate x64, WD 250 GB 

GAMING PC

AUGUST 2007 DIGIT 117



C
ellFactor: Revolution is a
long-awaited game that
its developers insist is
best played with a
physics processing card,

so we got ourselves an ASUS
Ageia PhysX card. The game is
totally free—but unless you own
a PhysX card, you can only play a
couple of missions. Find the
game on this month’s DVD.

CellFactor lets you choose
from three different races—
Black-op, Guardian, or Bishop
(for any of the single-player
campaigns or the multiplayer
modes). Each of the races has
special capabilities: for exam-
ple, the Bishop can fly and
throw things around, but has
no weapons at all. There are a
few special moves: the
Guardian, for example, can

shoot off a couple of hundred
feet and then shoot from up
there while falling down. He
also has two different weapons
in each hand. There are a cou-
ple of vehicles and mechanical
warriors to move you around
the maps. While the buggy may
be some fun, the mech warrior
is way too slow to reach the
action before it ends.

Alas, the game has no sto-
ryline whatsoever. It’s a line-up
of single skirmish missions on
different maps against AI bots.
Each level you win, another is
unlocked—almost always as
disappointing as the previous. 

Some levels, however, are
better looking and more fun,
especially the more open ones.
The indoor maps are cramped
with too many objects trying to

take advantage of the PPU. This
excess of objects gets in the way
while you’re going through the
maps. You end up pushing away
all sorts of debris and barrels.
There are just five levels, so
expect to be bored out of you
mind real soon… To add to the
disappointment, you only get
four guns!

The use of physics in the
game is the core strength of Cell-
Factor. The game engine along
the physics processing card
allows huge numbers of objects
of all sizes and shapes to react
with each other like in real life,
in real-time. But in-game, you
have huge, heavy, metal objects
floating around and bouncing off
walls like gas balls, which is just
plain silly.

It’s a letdown when the game
has the ability to do so much but
it’s all done so badly. You can use
your powers to levitate objects
and hurl them around the place—
and at enemies. The interaction
between the large numbers of
objects is sort of interesting to
see, but nothing special—Half-Life
2 had it with the gravity gun, too.
Here, the novelty fades away
rather quickly.

The game supports HDR
and per-pixel motion blurring,
which gives gives it the look of
a modern game. The models
and textures aren’t too
detailed, and the levels are
tasteless and lack identity.
They’re filled with neatly-
stacked boxes lying around
begging you to throw them
around—and that’s about it.

The sounds lacks punch. The
voices in-game, especially in the
CTF modes, are retarded. Your
team-mate keeps yelling in an
awkward kind of way like the
folks from 300. The music isn’t
any better either.

Our machine—a Core 2 Duo
E6700, 2 GB of RAM, and a
GeForce 8800GTX only managed
30 to 45 fps at 1280 x 1024 with
HDR and Motion Blur on. The PPU
might have helped elevate the
performance a bit, but it’s still far
from being a well-performing
game. Nor is it a good-looking
one. Loading stages takes a while
as well. Yes, the list goes on.

After playing this game a
fair bit and getting excited a
couple of times, I realise I’ve
only had my spirits raised and
then smashed into the ground.
I’m left confused and pondering
over the point of all this. And
after some soul-searching, I
have to say CellFactor feels
more like a tech demo than a
game. It isn’t anywhere close 
to exciting.

If you were planning on
buying a physics card just to
play CellFactor, don’t bother.
This game’s only saving grace
is its fairly decent looks and
the semi-cool physics effects,
and that’s the only reason I’m
giving it a 5—and maybe
because it’s free.

rossi_fernandes@
thinkdigit.com
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Rating: 5/10, Developer: Artificial Studios,
Timeline Interactive, Immersion Games,

Publisher: SouthPeak

XFX GeForce 8800GTX, Intel
Core 2 Duo E6700, 2GB RAM,

Windows XP Professional,
Hitachi 250 GB  HDD
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FirstEscape

Alucky few of us in
India are rejoicing
over our new, fast 2

Mbps Internet connections.
Yes, those of us who do have
such speeds at home—
especially the rich few who
even have it unlimited—look
down upon the hoi polloi.
We even wear T-shirts that
say “2M. Eat that, 56K.”

Sigbritt Löthberg, a 75-
year-old granny in Sweden
would kindly approve. She
just got a 40 Gbps
connection.

Wait. Did we write that
right? Yes, we did, and we
hope you read that right,
too. It’s about 20,000 times
faster than 2 Mbps, and 6
lakh 40 thousand times
faster than dial-up. OK, we
can’t have made typos
writing all that out.

Interesting how such
news spreads with such
rapidity over the fibres, as it
were… Löthberg’s home
connection happens to be
the fastest residential

Internet connection on the
planet. (So OK, our jaws
needn’t drop any further).

Löthberg can download a
full-length dual-layer DVD in
two seconds, or watch 1,500
HDTV channels streamed
simultaneously. So how did
she land up with this kind
of whatever-you-may-call-it
speeds? Well, it pays to have
a son who happens to be one
of the leading authorities on
the theory of fibre optics.

What puts the steam
into the lightning-fast
connection (sorry, mixed
metaphor) is a new data
modulation technique that
allows direct transfers
between two routers that
can be as far as 2000 km
apart, without any
intermediary nodes. (The
distance between the routers
can theoretically be
unlimited.)

It’s time to reveal the
hardest part-to-digest of the
story—(wails of pain here)—
the hardest part of getting

the connection to work was
the installation of Windows
on the ancient computer
Löthberg uses. And she uses
it rarely, we hear.

With that revealed, let’s
see what Löthberg might do
with her connection, in
increasing order of horror:

Download Windows
updates

Chat with relatives abroad
Play Yahoo! Games with

jovial granny-friends right in
Sweden

Search for recipes online…
Friends, philosophical

resignation is the only
solace. Hawking was right.
Life isn’t fair.

GRAND SLOTH

When
Gamers Go
Bad

Teenagers with no
social lives who spend
hours upon hours in

a dark room, shut off
from the rest of the world,

Sandip Dev from Nagaon confused us a bit with his
desktop—it looks like a crazy mix of Vista and Mac OS X,
but it’s really Ubuntu.
How he did it:
The top panel: Use GIMP to create a silver gradient
background of 24 pixels height and width equal to
dekstop horizontal resolution. Blacken some of the
pixels from the corners to give a rounded look
The Apple logo: Get the Apple logo from the Net and
convert it to .svg. Name it start-here.svg and copy it to
/usr/share/icons/Human/scalable/places as
root(gksudo)
For the Volume meter, CPU meter, Battery Meter,
Inbox and Calendar, use gdesklets

Google Cash-strapped
Now this one tickled us no end: when we last checked,
Google was sitting on, oh, billions of dollars in profits.
Even so, one blogger was issued a cheque—which
bounced—for Adsense earnings. And he told all.
(Probably kept and framed the cheque, actually.)

SPEED DEMONESS 

Granny Has Fastest Internet

My Desktop

Whatever 
Happened To…

Back around 1998, some
bright folks came up with

the idea that movies should
start getting interactive, that
audiences in movie theatres
and at home should get the
option of choosing which way
the movie would progress.
Should the actor kiss his
leading lady? Should the lady
in question swoon or slap the
man? The way the story
flowed would be in the hands
of the viewer.

Interactive movies were
proposed to work on the
principle that audiences in
theatres would be given a
four-button remote-control-
like device, and that key
twists in the plot would be
decided by a real-time poll in
the theatre. The movie would
progress in the direction of
the option with the most
votes. Producers thought
getting to a popular
conclusion would keep
everyone happy…

The idea never caught
on (we sort of knew back
then it wouldn’t). Producers
quickly realised they would
have to shoot many more
reels of film to
accommodate the different
twists and turns; conducting
a poll while the movie was
on could have been a tad
irritating. You don’t want to
be asked if Salman Khan
should take off his shirt!

Still, thanks to higher
bandwidths and ever-falling
production rates, interactive
movies have taken to the
Internet. A site catering to
this whim, if you do feel
compelled, is
www.interactive-film.com.

Woz Stands In Line!
The iPhone, like the Grim Reaper, is a great leveller.
Steve Wozniak, the iconic co-founder of Apple, was
spotted with ordinary folks outside an Apple store—
that’s no typo—waiting his turn for an iPhone. (because
he’d have to wait for his complimentary phone!)

Send us your desktop  with a description of how
you made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with
the subject ““MMyy  DDeesskkttoopp””,, and tell us your postal
address, too.

Participate in this contest and 
win next month 
Mastering Maya 8.5
by John Kundert-Gibbs

Published by

Interactive Movies



play games. And bachelors
with a history of failed
relationships (and who
aren’t getting laid
anytime soon). Right?
Well, think again. Turns
out even “responsible”
couples with babies (!) can
behave like spoilt teens
when it comes to games.

This is from Reno,
Nevada (where else could
this happen but in the
US?). A couple, Michael and
Iana Straw, were fanatic
gamers. They spent most of
their time online, playing
games like Dungeons and
Dragons. The immersive
environment of these
massively multiplayer
games was too immersive
for them. So they forgot
they had two babies. They
played and played, the
babies (must have) bawled
and bawled, and the couple
played and played, and you
get the idea, that no food
went into the babies’
mouths. When social
workers turned up to check
on the kids, they found
them sick and severely
malnourished.

The Straws had clearly
crossed the fine line that
separates passion from
madness.

They didn’t have steady
jobs, but the mister had
$50,000 as inheritance.
And no prizes for guessing
what he did with it:
splurged it on computers
and a large-screen plasma
TV, ostensibly to improve
the gaming experience (!!)

The couple have pleaded
guilty to charges of child
neglect, and will face trial.
The babies, meanwhile, are
in foster care and doing
well. (Umm, virtual
Columbine killers later on
in life, perhaps?)

MYSTERIOUS MISCHIEF

Defending
The Asses 

If you were looking to
(cough) download some
movies from the (cough)

Internet and innocently
visit www.P2P.net, it will
redirect you to
www.TorrentFreak.com, a well-
known BitTorrent news site.
So what’s the deal? Time for
a little history lesson, and
we’ll try hard not to bore
you. (Read: “Please Read.”)

A company called
MediaDefender, paying

filthy amounts of $$$,
bought P2P.net. This
company happens to have
been hired by the likes of
the Recording Industry Ass.
of America (the ill-famed
RIAA) and the Motion
Picture Ass. of America (the
equally ill-famed MPAA) to
find and report people who
use BitTorrent and P2P to
download copyrighted
content. (Read: “People who
download.”) In the past,
MediaDefender has
resorted to launching fake
video uploading sites, and
setting up fake torrent
trackers that record and log
user’s IP addresses.
MediaDefender also
regularly uploads fake
torrent sites on popular
BitTorrent sites to collect
details of the happy-go-
lucky folks who download
the torrent files. Such
conduct has enraged the
P2P community (Read: “The
people”), with site admins
offering to help each other
remove the MediaDefender
menace from their sites.

Against the backdrop of
this tense scenario, when
P2P.net was launched,
someone did a WHOIS on
the domain name and
found “MediaDefender.”
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LCD monitors
are pretty,
and it’s been
a long, long
journey from
the time of
the LCD
displays in

watches and such. Thank
James Fergason, the man
who improved the LCD and
kicked off the now-multi-
billion-dollar LCD market.

Fergason did not
discover liquid crystals;
what he did discover was
how to use them the
correct way. Prior to his
work, LCDs used too much
power, had limited life, and
poor visual contrast.

Born to a middle-class
American family, he
attended a one-room school.
He grew up reading science
books and admiring his
brothers who had degrees in
engineering. His
grandfather was a child
prodigy who graduated at
age 15. With such role
models around him,
Fergason decided that he
should invent something…

Graduating from
Missouri University in 1956
with a degree in physics, he
joined Westinghouse
Research Laboratories. There
he studied liquid crystals—
his passion—and thought up
the first practical way to use
them. The first commercial
use of LCDs came in quartz
watches. Fergason went on
to create his own company
to manufacture displays. 

The man’s latest
invention includes safety
eyewear whose liquid
crystals become opaque
instantly when hit by
intense radiation like lasers,
thus protecting the eyes. 

He received the
Lemelson-MIT Prize,
considered the “Oscar for
Inventors.” Now who’d
think liquid crystals were
something to be
passionate about?

People Who
Changed

Computing

The Face Behind The
Screen

1 GB—Lest I forget! 

WIN!
Send in your entry and you could win an exciting gift by sharing an amusing picture with a tech angle to it.
The picture should have been shot by you, and should not have been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line, mentioning your postal address, oonn  oorr  bbeeffoorree  tthhee
2200tthh ooff  tthhiiss  mmoonntthh  to digipick@thinkdigit.com. One prize-winning picture will be published each month.

Participate and 
win next month: 

Beginning 
Access 2007 
VBA
by Denise Gosnell

Published by

Last month’s winner:
Sankalp khanna
Amritsar.

James Fergason



How Do Yer Do?

As fate would have it, we
stumbled upon

www.rinkworks.com/dialect.
And so now, we’re talking in
Redneck, Pig Latin, and other
such exotic dialects. Look what
th’ Web hath wrought upon us:
we can nae speak in homely
tongue no more.

Go to that thar page and
type in yer sentence. Choose
yer dialect. Click the
“Dialectize” button and ooh la
la—th’ language of HM the
Queen of Engelond you typed
in has magickally mutated!

Bloody useful eh, this site?
To morph an entire Web page,
type in yon URL and get a
dialectised view. If th’ site hath
links, clicking them links will

fetch ye th’ morphed versions.
Ye can now speak in Redneck
(good, y’all), Jive (wassat?),
Cockney (‘ow’s ‘at?), Elmer
Fudd and H4x0r. (That thar last
one fer ye non-techies is
“hacker.” Arr!)

Lots In A Name?

The Bard might not quite
have approved, but names

are worth millions on the Web.
We also have a breed of
hangers-on, whom the media
refers to by the fancy-
sounding “cyber-squatters”.
But you know all that, and
we’re digressing: this is not
about cyber-squatters and
their run-ins. 

Having too much time to
kill and prone as we are to

goofing off, we looked up the
weirdest domain names we
could find. www.mp3shits.com
(get it?) is a place to go to if
you want some “free” MP3s
(chuckle, chuckle!).
www.whorepresents.com
(wink, wink!) is a listing of
contact numbers of actors and
their agents. Then again, look
at these gems: www.ba.be,
www.glo.be,
www.killbillsbrowser.com
(some folks just hate IE, you
know), and
www.therapistfinder.com (in
case you need a marital
counsellor). But our site name
of choice is www.losemoney-
now.biz, up for sale now. Just
in case you’re in the business
(duh!) of losing money.

This was, as you just might
have figured, reported all
over the blogosphere, and
quickly made it to the front
pages of popular social
news sites. After that, the
WHOIS information for the
site has been changed.
P2P.net now redirects to
the popular BitTorrent
news site, which is full of
muck about
MediaDefender.
Surprisingly, the page is
moderated, and there are
no dirty words there.

So why did
MediaDefender buy the
grossly expensive P2P.net?
And then decide to redirect
it to TorrentFreak? It’s all
twisted, warped, topsy-
turvy and what not, all this
business about the domain
name and the two Ass.es.
And guess what’s on the
redirected page right now?
As in the comments? Here’s
one: “When a digital file is
illegally downloaded,
NOTHING is taken. It’s
copyright infringement,
not theft. No matter what
the smacktards in the
entertainment industry
would have you believe.”
Ah, the same, the same,
even more of the same.
(Except for “smacktard,”
which we’ve now learnt is a
bad word meaning
“retard.”) Please, please

find the February 2007
issue of Digit somewhere
and read up on the whole
P2P thing.

I’M FEELING QUIRKY

Have Net,
Will Google

Most people key in
search strings in a
search engine when

they start their amblings
online. And some of these
strings are weird, as you
know. But some are way too
weird, and looking at them
makes you wonder what
the users were thinking.
(As in, if you’re all that
bored, why not just Google

“sex” and get virtually
laid?) Here’s a sample from
a couple of blogs we found
dedicated to the tracking of
search behaviour that
warrants urgent medical
attention. Don’t say we
didn’t warn you.
1. Half dog half cat
2. How to make animated

movies like happy feet
3. Breed of cat in James

Bond movies.
4. Haiku of Elvis Presley
5. How to make submarine

with pop bottle
6. My husband wears my

clothes
7. Why is my husband a

jerk
A butterfly can cause a

hurricane, and those folks
might be reading it, so let’s
tell them what Google can’t:

1. It’s going to be a
bloody freak of
nature. Period.

2. Feet are happy
when you soak
them in hot water.

3. If you care, you
have no life.

4. Try one yourself if
you’re so much of a
fan!

5. Go back to school.
6. Eek! Period.
7. Because you don’t

give him enough sex.
Talking about sex,

guess what: according

122

Escape

DIGIT AUGUST 2007

Image Editing
The whole point of a digital
camera is to just point and take
pictures, right? Who needs to
know about all those fancy
adjustments you can make? But
if you want to sound like the
know-it-all pro of digital image
editing… read on.

Hue: One of the main colour
attributes—apart from the
“lightness” and
“colourfulness”—of an image,
hue is associated with the
colours red and yellow: when
the hue is edited, it’s like
putting a film of coloured
plastic over the image. 

Saturation: Defined by the
intensity of colour. When it is
high, colours appears vivid and
vibrant; when it is low, the
colours take on a darker tone.
If it’s too high, the image
becomes “vibrant” in a
psychedelic way.

Brightness: The amount of
light given off by an object.
Brightness is subjective: it
depends on the eyes’
sensitivity to light.

Luminance: The measurable
component of brightness. So
the luminance of a bulb is the
same whether it’s measured
from three or 12 meters away.

Contrast: A combination of
colour and brightness (woe!),
contrast refers to the visual
details of an image that
distinguish objects in the
foreground from those in the
background. If an image has a
lot of detail but with low
lighting, increasing the contrast
will improve it.

Usage: So I got this shot of a
King Cobra, hood raised—right
in front of me! No, really! But
you couldn’t see the spots, so
I tweaked the contrast—and I
had to increase the
brightness. Actually, the
luminance was what needed
adjustment, and the
saturation, too—those colours!
It’s got a yellowish hue, which
I’m not touching.

Wild Wild Web

Illustration Harsho Mohan Chattoraj
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EEscscapeape

to Google Trends, Indians
topped the list for
keywords like
“pornography” and “sex.”
Yes, the land of the Kama
Sutra and being sex-starved
and all… and we don’t need
to repeat all that.

THE FOX SPREADS ITS WINGS

“What’s
Internet
Explorer?”

We cannot be sure if
some—maybe just
some—Microsoft

workers use Firefox at
home, but if you’re a loyal
one, you wouldn’t. And your
sense of pride of the world-
domination would take a
beating if you someone—in
fact, any computer user in
the world—were to ask you,
“What’s Internet Explorer?”

Perhaps that’s why UK
blogger and avid Firefox fan
Danny Sullivan spread the
news that his son had asked
him that question. To deflate
at least some MS egos.

Sullivan, we hear,
succeeded in persuading
his wife to drop the big

blue E. Apparently, it had
sometimes crashed on her.
So the missus moved over
to Firefox full-time. And
since hers is the hand that
had rocked the cradle, the
kids took the Firefox path
as well (after they were out
of the cradle, at any rate),
and soon the whole family
was hooked.

The aforementioned
question came up when
Sullivan’s eight-year-old
son wanted to browse the

Net and his preferred
browser wouldn’t work.
(OK, Opera fans, time to
gloat.) But Sullivan is no
Opera fan, and he didn’t
have it installed, it seems—
so he suggested the kid to
use IE instead.

Surprise probably
ensued when his son
replied asking, “Internet
Explorer? What’s that?”
Sullivan has said on the
Web that his son has access
to the Internet from school,

but he doesn’t know what
browser they use there.
Clearly, it’s not IE.

And that’s that. We just
wanted to tell you a story
pointing to the rising
popularity of Firefox instead
of one of those news items
that go, “Firefox use in
Bamako up by 2.3% in June
2007 from the
corresponding figure for
January! Now go to
Mozilla.org.(Mali’s Internet
code) and buy a T-shirt!”

Frank Hayes
www.computerworld.com/blogs/node/5864
Firefox fixed—now it’s Microsoft’s turn
Seven days after a zero-day vulnerability surfaced
that involves both Internet Explorer and Firefox, the
developers at Mozilla have released a patch.
Microsoft, for its part, says the security hole in IE is a
feature, not a bug.

For a week after the problem surfaced, security
pundits were taking sides to pin the blame on either
Firefox or IE… So now, a week later, Firefox has
issued its patch. The IE/Firefox security hole is
closed—on the Firefox end...

Lisa Vaas
http://apple-iphone-news-
articles.blogspot.com/2007/07/hackers-close-to-
cracking-iphone.html (http://tinyurl.com/2rhpxj)
Hackers close to Cracking iPhone
iPhone hackers are on the cusp of not only being able
to write programs for the phone but also finding a
way to cut the device’s tether to Cingular’s service
plans…

One of the first iPhone hacks came from Jon Lech
Johansen, aka DVD Jon. A self-trained Norwegian
software engineer, Johansen on July 3 announced on
his blog that he had hacked a new, unactivated

iPhone, managing to activate it without turning on
AT&T Cingular phone service. But although Johansen
managed to get the iPod and Wi-Fi capabilities of an
iPhone turned on with his hack, he couldn’t get the
device to work as a phone…

There are reasons why unlocking an iPhone is a
bad idea, however…

Frank Hayes
www.computerworld.com/blogs/node/5847
Intel folds on OLPC
Everyone is being polite about Intel’s decision to join
the OLPC consortium… Intel has been pouring insults at
the OLPC ever since MIT’s Nicholas Negroponte started
the project. On the surface, that made no sense:
Nobody was going to use one of these little ruggedized
PCs in competition with the high-end laptops that Intel
made CPUs for, so the most reasonable position for an
unsupportive Intel would be to sit smugly by.

But Intel didn’t do that. Intel honcho Craig Barrett
went out of his way to trash-talk the OLPC machine.
Even when it turned out Intel was working on its own
cheap student PC, the Classmate… Intel’s Classmate
finally hit the streets in March. Apparently it didn’t take
the Third World by storm. And now, four months later,
Intel has decided that maybe this OLPC crowd has a
good idea after all.

Has the iPhone and
related news been
flogged to death?
Bloggers don’t seem
to think so. And Intel
getting onto the OLPC
thing… who would
think?

Malice
If you’ve ever been in these offices at the

high-stress time of issue closing, you
soon understand why it’s necessary to
spew a little venom at the unsuspecting
human beings that dare cross your path.
It’s therapeutic, they say, and feels good
(not to the spew-ee, obviously, but you
can’t have everything). 

The most deadly woe-causing force in
these parts has to be Ajay—our resident
BOFH (look it up, why don’t you).
Somehow, our servers get lonely while he’s
gone, and wantonly turn themselves off.
Unbeknownst to our moody servers, poor
Pillaiji loses a few strands of hair—“Aiyyo
error!” (I/O Error. Get it? Heh, heh). 

Adding to Pillaiji’s already mounting
terror is The Browne Stain,
who promptly decided to

fall ill the day he was supposed to clear his
article before it went to print.

Going further down the halls, we find
SKOAR!’s ed Badri (None shall be spared!
Yarrrr!) dancing away to—cue dropped
jaws here—the latest Bollywood tunes! Not
in reality, though—we wouldn’t have
survived the shock—but he’s found joy in
a new multiplayer dance game. The
shocking truth...

In other news, we’ve got us a new
minion writer—young Bhaskar Sarma. He’s
bald—shinier than our reigning billiard
ball, Raaabo, even. By choice. Really. He
could grow his hair back if he felt like it.
Don’t let Raaabo find out.

We shan’t bitch about the ed here; you
don’t spew at people who pay you.

Well, not in public.
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Here’s Where The Action Is
I just wanted to share a little thought
with fellow Digit magazine readers. My
thoughts are intended as follows: I’m
trying to be as precise in expressing
myself as possible. I hope you like my idea
and publish this e-mail to make readers
aware of the Granular Linux Project. In
the initial days of my experimentation
with Linux, it delighted me, enlightened
me, to an extent that I eventually ended
up creating a distribution.

About eight months ago, Granular
Linux began its journey under the
Granular Project. In due course of time,
Team Granular has grown from a single
member to a small team of six to seven
members from across the globe.

Based on PCLinuxOS, this distribution
has always been touted as the “distro for
newbies.” Although nowadays we have a
lot of distros that are very easy to use
including Ubuntu, Mandriva, and PCLOS,
these have some things that give them a
bit of geeky feel, which we intend to do
away with in Granular. It’s the endeavour
of Team Granular to make it the easiest-to-
use distro on the planet. This is not
possible through a very small team.
Granular is intended to be completely
community-oriented. Development within
a community is fast; a community
understands the needs of others better,
support from the community is best, and
moreover, a community helps others grow
and learn fast.

With this ideology in mind, I urge the
Indian talent to come ahead and form a
community that would fulfil the goals set
for Granular and also make India proud by
giving the world’s first-ever community-
based native Indian distro free of cost. This
is in the spirit of the open source
revolution that other countries already
support. Why just be a part of the
revolution—why not create one?

For more information, please check

out www.granularproject.org. Granular on
DistroWatch: www.dirstrowatch.
com/granular.

Anurag Bhandari
Dear Anurag
Congratulations on your efforts thus far. I can
only encourage you; what you are proposing
sounds exciting to say the least. And the least I
can do is publish this as the first letter in this
section of the magazine.

Considering our reach, I believe you will get
more than a few responses. Do keep me updated
on what’s going on, and whether we made a
difference.

— Executive Editor

The Best Ever…?
Dear Team Digit,
Let me first ask you a question. Was last
month’s issue the best Digit ever
published? I think it really was. But let me
thank you for also publishing the Fast
Track to Apple. You fulfilled a long-term
request of mine there.

The whole magazine was indeed a
masterpiece. I’ll compare it to the Linux
kernel, which is the greatest masterpiece.
Like the Linux kernel, the magazine was
indeed valid for all the platforms. You
didn’t miss Linux, you didn’t miss Mac,
you didn’t miss Vista, and, of course, you
didn’t miss XP. It was also nice to see Tips
& Tricks on Linux and torrents.

The laptop test was quite impressive.
But instead of categorising them into the
lifestyle etc. sections, I suggest you sort
them into price-wise sections the next
time you do a shoot-out. One thing I don’t
understand is, why didn’t you feature
Macbooks in the laptop test? The Macbook
model could have been included in the
home series, and the Macbook Pros would
be in the Performance segment. You could
have even tested them by loading
Windows XP or Vista on them via the Boot
Camp utility.

Reading the history of Apple was quite
interesting. But the thing that stood out
was the operating system Mac OS X. The
coverage of the iPhone was exhaustive.
Did you really get your hands on the
iPhone?

I used to save Web pages from the
Apple site on my computer to read them
again and again. But even those Web
pages could not provide me with the
information this little book did.

A big thank you for providing us with
the Fedora 7 distribution. I was really in
need of Fedora as I’m preparing for my

RHCE certification. Hey… wait a minute…
why don’t you guys publish a little article
on the scopes of various certifications in
the IT field? What are the scopes for our
careers if we undergo MCSE, RHCE, CNE,
etc. courses? It would be of great help to
your young readers (which are the
majority of your readers) and also to the
retired citizens, who would like to do
more after retiring from their jobs.

Thanking you in anticipation!

Tarun Brari
Hi Tarun,
It’s good to see you writing to us after you
submitted an article for our Sixth Sense issue.
You really seem to be an avid reader. Let me
answer a couple of your questions—first, about
our laptop categorisations: I do of course know
India is a price-sensitive market, but if a reader is
to look only at price, he would tend to miss out
on the usability factor—which, in my opinion, is
paramount. About Macbooks, the two-pronged
answer is that (a) they are expensive, so not too
many readers would be interested; (b) not too
many readers are comfortable with non-Windows
OSes—yet; we have tried to rectify this situation
via our Fast Track; (c) Macs are in a class of their
own, and would not blend well in a comparison
test; and (d) the few who do know and love Macs
do not really need benchmarks—they already
know what Mac to buy! 

We really did get our hands on an iPhone,
and finally, yes, we intend to publish an article on
certifications—or something along those lines—
soon.

— Executive Editor

Die, Pirates!
I live in New Delhi which is the heart of
India. And the heart of Delhi is
Connaught Place, which is the centre of
piracy. In Palika Bazaar, every shop vender
offers pirated CDs without any fear. I have
a genuine version of XP which is costly,
but there I found I can get it for as low as
Rs 60 without any bargains. I think
companies like Microsoft, Adobe, Corel,
and Autodesk are not worried about
piracy because everyone knows that
pirated CDs are available there; don’t
these companies know these facts?

I think piracy can only be stopped
after lowering the prices of genuine
software, which as far as I know, seems
impossible. The only light I can see are the
movies which have started to retail at as
low as Rs 39, and open source software
like VLC Media Player.

Akash Yadav
New Delhi
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Dear Akash
Delhi is not the heart of India; it is Bombay—to
use the name we know and love! OK, I was just
kidding… getting serious, you’re right in saying
about piracy that though a seemingly plausible
way out would be to lower prices, it is not
possible for the big companies. And as for the
companies not knowing these facts, our insight
regarding this—rather, Agent 001’s insight—has
been published in an earlier issue. It’s called,
simply, Is Piracy Good? Do take a read.

Open source software is a good way to go,
and you’ve probably noticed how much we focus
on such software these days.

— Executive Editor

Disgruntled, And Rightfully
I have received one CD with a plastic
protection sheet  tightly fixed to the CD.
After removing the plastic protection
sheet (which is normally there in any CD
box at the bottom), I inserted the CD in
the drive and it was not recognised. I have
already sent you a message in this regard.

The customer service does not give a
reply whether it is for subscription
renewal or for the status of subscription
cheque or for a missing magazine or for
any subscription scheme.

Even if the subscriber receives a reply,
it will contain a message saying that every
day they receive hundreds / thousands /
lakhs / billions of messages.

As far as I know, the subscriber need
not worry about the volume of messages
received by a magazine every day; the
magazine has to take measures to handle
it. I now hope I will receive a reply
for replacement of the damaged July
2007 CD.

A M Sameeullah

Dear Mr Sameeullah,
I agree: replying to your mails is our
responsibility—hence, even if late, we need to
reply them. I am personally arranging to send
you a working July CD.

Please bear with us for a week on this.
Thanks for writing to us and sharing your
frank opinion.

— Executive Editor

Computers Or Cleavage?
Being a mechanical engineer, my only
touch with technology is through Digit, to
which I’m subscribed since the past few
years. I’ve been wanting to mail Digit from
quite some time now, but one thing or
the other came up. I bought my cell and a
new PC recently based on your
suggestions. But the July edition just
made me sit and type.

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar Building,
MIDC, TTC Industrial Estate, Nerul
Navi Mumbai 400 706

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee  iinncclluuddee  yyoouurr  ccoommpplleettee  aaddddrreessss  iinn  aallll  ccoommmmuunniiccaattiioonn..  

For subscription queries, call the help desk at 
022-27629191/9200, fax 022-27629164, or 
send an e-mail to help@jasubhai.com

I’ve been used to seeing Digit as a
hardcore technology magazine with no-
nonsense stuff and no distractions;
needless to say, the cover left me with a
pleasant feeling at the same time
surprising me. I know it’s not the first
time you have a woman on your cover,
but this time it looked more like a film
magazine. I’m used to seeing the
cleavages of hardware that you
normally show so generously, but I just
wondered why on earth would a
technology magazine have such a
picture on its cover. 

What was she posing with? Laptop?
Cell phone? …Let me check the cover of
the issue again.

Navin D’Cunha
Thane

Dear Navin,
I’ll respond to your comments about the
cover.

First, being a hard-core tech magazine
does not preclude a cover of the type you’re
talking about. One might be an alpha-geek or
gamer, and he might still wear a plain yellow
shirt—he doesn’t necessarily wear a T-shirt
with a motherboard on it (which he could), or
a Quake logo. Second, it’s not about cleavage.
It’s the particular dress the model was
wearing. That dress is casual, which brings
out the “casual, carefree computing” kind of
theme we wanted to bring out for our laptop
tests. After all, people use laptops while in
bed, don’t they—and that’s something they
can’t do without Desktops.

About the fact that it was a woman on
the cover, it adds to the human element. That
might sound like a truism, but I hope you get
what I mean. Yes, if you’re saying “Why a
woman and not a man,” look across our
issues—you’ll find plenty of men on our covers
as well. Finally, I’d like to say that I’m not an
expert on cover design—I leave that to the
expert cover design team. 

I’m sure several readers will echo your
thoughts, and this open letter is addressed to
all of them. Thanks for writing in—even if just
with a minor concern!

— Executive Editor

Archi-tech-ture!

Dear Digitizers
I am an architect (at least
that’s what my university
certificate says!). Maybe I
was amongst the first few
CAD users in college. Since
then, I am more recognised as
computer-savvy than as an architect. I am
a regular subscriber to Digit since the last
three years. I have no other option than
keeping myself updated when it comes to
technology, because friends hardly talk to
me about anything in architecture, and
rather, they would love to seek my advice
on buying a good laptop, upgrading their
existing graphics card, or at times the
comparative analysis between AMD and
Intel processors.

The institute where I am appointed as
a faculty (architectural computing and
design fundamentals) decided to go for
Linux rather than Windows. I took up the
challenge with a smile; I already had a
handy book on Linux and open source
software with me, which gave me many
insights on Linux and open source
software (don’t tell my boss… he is under
the impression that I have done a lot of
research on Linux, and now I am
expecting a raise!).

I learnt a lot from either Digit or the
Internet without having to go for any
formal education in graphic and Web
design. Point is, technology has reached
all the offices, may it be an architect, CA,
lawyer, doctor, or stock broker for
example. Can Digit come up with
specialised issues on “technology for
particular professions,” for example,
Software for Architects.

When it comes to architecture, now
there is BIM, estimation software,
rendering software, software for checking
sustainability issues, construction
management for architects, and what
not. Digit can even focus on architecture-
specific hardware requirements.

Somebody has correctly put it:
“Computers are not about computing any
more, they are about living.”

Ar. Rajesh Advani

Dear Mr Advani
It is now-knowledgeable people like you that
we’re trying to create; you’re the best example of
what Digit’s aim is. To enrich someone’s tech
knowledge and awareness, to help him or her
put it to good use, and to enable him to stand
out from the crowd.

Many thanks for your e-mail—it has raised
my spirits for the day!

— Executive Editor

Letter 
of the
Month

ERRATA 

In Mp3 player test article (June 2007), on
page number 176-177, the Digit Best Buy
Gold and Best Buy Silver Logos were
misplaced. The correct placement should
have been, Gold logo for iAudio’s Cowon D2
and Silver logo on Sansa’s E260 as stated
correctly in the article. Inconvenience to our
patrons is regretted.
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The first successful high-
level programming language

was…
(a) Machine language
(b) FORTRAN
(c) Lisp
(d) Pascal

A physical address on a LAN
is called the:

(a) IP Address
(b) MAC Address
(c) Ethernet mask
(d) Subnet mask address

The first live channel in
India to broadcast mobile

TV (in March 2007) was 
(a) CNN
(b) Star TV
(c) Doordarshan
(d) NDTV

”RSA” stands for

(a) Rivest, Shamir, Adleman
(b) Really Secure Authentication
(c) Ronald, Sam, Amman
(d) Random Secure Access

The first commercial 
microprocessor—the 4-bit

4004 from Intel—was introduced in
(a) 1971
(b) 1981
(c) 1979
(d) 1985

Which one doesn’t belong?

(a) MAN
(b) WAN
(c) LAN
(d) SAN

What was the first 
Web site to feature a 

banner ad?
(a) Amazon, in 1995
(b) Yahoo!, in 1990
(c) Hotwired, in 1994
(d) CNET, in 1993

Which company is called
“Big Blue”?

(a) IBM
(b) HP
(c) Sun
(d) Dell

Which of these operating
systems has a UNIX founda-

tion?
(a) BeOS
(b) Windows 1.4
(c) OS/2
(d) Mac OS X
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ACROSS
7. 1.Computer programme(8)
6. OS failures(4)
8. Burst Extended Data Output-Dynamic Random
Access Memory(abbr)(4,4)
9. Wavelength symbol- Greek alphabet(6)
10. Macromedia programme for creating vector
graphics-based animation programmes (5)
11. Magneto-optical Filter(abbr)(3)
12. To take or wrest control(5)
14. SI unit of inductance symbolized H(5)
16. Unit of information in a binary numbering
system(3)
18. Undeliverable e-mail that returns with an error
to the sender(6)
20. High-Speed Downlink Packet Access(abbr)(5)
22. Data containing only ASCII characters.-has the
extension .TXT or .ASC(4,4)
23. -----or close files(4)
24. -----screen of -------—code name for Microsoft’s
latest Window operating system(3,5)

DOWN
1. Device into which data can be entered and held(7)
2. Video camera attached directly to a computer(6)
3. Mumbai based information portal(6)
4. Computer breakdown(5)
5. Advertising banners displayed through pop-ups on the
internet(6)
7. Break-out Box(abbr)(3)
13. Second largest indian PC company based  in
Mumbai(6)

15. Small Particle-------—chemical substance used for
fingerprint detection(7)
16. ------or pen tool in graphic software(6)
17. Chain of postings on a single subject in a newsgroup(6)
19. Small, fast and stable web browser-’a rope’ (anagr)(5)
21. Semi-conductor device which conducts electric current
in one direction only(5)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

Of Lasers And Security
The first company to

enter the optical disc
market with the LaserDisc was? 

(a) Pioneer 
(b) Sony
(c) Mitsubishi 
(d) Philips

1

EBay users worldwide
trade more than

$1,839 (Rs 74,000) worth of
goods every second! The
highest-priced item ever sold
on the site was a $4.9 million
(Rs 20 crore) corporate jet.

Did You
Know?

Answers

6.(a) 1971

7.(d) SAN: the others 
are communication 
networks

8.(c) Hotwired, in 1994

9.(a) IBM

10.(d) Mac OS X

1.(a) Pioneer

2.(b) FORTRAN

3.(b) MAC address

4.(c) Doordarshan

5.(a) Rivest, 

Shamir, Adleman

Crossword by Nitta Jaggi

Last Month’s Solution

July’s Winner:
Anish Thomas Mathew,
Chennai

Send in your entries to
TQ@thinkdigit.com
on or by 20th of this
month. One lucky
participant will 
win ASP.NET 2.0 Web
Parts In Action
By Darren Neimke
Published by

Win!



People And Events That Grabbed The Headlines—For Better Or For Worse

Lindsay Lohan of drunken
binges fame is taking the
help of high-tech to cure

her of her dipsomania. Just out
of rehab, she has volunteered to
wear an electronic anklet that
will monitor her blood alcohol
levels. The device works on the
principle of “transdermal
alcohol testing,” and if you
know what “dermal” refers to,
you’ll know how it does work:
the anklet measures the
alcohol level in the thin layer
of sweat on the skin that’s
there no matter what the
ambient temperature is. It is
sensitive enough to detect
consumption of even a teensy-
weensy shot.

The transmission of data is

as sophisticated as the
collection is. Whenever the
anklet is within a range of 30
feet from a wireless modem,
the collected data is sent to a
secure Web site that alerts
probation officers if the levels
exceed permissible limits. And
it is next to impossible to
remove it: it has a tamper-
proof clasp. And trying to slip
something between it and the
skin won’t work: an infrared
beam measures the distance
between the skin and the
anklet. When this distance
increases even slightly, an
alert goes out.

Perhaps Ms Lohan can pass
it off a new must-have
accessory with her heels.

Celebrities have long dealt
with pesky fans and
peskier paparazzi.

Stalking is part of their lives,
and courts have had to
intervene too often to address
privacy concerns. But most of
these cases involved physical
stalking. When the stalking
becomes virtual, it gets scarier
and more pervasive, as 
Chester Bennington recently
discovered.

A woman has pleaded
guilty to cyber-stalking
Bennington, lead singer of
Linkin Park. Devon Townsend,
a former employee at 
Sandia National Laboratories,

admitted that for almost a
year she’d spied on Bennin-
gton and his wife’s online
activities using government
computers. She accessed their
e-mail and private photos,
monitored his financial
transactions, and read
transcripts of the couple’s
phone conversations. She’d
have done the post of a KGB
agent proud… But as things
stand now, she’s staring at a
hefty fine and a long time
behind bars.

As for Chester, we wonder
whether he uses the Internet
any longer. Perhaps he should
look at moving to Bhutan.

We always knew that on
the Internet you could
be anyone, no questions

asked. But when you say you’re
Steve Jobs, and keep a blog, peo-
ple are going to be curious. Espe-
cially when the blog is titled “The
Secret Diary of Steve Jobs”
(www.fakesteve.blogspot.com).

The postings are decently
funny and tongue-in-cheek, and
some of the time politically
incorrect. Sample: “Woz has
nothing to do but give inter-
views.”

“Vista’s advanced speech
recognition technology.” “Anoth-
er super cool iPhone hack.” The
blog has been quite a hit, with
thousands of people viewing the
site every day and many others
blogging about it as well. Busi-
ness 2.0 magazine has named
Fake Steve Jobs the 41st most
influential person in business.

You can just see Obelix tapping
his head and saying, “These
techies are crazy”!

What really draws people to
this phenomenon is how well the
author of the blog has managed
to remain hidden. Some claim he
is a Macworld columnist named
Andy Ihnatko, while others pooh-
pooh the idea and say the perpe-
trator is a Silicon Valley-based
reporter. In fact, people have
gone to the extent of IP address
tracking to find out the geo-
graphical location of FSJ (Fake
Steve Jobs). But high-tech
sleuthing has raised more ques-
tions than answers… then again,
some are of the opinion that it
would be for the best if FSJ stays
hidden.

Posts by FSJ are flying in
thick and fast. Watch this space
for updates. We love to repeat
ourselves.

The iBlog - Not

Big Sister!

Accessories
Anonymous

133AUGUST 2007 DIGIT




